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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

All About Wireless

Momen Indocomtech 2003 ini sedikit berbeda dari biasanya.
Dimajukan ke awal Oktober karena dua minggu lagi kita sudah
memasuki bulan puasa, bulan penuh berkah dan ampunan bagi umat
Islam. Dengan memajukan jadwal ini, Indocomtech pun juga tampaknya
akan menjadi penuh berkah dan sarat himpunan informasi untuk Anda
sekalian.

Pertama, dengan dimajukan dua minggu lebih awal dari
penyelenggaraan rutin, Indocomtech pun jatuh pada bulan muda, bulan
di mana para karyawan atau pekerja tengah berlimpah rizki, sehingga
mereka memiliki anggaran tatkala ingin membeli peralatan/komponen
komputer. Atau, ketika anaknya merengek minta dibelikan komputer,
minimal ada dana untuk itu.

Kedua, Indocomtech yang dimajukan sebelum bulan puasa tiba
juga memberi harapan bagi para pedagang komputer. Selama ini,
masyarakat kita memang gandrung dan gila belanja. Terutama pada
bulan-bulan puasa dan menjelang Lebaran. Dan ironisnya, semua yang
dibeli adalah barang-barang konsumsi, bukan barang yang
mendatangkan produktivitas. Dengan dimajukannya Indocomtech, bisa
jadi dorongan belanja barang-barang konsumsi ini menurun karena juga
harus mengalokasikan dana untuk membeli komputer atau komponen-
komponen tertentu yang merupakan barang penunjang produktivitas.

Ketiga, penyelenggaraan Indocomtech kali ini sangat berdekatan
dengan pameran komputer terbesar di Asia Pasifik, Computex 2003, di
Taipei, Taiwan, akhir September lalu. Computex sendiri juga merupakan
momen yang tertunda akibat mewabahnya SARS di beberapa negara
seperti Cina, Taiwan, Singapura, dan berbagai kawasan dunia lainnya.
Seharusnya, pameran ini diselenggarakan bulan Maret lalu. Dengan
adanya penundaan Computex dan pemajuan Indocomtech ini, secara
otomatis kita bisa memrediksi gambaran tren teknologi yang akan
berkembang selama kurun waktu satu tahun ke depan. Perlu diketahui,
masing-masing pameran tersebut merupakan barometer tren teknologi
untuk skala masing-masing. Computex di Asia Pasifik, Indocomtech di
Indonesia tentu saja.

Keserbakebetulanan inilah yang kami haturkan ke hadapan Anda
sebagai sajian kami edisi ini. Lebih kebetulan lagi, salah satu kru PCplus,
Silvester Sila Wedjo, membawa banyak kisah dan cerita tentang tren
teknologi dari arena Computex. Cerita tersebut kami padu dengan
berbagai informasi yang kami kumpulkan menjelang Indocomtech
berlangsung. Tentu saja, boleh jadi Anda menikmati tabloid ini di tengah-
tengah pameran Indocomtech yang semuanya bernuansa wireless.

All about wireless. Dan penundaan atau pemajuan jadwal tak selalu
berarti apes. Selamat berbelanja, jangan lupa membaca tuntas sajian
kami sebelumnya.

Salam hangat dari Palmerah
Redaksi

PLUSGAME
To the point aja, saya cuma

ingin menanggapi usulan Bung
Agus Sunardi di plusMail edisi
142. Saya setuju sekali kalau
PCplus menampilkan lagi rubrik
plusGame. Kalau bisa rubrik ini
selalu dimuat dalam setiap
edisinya. Rasanya sebuah media
yang membahas PC akan
kurang lengkap tanpa informasi
mengenai game. Itu saran dari
saya. Terima kasih.

Nur Adi I
nur_adi_i@yahoo.com

Red: Usulan Anda kami
kompromikan dengan pembaca
lain, dua minggu sekali rubrik
tersebut pasti ada.

BAHAS SEKOLAH IT YANG
BAGUS

Hai Redaksi PCplus saya
mau usul nih gimana kalau
PCplus membahas tentang
sekolah-sekolah mana yang

bagus dalam bidang IT, soalnya
saya baru lulus SLTA jadi bingung
milih sekolahan yang bagus.
Tolong dimuat yah.

Deni Sattrya
deny0108@plasa.com

Red: Kami akan pertimbangkan
usulan Anda, Bung Deni. Untuk
tahap pertama, kami akan
mendiskusikannya di meja Redaksi.

DRIVER MODEM
Dear Redaksi. Nama saya

Andi W, saya tinggal di Bandung
City. Saya mempunyai persoalan
yaitu membeli modem 52k
internal dengan software berupa
CD yang hanya memiliki fasilitas
untuk Windows 2000/98/Me/95 ke
bawah. Nah yang menjadi
persoalan adalah bagaimana
caranya mendapatkan software
yang baru dengan kapasitas
seperti Win XP dan lain-lain,
karena saya sekarang sering
menggunakan Win XP yang

penampilannya lebih baik dan
lebih bagus, serta keluarga saya
sangat menginginkan Win XP ini.
Akan tetapi untuk jalan-jalan ke
Internet saya harus ke warnet
atau harus menduakan Win saya
dengan cara satu komputer dua
sistem. Hebat kan? Yang paling
penting adalah bagaimana saya
mendapatkan software ini. Ciri
cirinya: internal modem 52k
PROLINK, Pentium III 600 MHZ.
Saya pernah men-download
software dari PROLINK akan
tetapi tidak jalan di Win XP saya.
Atas tips dan perhatian saya
ucapkan banyak banyak terima
kasih dan semoga Tuhan
membalas kebaikan saudara.
Salam kenal dari saya.

Andi Wibowo
andi_wibowo_2000@yahoo.co.uk

Bandung City

Red: Setidaknya ada dua cara yang
bisa ditempuh. Pertama Anda coba
update Windows XP Anda dengan
cara mengklik windows update di
Control Panel, setelah scanning, lalu
pilih driver update. Cara kedua,
cobalah cari ke situs driver pihak
ketiga seperti www.driverzone.
com atau Anda cari menggunakan
fasilitas search engine.

SHUT DOWN DAN
INSTALASI OFFICE

Hai, Tim redaksi PCplus!
Salam kenal. Mungkin saya juga
termasuk penggemar PCplus
walau hanya melalui kakakku
yang selalu memiliki PCplus edisi
terbaru. Saya hanya membacanya
bila kakakku sedang keluar atau
pergi kuliah karena dia tak mau
bila PCplus yang tertata rapi
dalam kamarnya acak-acakan.

Terus terang saya sangat
senang dengan informasi yang
diberikan oleh PCplus karena dari
situlah saya dapat menambah
pengetahuanku dalam bidang
komputer dan beberapa
kesulitan yang saya temui dalam
menjalankan komputer dapat
saya selesaikan melalui PCplus ini.
Sekarang saya mempunyai
komputer sendiri karena saya
sudah kuliah di luar daerah
tempat tinggal saya, dan saya
termasuk orang yang awam
tentang komputer. Maka dari
itulah kebetulan saya
mempunyai  masalah pada
komputer saya:
1. Pada saat saya men-shut

down komputer biasanya kan
sebelum kita menekan tombol
OFF nya kita akan menunggu
tulisan yang muncul.
Masalahnya di situ
komputerku tak menampilkan
tulisan itu! Apakah itu tak
mempengaruhi proses
komputer? Dan bagaimana
cara menampilkan tulisan itu!

2. Komputerku tak bisa
menampilkan Clip Art pada
Microsoft Office. Apakah itu

penginstalan Microsoft Office-
nya kurang lengkap?

Terima kasih sebelumnya
atas jawaban Redaksi dan saya
harap jawabannya dikirim juga
melalui e-mail. Salam kompak
selalu untuk PCplus.

ULLA
ulla-plp@internux.web.id

Red: 1. Sayangnya Anda tak
mencantumkan OS yang Anda
gunakan apa. 2. Ya, penginstalan
Office Anda kurang lengkap karena
pilihan untuk menjalankan Clip Art
dari komputer pada waktu instalasi
Office tidak diaktifkan.

PELANGGAN PCPLUS
MINTA TOLONG

Tolong dong PCplus
mengulas langkah2 konfigurasi
jaringan pada Linux. Windows sih
udah lazim. Baik peer2peer (2
komputer) maupun
menggunakan hub. Kalau ada
bahannya tolong dong kirimkan
ke saya, soalnya saya lagi
bermasalah dengan setting
jaringan, baik Linux ke Linux
maupun Linux ke Windows (saya
menggunakan Windows ME) dan
sebaliknya agar bisa sharing.
Thank's, sukses selalu. Satu lagi,
bagaimana kalau di
plusSoftware sekali-sekali
mengulas program pengedit
video Adobe Premiere maupun
Ulead Video Studio.

Rusli
rusli3@telkom.net

Red: Kami akan usahakan untuk
membahasnya. Tetapi bila Anda
butuh mendesak, Anda bisa
menghubungi vincent@e-
pcplus.com atau yahya@e-
pcplus.com untuk konsultasi
masalah Linux. Usulan tentang
pembahasan software untuk video
editing boleh juga tuh.

MUNCULKAN LAGI
PLUSVIRUS/SECURITY

Gue nih termasuk
penggemarmu. Gue sedikit
kecewa dengan artikel-artikel
yang ada sekarang nih. Gue lihat
ada yang nggak pernah nongol
lagi. Contohnya bahasan virus/
security. Padahal gue paling getol
nih sama bahasan ini. Terus
terang nih, gue agak terpacu
belajar tentang virus dari PCplus,
terutama pas lagi baca tulisannya
Mas Chandraleka. Tambahan lagi,
sekarang ini kan virus-virus makin
heboh deh, sepanjang tahun
2003. Eh gue saran lagi nih. Kalo
bisa bahasan ponsel dihapus aja
dah. Masak tabloid komputer
membahas ponsel. Kan kurang
pas, lagi pula udah banyak
majalah lain yang ngebahas
ponsel.

Supriyanto
supriyanto78@telkom.net

Red: Masukan Anda akan kami
pertimbangkan. Sebagai catatan,
kami berusaha untuk meringkas
rubrik, tetapi lebih fleksibel.
Misalnya saja, apabila ada virus-
virus baru yang menyerang, tentu
saja kami akan munculkan di
plusAktual. Saran untuk
menghapus rubrik plusPonsel akan
kami godok dan evaluasi.

KRITIK UNTUK PCPLUS
Salam sejahtera untuk

PCplus. Ada beberapa hal yang
ingin saya sampaikan:
1. Menurut saya sebagian

besar rubrik dalam PCplus
sekarang terlalu banyak
kalimat yang kurang simpel,
jadi kesannya bertele-tele
seolah mau memanjang-
manjangkan kalimat.

2. Dalam plusHarga, rasanya
banyak daftar komponen
yang kurang banyak dicari,
tapi selalu hadir pada tiap
edisi. Bagimana bila PCplus
secara rutin tiap edisi
mengganti daftar
komponen tersebut
sehingga kemungkinan
muncul kembali komponen
yang sama antara 3 pekan
sampai 1 bulan sekali.

3. Walaupun PCplus pernah
menyajikan pengujian
motherboard yang ber-
chipset Springdale dan
Canterwood, tapi sayang
hanya beberapa merek saja,
padahal sekarang sudah
banyak merek motherboard
seperti itu beredar di
pasaran. Saya sangat ingin
mengetahui kinerja
beberapa motherboard jenis
ini dari vendor: ECS, Abit,
ASUS, MSI, dan Gygabite.
Sudikah PCplus
mewujudkannya.

Terima kasih atas
tanggapannya dan mohon maaf
kalau ada yang salah.

Budiono
geos_planet@yahoo.com

Red: 1.Thanks masukannya. 2.
Akan kami pertimbangkan dan
usahakan. 3. Pengujian di PCplus
sering kali terbentur masalah
waktu terbit yang terlalu cepat
(seminggu sekali) sehingga masa
pengumpulan komponen untuk
pengujian sangat mepet.

WORKSHOP DI BULAN
PUASA

Redaksi yth. Ane mau tanya
nih seputar workshop di bulan
puasa nanti ada engga sih?
Kalo ada di mana and kapan
tuh?

Agus Mukti Ali
re-com@telkom.net

Red: Simak terus infonya di
PCplus!



| 3

plusAktual IV • 01 - 07 Oktober 2003
PCplus 146

Ericsson Adakan Kompetisi
Aplikasi Bergerak. Untuk babak pertama dalam
Ericsson Mobile Application Awards 2003, para peserta diberikan
kesempatan untuk mengirim aplikasinya sampai tanggal 31
Oktober 2003. Dari semuanya, dua belas yang akan dipilih untuk
mengikuti babak final di Zurich, Swiss pada tanggal 25 November
2003. Kategori yang akan dipertandingkan adalah Best Mobile
Entertainment, Gaming dan Enterprise and Information
Application. Kompetisi ini merupakan usaha Ericsson dalam
memperkecil kesenjangan antara para developer, penyedia
aplikasi, venture capitalist dan penyedia jaringan operasi.
Tujuannya untuk mencari aplikasi terbaik yang berfokus pada
mobile Internet. (raa)

Kerja Sama Oracle – Partner
untuk Integrasi Penawaran Grid.
Partner Oracle terdiri dari banyak perusahaan besar termasuk
Computer Associates, Digex, F5, Hawlett Packard, Sun
Microsystem, Micromuse dan TUSC. Bersama mereka membangun
Oracle® Enterprise Manager 10g Grid Control sebagai solusi untuk
mempermudah pengelolaan enterprise grid computing.

Grid computing merupakan cara sederhana, efisien dan
ekonomis untuk mengelola ribuan server secara terpusat. Oracle
Grid Control bisa mengelola  komponen software dan hardware
kritikal di lingkungan grid computing dan berperan sebagai
protokol aplikasi terbuka yang bisa memonitor proses dan
administrasi seluruh sistem perusahaan. (raa)

IBM Memperkenalkan Solusi
Berbasis Grid untuk Industri
Keuangan dan Perbankan. Ini adalah
kerjasama IBM dengan SAS sebagai penyedia software untuk
bisnis keuangan dan perbankan. IBM juga bekerjasama
dengan Morgan Stanley untuk melakukan migrasi aplikasi
analitis keuangan agar bisa berjalan pada grid server prosesor
Intel, dengan Hewitt Asssociates dalam membangun sebuah
grid ber-platform WebSphere dan Linux untuk aplikasi pensiun
SDM perusahaan, dan dengan NLI Research Institute untuk
membangun solusi dalam mengurangi waktu proses dan
pengelolaan resiko keuangan perusahan dengan metode Monte
Carlo yang memanfaatkan teknologi grid.

Menurut Suryo Suwignyo, Country Manager System Group,
IBM Indonesia, para pelanggan di industri layanan finansial,
perbankan, otomotif, telekomunikasi dan pendidikan bisa
memanfaatkan komputasi grid untuk meningkatkan produktivitas
dan daya tanggap, serta mengurangi biaya aset TI mereka. IBM
memanfaatkan aplikasi SAS Credit Scoring sebagai bagian dari
solusi SAS Banking Intelligence yang bisa melakukan “plug and
play” tanpa perlu pemograman terkustomisasi. Solusi ini bertujuan
untuk yang memenuhi permintaan pasar keuangan akan fungsi-
fungsi pengelolaan resiko yang dapat mendeteksi penipuan dan
memonitor batas piutang secara real-time. (raa)

Web Anti Spam Diserang. Tiga situs web
yang menyediakan sistem anti spam berhasil dilumpuhkan melalui
jaringan Internet yang terhubung melalui e-mail. Para ahli
menuding para spammer yang melakukan serangan tersebut. Ini
bisa menjadi awal terjadinya perang teknologi, para ahli harus
berurusan dengan ratusan surat spam yang sumbernya tidak jelas.
Monkeys.com terpaksa menutup situsnya selama tiga hari untuk
perbaikan. Operator anti-spam dari Osiriusoft.com juga harus
menutup situsnya karena Compu-Net, Perusahaan ISPnya, juga
diserang oleh ratusan e-mail spam. Para ahli menduga bahwa para
spammer di balik serangan worm Sobiglah yang telah menginfeksi
komputer-komputer mereka dengan surat spam. (raa)

SiS Luncurkan Chipset yang
mendukung AMD64-Bit. Baru saja
diluncurkan, SiS755, telah menarik animo pasar internasional.
Seperti dua produk pendahulunya, SiS740 dan SiS746FX, SiS755
mampu mendukung platform dari prosesor AMD. SiS755 mampu
mendukung platform AMD64-Bit yang mulai dilirik sebagai pilihan
untuk notebook. Banyak produsen motherboard yang akan
menggunakan chipset SiS755 dalam produknya, mereka adalah
Aopen, Asrock, Asustek, ECS, Gigabyte dan Jetway. Michael Chen,
Presiden dan CEO SiS, merasa optimis dengan potensi pasar SiS755.
Chipset ini selain mendukung prosesor AMD AthlonTM 64 dan
prosesor OpteronTM, juga mendukung teknologi HyperTransport
yang memungkinkan kecepatan transmisi FSB sampai dengan
6.4GB. Sebagai tambahan, SiS755 bisa berintegrasi dengan AGP 8X
Interface dan mesin SiS HyperTransportTM yang mampu
meningkatkan kecepatan transmisi data I/O, kapasitas transmisi
data jaringan dan waktu respon sistem. (raa)

Hewlett Packard Luncurkan Solusi untuk Pasar
Usaha Kecil dan Menengah.  Investasi sebesar US$ 100 juta ini merupakan
strategi HP untuk mendekati pasar usaha kecil dan menengah (UKM) di Asia Pasifik. Prinsip utama dari
program ini adalah untuk menyediakan keahlian yang tepat dengan menawarkan teknologi yang lebih
baik dan mudah untuk dimiliki. HP menawarkan dasar teknologi yang kuat untuk UKM, mulai dari PC,
printer, server, storage system, solusi jaringan dan workstation. Produk-produk yang ditawarkan HP
dibagi menjadi tiga kelas – penawaran produk imaging dan printing, client dan infrastruktur HP.

Untuk produk imaging dan
printing, HP memperkenalkan HP
LaserJet seri 1010, HP Deskjet 9650/
9680, HP Business Jet 1100, HP Color
LaserJet 9500, HP Digital Projector
3130, HP Digital Projector xp8010,
HP Jetdirect 175x, HP Jetdirect 200m,
HP Scanjet 8250/8290 dan HP
JetCAPs PDF Direct. Untuk produk
client, HP menawarkan Sistem
Integrated Work Center Desktop, HP
Desktop Access Center, HP Flat Panel
Monitor L1530 dan L1730, HP
Notebook seri nx9000, HP Worksta-
tion seri xw3100 dan seri xw4100.
Sedangkan untuk produk
infrastruktur, HP menawarkan HP
Proliant ML150, HP Storage Work
NAS, HP Storage Work DAT tape

drive dengan satu tombol disaster recovery dan HP ProCurve Wireless Access Point 420.
HP LaserJet seri 1010 merupakan printer yang paling terjangkau harganya, praktis dan memberi

solusi pencetakan monochrome berkecepatan tinggi, cocok untuk desktop dalam berbagai perusahaan.
HP Deskjet 9650, HP Deskjet 9680 dan HP Business Inkjet 1100 dirancang untuk lingkungan
perusahaan kecil yang membutuhkan produtivitas tinggi, memiliki banyak fungsi dengan format besar
dan mampu mencetak foto tanpa batas (borderless) hingga ukuran A3. HP Business Inkjet 1100 memiliki
4 tinta cartridge, bisa mencetak bolak-balik dengan kecepatan hingga 23 ppm untuk cetak monochrome
dan 20 ppm untuk cetak warna, harga yang ditawarkan sekitar US$ 280. HP Deskjet 9650 dan HP Deskjet
9680 memiliki 6 tinta cartridge, mampu mencetak mulai dari ukuran A6 (ukuran kartu pos) hingga A3
(ukuran poster). Harga yang ditawarkan sekitar US$ 558/US$ 698. HP Color LaserJet 9500
menghadirkan pencetakan laser berwarna berkualitas tinggi, target penggunanya adalah kantor atau
bisnis percetakan.

HP Jetdirect 175x dan HP Jetdirect 200m adalah server printer yang menawarkan konektivitas
jaringan mobile. Harganya sekitar US$ 199 untuk 175x dan US$ 210 untuk 200m. HP Scanjet 8250 dan
HP Scanjet 8290 merupakan scanner berperforma tinggi, bisa digunakan untuk mengelola dokumen
dengan cepat. Fitur Automatic Document Feeder (ADF) memungkinkan scan otomatis dan fasilitas
duplex memungkinkan pencetakan bolak-balik 15/25 halaman permenit. HP Scanjet 8250 dilengkapi
dengan software Newsoft Presto! PageManager untuk menyimpan pengaturan dokumen yang telah
dilakukannya dan ScanSoft Omniform untuk mengelola koleksi data secara digital. HP Scanjet 8290 juga
dilengkapi dengan Scansoft Omniform, Kofax sVRS yang secara otomatis memeriksa proses pencetakan
agar diperoleh hasil yang optimal dan NSi OneStep untuk mendeteksi, memroses dan menghubungkan
file elektronik ke aplikasi back-end (seperti MS SharePoint portal dan Lotus Notes) secara otomatis.
Kedua scanner ini kompatibel dengan PC dan Mac. HP JetCAPs PDF Direct menawarkan solusi
pencetakan file PDF dan MMS dari ponsel, mampu mengirimkan e-mail berisi dokumen langsung ke
printer. (raa)

Macromedia Luncurkan Macromedia Central. Untuk
mendukung terciptanya kehidupan berteknologi wireless, Macromedia meluncurkan Macromedia
Central, sebuah lingkungan baru bagi user untuk berinteraksi dengan web tanpa harus bergantung
dengan koneksi terus-menerus. Sistem Macromedia Central merupakan aplikasi yang bisa berjalan di
dalam atau diluar lingkungan browser. Dengan berkembangnya bisnis dan teknologi berbasis aplikasi
web dalam kehidupan sehari-hari, produk ini bisa mempermudah para web developer untuk menjual
dan menyebarkan aplikasinya pada masyarakat. Komputer yang telah terinstal Macromedia Central
mampu men-download aplikasi secara cepat dari developer. Sistem akan secara otomatis mendeteksi
apakah user sedang online atau offline, jika sedang online sistem akan menyambungkannya langsung ke
layanan web.

Lingkungan Central bisa berjalan di desktop maupun peralatan mobile menggunakan teknologi
Macromedia Flash Player 6, para developer bisa membangun aplikasi berbasis web secara online ataupun
offline. Pada peluncuran pertamanya, ada dua aplikasi awal yang disediakan – Movie Finder dan
AccuWeather. Movie Finder memberi akses bagi user untuk melakukan rating film, melihat jadwal main,
membeli karcis, atau menggunakan layanan rental DVD. AccuWeather memperlihatkan ramalan cuaca
untuk lima hari  dan memberikan penjelasan spesifik tentang kondisi cuaca. (raa)

BII Sediakan Layanan Cash
Deposit Machine. Layanan
berupa setoran tunai mandiri ini
merupakan layanan bank
pertama kali di Indonesia.
Dengan memanfaatkan fasilitas
ini, pelanggan bank yang
bersangkutan bisa menyetorkan
uang tunai dalam pecahan yang
berbeda-beda (10, 20, 50, dan
100 ribu rupiah) dan langsung
dikredit ke rekening pada saat
itu juga. Untuk langkah pertama,
CDM ini akan tersedia di mal-mal
seperti Plaza Senayan, Mal
Taman Anggrek, Plaza Indonesia,
dan kantor pusat BII di Plaza BII
sendiri. Mesin CDM ini
merupakan produksi IBM. Untuk
menyempurnakan pelayanannya,
mesin ini juga dilengkapi dengan
teknologi dari Omron. (snu)
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Intel akan Kembangkan
Teknologi Hyper-Threading untuk
Notebook. Rencananya Intel akan memasukkan
prosesor Mobile Intel Pentium 4 berteknologi hyper-threading (HT)
untuk produk notebooknya. Tidak seperti single-thread prosesor,
HT memungkinkan banyak aplikasi atau sistem operasi untuk
memanfaatkan unit-unit eksekusi yang tidak terpakai dalam
komputer, instruksi-instruksi software yang dikirim tidak
bergantung pada eksekusi instruksi lainnya sehingga prosesor bisa
bekerja lebih optimal karena beberapa tugas bisa dikerjakan
dalam waktu bersamaan. HT beroperasi secara independen di atas
teknologi SpeedStep Intel dan kecepatan clock prosesor mobile-
nya bermacam-macam tergantung pada jenis aplikasi yang
dijalankan, ini merupakan solusi untuk menghemat konsumsi
tenaga prosesor dalam notebook. (raa)

Intel Adakan Consumer Digital
Workshop 2003. Acara ini diadakan di dua kota,
Jakarta (28 September 2003) dan Surabaya (12 Oktober 2003).
Menggunakan PC berbasis Intel® Pentium® 4 berteknologi hyper-
threading (HT), para pengunjung mendapat kesempatan untuk
membuat film atau melakukan video editing. Mereka bisa
menikmati secara gratis berbagai workshop pengolahan foto
menggunakan printer foto HiTi. Dengan teknologi ini PC bisa
melakukan banyak pekerjaan dalam waktu bersamaan (multi-
tasking), mempersingkat waktu pekerjaan.

Bersamaan dengan workshop tersebut, 5 keluarga dari Jakarta
dan 5 keluarga dari Surabaya berlomba untuk membuat film
dokumentasi menggunakan video digital dan mengeditnya
menggunakan komputer-komputer berteknologi HT yang
disediakan. Keluarga yang terpilih telah mengikuti beberapa
tahap seleksi, mereka harus mendaftar melalui Internet, memiliki
tingkat awareness tinggi untuk menggunakan teknologi, dan
harus merupakan satu keluarga inti yang minimum memiliki
dua orang anak. Usia orang tua dibatasi maksimum 41 tahun dan
anak maksimum 12 tahun. Keluarga Uswanur Rizal,  terpilih
sebagai keluarga terbaik pertama, berhak membawa pulang
satu unit PC berbasis prosesor Intel® Pentium® 4
berteknologi HT. (raa)

Kurusetra Luncurkan Game Strategi Online
Berbasis Web, WAP dan SMS.  Kurusetra ini merupakan
game strategi online multiplayer
pertama di Indonesia yang telah
dibangun sejak tahun 2000 oleh
beberapa mahasiswa Institut Tekno-

logi Bandung. PT Kurusetra Kencana bekerjasama
dengan TELKOMSEL untuk mewujudkan game ini
sebagai game multichannel pertama di Indonesia
yang dapat diakses melalui web, WAP dan SMS.

Ada tiga misi dalam game ini – membangun
kerajaan dan melatih pasukan seoptimal mungkin,
bekerja sama dengan kerajaan lain, dan berperang
dengan kerajaan lain untuk menjadi yang terbaik.
Karakter-karakter yang digunakan berasal dari
karakter budaya Indonesia, khususnya budaya
pewayangan. Permainan ini melibatkan banyak
unsur seperti strategi, insting, analisa matematis,
dan emosi para pemain. Para pemain bekerja sama
secara tim di mana setiap tim disebut sebagai
dewan raja. Satu turn permainan (pergantian hari)
sama dengan satu jam, permainan selalu berjalan
saat pemain tidak login. Game akan di-reset setiap
periode tiga bulan, yang berarti satu abad
Kurusetra, dan diberikan tambahan fitur-fitur baru.

Menurut data, ada 5.000 pemain aktif dalam
game ini dan 12.000 pemain yang tercatat keluar

masuk dalam permainan. Lima puluh persen pemain
adalah karyawan kantoran, 25 persen mahasiswa, dan
sisanya adalah pelajar SMU atau SMP. Karena permainan
terus berjalan, para pemain membutuhkan media lain
seperti fitur WAP dan SMS untuk mengakses permainan,
mereka tidak bisa online 24 jam di depan komputer.
Dasar Kurusetra adalah game berbasis teks sehingga
mudah dikembangkan dengan SMS. Saat ini PT
Kurusetra Kencana sedang mengembangkan versi grafik
untuk meningkatkan daya tarik dan fitur bagi game
tersebut. (raa)
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Proyek teknologi
informasi untuk

melaksanakan pemilu
2004 sudah dimulai.

Tapi dalam
pelaksanaannya,

proyek ini rasanya
seperti membangun

seribu candi dalam
waktu semalam

seperti Bandung
Bondowoso. KPU pun

menjadi Rara
Jonggrang dalam

mitologi Candi
Prambanan, yang

meminta infrastruktur
Pemilu bisa siap
dalam sekejap.

ejak setahun
lalu,Komisi
Pemilihan Umum (KPU)
telah merancang

teknologi yang akan digunakan
dalam Pemilu 2004. Tapi, kritikan
dan protes bermunculan ketika
spesifikasi hardware dan
rancangan sistem informasi yang
diajukan oleh tim
ahli teknologi
informasi KPU dinilai
mengarah pada satu
merek tertentu dan
dibuat tidak sesuai
dengan kebutuhan.
KPU sendiri
didampingi oleh tim
ahli terdiri dari lima
orang, diketuai oleh
Dekan Fakultas Ilmu
Komputer UI Prof.
Toemin A. Masoem
dan beranggotakan
Cahyana Indrayana, Achyar Oenry,
Aryana Haribawa, dan Basuki
Suhardiman.

KEGANJILAN DOKUMEN
LELANG

Banyak hal aneh dalam
“Dokumen Lelang Pengadaan
Barang dan Jasa – Infrastruktur
Data Center, Disaster Recovery
Center dan Perangkat Komputer
untuk Pengembangan Sistem
Informasi” dengan nomor 695.1/
15/IX/2003 yang dikeluarkan oleh
KPU tertanggal 12 September
2003. Misalnya saja, dokumen
lelang tersebut baru diterima oleh
para peserta tender pada tanggal
13 September 2003, sedangkan
penjelasan mengenai dokumen
itu diberikan tanggal 18 Septem-
ber 2003. KPU memberi waktu
bagi para peserta untuk
mengajukan penawaran
selambat-lambatnya pada tanggal
25 September 2003. Tiga hari kerja
dituding terlalu singkat untuk

mempersiapkan sebuah dokumen
penawaran yang lengkap.

Dalam dokumen lelang tertulis,
pekerjaan harus selesai paling
lambat 62 hari sejak
penandatanganan kontrak
perjanjian. Waktu tersebut hampir
tidak masuk akal jika melihat
beratnya pekerjaan yang harus
diselesaikan oleh perusahaan
pemenang tender. Proyek ini
berskala besar dan sangat luas,
membangun infrastruktur  yang
bisa menghubungkan kira-kira 438
kabupaten dan 5059 kecamatan di
Indonesia termasuk sebuah data
center dan disaster recovery center
di dalamnya.

KPU sendiri memang membuka
kesempatan bagi para peserta
tender untuk membentuk sebuah
konsorsium di antara para peserta

tender. Namun membangun
konsorsium sendiri tak segampang
membalik telapak tangan. Apalagi
cuma ada waktu 3 hari.

Information, Communication
and Technology (ICT) Watch, sebuah
LSM teknologi informasi dan
telekomunikasi, melakukan analisis
atas spesifikasi yang diajukan oleh
tim ahli KPU dan melakukan kroscek
produk antara Hewlett Packard,
IBM, Dell, dan Sun Microsystem.

Dari spesifikasi yang diajukan,
KPU membutuhkan 24 server dan 4
database server. Teknologi yang
diminta untuk server-server tersebut
adalah teknologi Smart Array 5i
Plus controller yang berfungsi
sebagai pengendali harddisk dan
integrated Lights-Out (iLO)
embedded yang merupakan sistem
pendeteksi kerusakan hardware,
keduanya hanya ditemukan pada
komputer server HP. Spesifikasi yang
diminta untuk database server
adalah prosesor 4 x Itanium2 1.5
GHz keluaran Intel dengan multiple

OS, server kelas high-end ini hanya
dimiliki oleh oleh HP Integrity
Superdome.

Sementara OS yang akan
digunakan adalah Microsoft
Windows XP Professional Edition
dan Microsoft Office XP Standard
Edition yang satu paket dengan
hardware sekelas Pentium 4. Ketika
ditanya mengenai hal ini, Basuki
Suhardiman mengatakan bahwa
timnya tidak pernah bermaksud
mengarahkan spesifikasinya ke satu
produk tertentu, mereka tidak
menutup kemungkinan
diajukannya produk lain yang
memiliki kemampuan setara
dengan spesifikasi yang diminta.

Spesifikasi OS ini sendiri menuai
kritik. Mengapa harus Windows
Professional? Padahal untuk
keperluan ini, Windows Home

Edition pun sudah
mencukupi sedangkan
harganya juga lebih
murah. Begitu juga
dengan penggunaan
Office yang keluaran
Microsoft. I Made
Wiryana, dalam surat
terbuka menanggapi
masalah ini menyatakan,
ada banyak pilihan
Office selain keluaran
Microsoft yang lebih
murah dan juga tidak
sulit untuk

diimplementasikan.
Di beberapa daerah selain Jawa

dan Bali, data dari Tempat
Pemungutan Suara (TPS) akan
dibawa secara manual ke
kecamatan dan dari kecamatan juga
akan dikirim secara manual ke
kabupaten. Setelah itu, barulah dari
kabupaten data dikirim secara
elektronis ke Kantor Pusat KPU di
Jakarta. Lalu untuk apa di setiap
kecamatan harus dipasangi
workstation? Jumlah workstation
yang diminta untuk kabupaten/kota
adalah 892 buah, padahal di
Indonesia hanya ada 438
kabupaten, untuk kecamatan
jumlah workstation yang diminta
adalah 7029 buah sedangkan
jumlah kecamatan seluruhnya
hanya 5059.

Drs. H. Dalail, Kepala Biro
Pengolahan Data dan Pengendalian
Informasi KPU, menjawab bahwa ia
sendiri belum tahu pasti berapa
jumlah kecamatan yang ada karena
mungkin saja ada beberapa

pemekaranan daerah, namun setiap
kecamatan pasti akan dilengkapi
dengan workstation. Komputer-
komputer ini nantinya akan
diberikan ke setiap kantor KPU di
kabupaten/kota dan akan dipakai
untuk pemilu berikutnya, SDM KPU
daerahlah yang akan merawat
infrastruktur tersebut.

Untuk pengadaan layanan
sambungan komunikasi dan
Internet, KPU menyerahkan
sepenuhnya pada PT Telekomuni-
kasi Indonesia tanpa melalui proses
tender resmi. Dalail mengatakan
bahwa hanya 60 persen daerah
Pemilu yang terjangkau oleh
jaringan telepon. Yang pasti, Telkom
telah menyanggupi untuk
mengatasi masalah komunikasi di
40 persen daerah sisanya dengan
membangun interkoneksi via satelit.
Waktu yang sangat singkat menjadi
tantangan terberat, pertanyaan
yang muncul adalah bagaimana
kualitas hasil pekerjaan berskala
nasional itu nantinya.

OPTIMISME KPU
KPU sendiri menyatakan

bahwa mereka tidak memiliki
rencana lain sebagai backup plan
jika terjadi hambatan dalam
penyelesaian proyek Pemilu
online, mereka optimis proyek
tersebut nantinya akan berjalan
lancar. “Jika proyek tak bisa
selesai tepat pada waktunya,
terpaksa akan dipakai cara lama,
Pemilu secara manual. Tidak
mungkin bila Pemilu harus
ditunda karena proyek belum

Kerikil Dalam Proyek
Teknologi Informasi di KPU

S

Restituta Ajeng Arjanti
ajeng@e-pcplus.com

kelar,” ujar Dalail.
Tercatat ada 41 perusahaan

yang lolos dalam tahap
prakualifikasi untuk tender TI
KPU. Sabtu, 27 September 2003,
KPU melakukan pembukaan
surat penawaran tender. Ada 10
surat penawaran yang diajukan
oleh 19 perusahaan kepada
panitia, empat di antaranya
diajukan dalam konsorsium.
Kesepuluh penawaran tersebut
diajukan oleh PT Adhisakti Solusi
Komputindo, PT Pernadi Wira
Perkasa, PT Texacom Hitek
System, PT Anabatik Technolo-
gies, PT Globalindo Technology,
PT Asaba Computer Center,
konsorsium PT Berca Hardaya
Perkasa dengan PT Indosat Mega
Media dan PT Citra Tirza Astari
Jaya, konsorsium PT Integrasi
Teknologi Tbk. dengan PT
Intikom Berlian Mustika, PT
Harrisma Agung Jaya, PT
Multidata Rancana Prima, dan PT
Nusantara Compnet, konsorsium
PT Swadarma Duta Data dengan
PT Transmarco Data System, dan
konsorsium PT Multipolar
dengan PT Binareka Tata Mandiri
dan PT Rahajasa Media Internet.
Ada tiga perusahaan yang
menyatakan mengundurkan diri,
dua di antaranya adalah PT Peta
Bumi Nusantara dan PT Praweda
Cipta, dan satu surat penawaran
dari sebuah konsorsium yang
dipimpin oleh PT. Bringin
Gigantara terpaksa tidak bisa
diterima karena datang
terlambat. PC+

Jadwal Lelang TI untuk Pemilu 2004

10 – 11 September 2003 Pengumuman dan pengambilan

undangan

12 – 13 September 2003 Pengambilan dokumen lelang

18 September 2003 Penjelasan lelang

25 September 2003 Pemasukan penawaran

26 – 29 September 2003 Evaluasi surat penawaran harga

30 September 2003 Usulan calon pemenang

1 Oktober 2003 Penetapan dan pengumuman hasil

pemenang

2 – 7 Oktober 2003 Masa sanggah

8 Oktober 2003 Penunjukkan pemenang

9 Oktober 2003 Penerbitan Surat Perjanjian Kontrak

10 Oktober 2003 Kontrak

Oktober – 4 Desember 2003 Pelaksanaan kerja

Sumber: Komisi Pemilihan Umum

ARE/PCplus
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Jika Anda berkunjung ke ruangan kerja seseorang dan
melihat di atas mejanya berdiri anggun sebuah monitor

LCD yang ramping --tanpa seliweran kabel dan lain-lain--
apa kesan Anda? Tentu Anda akan lebih respek terhadap si

pemilik meja. Kesannya, si pemilik meja menghargai
teknologi informasi dan memanfaatkannya. Terkesan juga

“beliau” cukup berselera sehingga tidak ingin mejanya
ditumpuki oleh sebuah monitor komputer berbadan

gemuk. Beliau adalah seorang yang mengerti efisiensi
ruang, dan mungkin sekali beliau juga mengerti arti

kesehatan dari monitor komputer yang bebas radiasi.

MONITOR LCD LEBIH DISUKAI
Dari survei yang dilakukan oleh

sebuah majalah komputer Indonesia
ternama, lebih dari 50% responden
menyatakan dengan tegas ingin membeli
monitor LCD, si monitor bertubuh
ramping (slim). Keinginan tersebut
bukan hanya dambaan hati belaka,
melainkan keinginan rasional setelah
mengetahui konsekuensi logisnya, yaitu
harus merogoh kocek lebih dalam.

Mengapa? Ada banyak alasan
mengapa banyak orang menginginkan
monitor LCD. Selain penampilannya lebih
elegan, layar monitor yang datar konon
bisa menampilkan gambar lebih baik

karena terhindar dari distorsi seperti yang terjadi pada layar cembung. Layar LCD
yang bebas kedip juga bisa menampilkan teks lebih baik dan sehat bagi mata yang
memandangnya. Tidak lupa, monitor LCD juga sangat hemat penggunaan daya listrik,
yaitu hanya sekitar 30% dibandingkan penggunaan daya pada monitor biasa
(tabung).

MEMILIH MONITOR LCD
Tetapi saat ini banyak sekali merek monitor LCD yang beredar. Bagaimana

memilihnya? Pertanyaan ini sulit dijawab, bahkan setelah kami membanding-
bandingkan spesifikasi dan melihat model monitor LCD yang tersedia. Kami mencoba
membandingkan keunggulan teknologinya, melihat penampilan fisik, serta
mengukur seberapa pantas harga yang harus dibayar dengan manfaat yang
diberikan. Tidak lupa --tentu saja-- intuisi dan selera yang subyektif. Kami mencoba
melihat semua itu dari kacamata seorang pemakai pribadi yang hanya memutuskan
pembelian monitor LCD sekali saja. Jadi, serba hati-hati, hingga sampailah kami pada
sederetan produk Samsung yang bertajuk SyncMaster. Tahukah Anda apa yang
memikat perhatian kami untuk pertama kali? “Kakinya”.

Ya, kakinya. Ibarat melihat seorang gadis, mata memang cenderung untuk
melihat ke arah kaki. Asumsinya mungkin sederhana, jika kakinya sudah bagus,
apalagi yang lainnya, bukan? Tetapi kaki monitor LCD tentu saja bukanlah seperti
kaki seorang gadis. Kaki yang kami perhatikan di sini tampak ramping, namun
terkesan kokoh. Kaki itu milik SyncMaster seri 152N, 172N dan 192N. Lalu ada juga
seri 193T, serta yang agak berbeda adalah kaki SyncMaster seri 153V dan 173V. (Untuk
memudahkan Anda mengenal seri SyncMaster di atas, dua angka pertama
menunjukkan ukuran diagonal layar dalam inch, yaitu 15”, 17”, dan 19”).

MEMERIKSA SPESIFIKASI
Selanjutnya, mari kita periksa spesifikasinya. Ini cukup penting, walaupun kita

sudah bisa memberikan kepercayaan penuh pada Samsung karena reputasinya
(antara lain sebagai perusahaan raksasa terbesar di Korea Selatan dan kedua terbesar
di kawasan Asia. Di Indonesia diwakili oleh PT Samsung Electronics Indonesia/SEIN
yang telah beroperasi sejak 1991). Atribut-atribut yang perlu diperhatikan di sini,
sepanjang yang bisa kita mengerti, antara lain adalah: ketajaman yang dicerminkan
oleh Brightness dan Contrast Ratio, lebar sudut pandang yang dicerminkan oleh
Viewing Angle, jenis antar muka yang ditunjukkan oleh Interface, resolusi layar
maksimal yang bisa digunakan, serta jumlah warna yang mampu dihasilkan.
Spesifikasi yang lain terlampau teknis untuk diungkapkan dalam kata-kata, jadi
silahkan menyimak sendiri tabel spesifikasi yang disediakan.

Mengapa ketajaman atau contrast perlu Anda perhatikan? Pada awalnya,
kelemahan dari monitor LCD adalah tampilan warnanya yang relatif suram

Monitor LCD Samsung SyncMaster:
HADIR DENGAN SEGALA KEUNGGULAN

TEKNOLOGI LCD DISPLAY
dibandingkan monitor jenis CRT (tabung).
Saat ini, khususnya pada monitor LCD seri
SyncMaster dari Samsung, tingkat kecerahan
(brightness) sudah mencapai 270cd/m2
(pada seri 172N) dan rata-rata 250cd/m2
pada seri yang lainnya. Sementara itu
rasio kontras sudah mencapai 750
banding 1 pada seri 193T sedangkan
pada seri 153V masih 300 banding 1.

Kelemahan kedua monitor LCD
(dibandingkan monitor CRT) adalah
sudut pandang yang terbatas. Anda
tentu sudah mengetahui kelemahan
ini ketika menggunakan notebook
terutama pada produk-produk awal.
Kita hanya bisa menampak tampilan layar
dengan baik jika kita memandang tegak lurus
atau tepat dari depan monitor tersebut. Saat
ini, sudut pandang yang diberikan oleh
monitor LCD semakin lebar. Pada SyncMaster
153V dan 173V sudut pandang mencapai 140o

horisontal dan 120 o vertikal (ingat: sudut 180 o adalah melihat betul-betul dari
samping). Pada SyncMaster 172N sudut pandang mencapai 150 o/120 o (H/V), dan pada
SyncMaster 192N dan 193T sudut pandang mencapai 170 o/170 o(H/V).

Dari sudut antar muka (interface), SyncMaster 153V, 173V, 152N, 172N, dan 192N
menggunakan sistem Analog, sedangkan SyncMaster 193T menggunakan dua sistem
sekaligus yaitu Analog dan Digital. Sementara itu, jika Anda terbiasa atau ingin
bekerja dengan resolusi layar yang lebar, Anda perlu memilih seri 173V, 172N, 192N,
dan 193T karena memiliki resolusi maksimal 1280x1024 pixels. SyncMaster seri 153V
hanya menawarkan resolusi maksimal 1024x768 pixels.

BERBAGAI KEUNGGULAN
Mulai SyncMaster 153V/173V Samsung telah menerapkan standar kualitas image

yang tinggi. Tingkat kecerahan yang tinggi tidak mengorbankan kejelasan gambar
karena diikuti oleh tingkat kontras yang tinggi pula. SyncMaster 153V/173V juga
mendapatkan penghargaan dari TCO’03 sebagai produk yang ramah lingkungan.
Dalam hal penggunaan daya listrik, SyncMaster 153V/173V hanya mengkonsumsi daya
sebesar 45W ketika beroperasi, dan hanya 2W ketika dalam keadaan standby.

Kabel, yang biasa membuat “ribet” dalam penempatan monitor di atas meja,
tersembunyi di dalam kaki monitor. Anda juga tidak perlu repot dengan kabel
adaptor karena SyncMaster telah memiliki power
supply yang built-in.

Jika pada seri 153V/173V kaki masih sederhana,
pada seri 172N/192N dan 193T kaki sudah bisa diatur
sangat fleksibel, termasuk ketinggiannya, serta bisa
dipasangi speaker multimedia (opsional). Pada seri-seri
172N/192N dan 193T juga dilengkapi dengan fitur
khusus yang disebut Magic Bright™. Bidang pinggir
(bezel) juga sangat tipis sehingga lebar layar bisa
maksimal tanpa menambah lebar ruang yang harus
disediakan.

KESIMPULAN
Kami menyadari bahwa tidak mungkin mengulas

semua karakteristik dan keunggulan monitor LCD
Samsung SyncMaster di halaman ini. Dari pencarian
yang kami lakukan untuk memilih satu di antara
sekian banyak monitor LCD yang tersedia, kami benar-
benar terhenti pada deretan seri SyncMaster ini.
Keinginan hati sih memilih yang paling baru dan
paling lebar (SyncMaster 193T) karena semua
keunggulan yang mungkin didapatkan dari sebuah
monitor LCD telah ada di situ. Saya pasti akan leluasa
membuka banyak window ketika sedang membuat
program aplikasi, istri saya akan senang membuat
detil yang lebih tajam dalam disain grafisnya, dan
anak kami pasti akan lebih senang bermain game
serta aplikasi multimedia lainnya tanpa
membahayakan mata dan kesehatannya. Apa lagi? ***
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KUIS
Dapatkan 1 (satu) buah hadiah utama berupa monitor SyncMaster 551V, 1 buah CD-RW, 1 buah DVD-ROM dan 5

(lima) buah Jam Tangan Samsung bagi Anda yang beruntung dan bisa menjawab pertanyaan berikut ini. Jawaban
dikirim melalui kartu pos ke:

Redaksi PCplus
Gedung PCplus Lantai 2
Jl. Palmerah Selatan No. 12,
Jakarta 12070

Jangan lupa mencantumkan identitas Anda dengan jelas, meliputi: NAMA, JENIS KELAMIN, USIA, ALAMAT, NO.
TELP, NO KTP/SIM, dan PEKERJAAN. Gunting dan tempelkan kupon yang tersedia pada halaman ini. Jawaban kami
tunggu selambat-lambatnya tanggal 24 Desember 2003 (cap pos), dan pemenang akan diumumkan pada Tanggal 28
Januari 2004.

PERTANYAAN
1. Apakah Anda ingin membeli sebuah monitor LCD dalam waktu dekat (tiga bulan) ini?

a. Ya     b. Tidak     c. Ragu-ragu

2. Jika jawaban no. 1 di atas adalah “Ya”, Merk/Type apakah yang ingin Anda beli?
a. SyncMaster 152S/153V     b. SyncMaster 172S/173V     c. Merk Lain

3. Jika jawaban no. 1 di atas adalah “Tidak”, mengapa?
a. Belum ada dana      b. Belum ada rencana     c. Sudah puas dengan monitor CRT

4. Apakah pertimbangan utama Anda dalam memutuskan untuk membeli sebuah produk monitor komputer?
a. Kualitas gambar/warna     b. Bentuk fisik/ergonomi     c. Harga

5. Bagaimanakah menurut pandangan/kesan Anda terhadap produk komputer/periferal dari Samsung?
a. Bagus/berkualitas     b. Kurang bagus     c. Biasa saja

6. Menurut sebuah Survei, merk yang paling banyak diminati adalah produk Samsung. Bagaimana menurut Anda?
a. Setuju     b. Tidak Setuju     c. Ragu-ragu

7. Berapakah sudut pandang yang dapat dicapai SyncMaster 172N?
a. 1700/1700 (H/V)   b. 1400/1200 (H/V)    c. 1500/1200 (H/V)

8. Menurut pengetahuan Anda, seri monitor LCD Samsung SyncMaster yang manakah yang mempunyai interface
Analog dan Digital?
a. 192N     b. 193T     c. Tidak tahu

9. Berapa persenkah konsumsi daya pada monitor LCD dibandingkan konsumsi daya pada monitor biasa
(tabung/CRT)?
a. 30%     b. 50%     c. 70%

10. Apakah nama fitur yang dimiliki oleh monitor LCD Samsung SyncMaster
yang berfungsi meningkatkan kecerahan tampilan warna?
a. Ultra Bright     b. Magic Bright     c. Brightener

Ada Rupa
Ada Harga

Cukup menggelitik juga ketika seorang teman
menyodorkan sebuah sinyalemen: alasan paling besar
orang belum membeli monitor LCD adalah karena
harganya yang masih mahal. Dibandingkan dengan moni-
tor jenis CRT (tabung), tentu saja hal ini benar. Tetapi,
bukankah kita membeli sebuah produk itu karena kita
ingin menikmati manfaatnya?
Kita sebenarnya tidak
membayar sebuah produk
hanya karena produk itu
sendiri, tetapi kita
membayar manfaat
yang diberikannya.
Ada sejumlah
manfaat yang
diberikan monitor
LCD yang tidak
diberikan monitor
CRT, sehingga
kelebihan (perbedaan)
harga itu adalah untuk membayar kelebihan manfaatnya.

Sang teman masih mencoba memberikan argumen,
yaitu ada produk serupa --dengan teknologi dan
keunggulan yang hampir sama-- tetapi berharga lebih
murah. Ini memang sebuah fakta. Kita kadang-kadang bisa
menemukan di suatu lokasi di Ibukota yang menjual
sebuah merk --baru sehingga belum terkenal-- dengan
harga yang lebih murah. Terhadap ini saya hanya bisa
mengingatkan sebuah peribahasa: ada rupa ada harga.
Seperti ketika melamar gadis, jika rupanya elok dan dari
keluarga terpandang, Anda tidak cukup membawa uang
seperak. *** K
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BIOS (Basic Input/
Output System)

merupakan software
terpenting pada

sistem. BIOS sangat
mempengaruhi

kinerja dan kestabilan
dari suatu sistem. BIOS
yang dimaksud di sini

tentu saja adalah BIOS
dari mainboard.

idak hanya
mainboard
yang menggunakan
BIOS. Peralatan lain

seperti kartu grafis dan CD-
Writer juga menggunakan BIOS.

Meskipun begitu, BIOS dari
mainboard bisa dikatakan yang
memiliki peranan paling besar
sejalan dengan peranan dari
mainboard itu sendiri. Karena
peranan dan pengaruhnya yang
besar ini, BIOS mainboard sering
sekali tersedia versi yang lebih
barunya. Versi yang lebih baru
ini sering kali memberikan
kestabilan dan kinerja yang
lebih baik. Sayangnya meng-
update BIOS menjadi versi yang
lebih baru bisa berisiko. Namun
di sisi lain, semakin hari semakin
banyak produsen mainboard
yang menawarkan update BIOS
yang lebih aman.

TIDAK PERLU
MEMBONGKAR CASING

Dengan semakin majunya
teknologi, update BIOS bisa

dikatakan semakin hari semakin
aman. Selain mengalami
kemajuan dalam hal update BIOS,
BIOS yang tersedia pada
mainboard juga semakin pintar
saja.

Memang tidak (atau
setidaknya belum) semua
produsen mainboard telah
menggunakan BIOS yang lebih
pintar dibandingkan dengan
BIOS yang digunakan pada masa
yang lalu. Sebagian produsen
mainboard telah
mengimplementasikan BIOS yang

lebih pintar
pada
mainboard-
nya dan
meng-
gunakan hal
tersebut
sebagai
andalannya.

Pada
Setup BIOS,
seseorang
sering kali
bisa
mengatur
banyak hal
yang akan
mem-

pengaruhi kinerja dan juga
kestabilan. Sering kali untuk
memperoleh kinerja yang lebih
tinggi lagi, seseorang memaksa
hardware yang digunakan
dengan mengubah nilai yang
bersangkutan pada BIOS. Hal ini
bisa mengakibatkan sistem
menjadi tidak stabil, bahkan
sering pula membuat sistem
menolak untuk bekerja. Bila
sistem menolak untuk bekerja,
bahkan melakukan POST (power
on self test), cara yang paling
umum adalah dengan mereset
CMOS (complementary metal
oxide semiconductor) atau lebih
dikenal dengan istilah clear
CMOS.

Melakukan clear CMOS ini
sayangya mengharuskan
seseorang untuk memindahkan
jumper ataupun

menghubungpendekkan dua
buah titik pada mainboard.
Apabila PC telah selesai dirakit
dengan baik, clear CMOS ini akan
memaksa seseorang untuk
setidaknya membuka casing yang
digunakan. Dengan kata lain, hal
ini tidak begitu praktis. Belum
lagi kalau jumper atau titik yang
diperlukan itu posisinya terha-
lang oleh peripheral lainnya.

Dengan kemajuan teknologi,
sebagian produsen mainboard
masa kini telah melengkapi
mainboard-nya dengan semacam
fitur yang bisa mendeteksi
apakah sistem mengalami
ketidakstabilan, khususnya
menolak untuk melakukan POST.
Tentunya hal ini lebih ditujukan
pada ketidaktepatan pengaturan
BIOS. Setting BIOS ini dilakukan
pada Setup BIOS dan disimpan
pada CMOS. Apabila setting yang
digunakan membuat sistem
menolak untuk melakukan POST,
maka fitur di atas tadi akan
mengembalikan setting BIOS
yang digunakan pada kondisi Fail
Safe ataupun setting sebelumnya
yang masih bisa melakukan POST.
Pengembalian ini biasanya terjadi
pada proses untuk melakukan
POST berikutnya.

Hal yang umum adalah
sistem segera masuk pada Setup
BIOS dan kadang memberikan
semacam peringatan pada saat
proses melakukan POST
berikutnya. Pada sebagian
mainboard, bila pengguna tidak
mengindahkan peringatan yang
diberikan oleh fitur di atas dan
tidak mengubah setting BIOS
yang digunakan, maka tidak
akan ada perubahan pada setting
BIOS yang digunakan. Hal ini bisa
mengakibatkan sistem menolak
untuk melakukan POST lagi pada
saat proses melakukan POST
berikutanya.

Dengan fitur seperti di atas,
seseorang bisa mengubah
berbagai hal pada Setup BIOS
untuk meningkatkan kinerja,
tentunya tetap lebih baik secara

bertahap, tanpa perlu takut
harus membongkar PC untuk
melakukan clear CMOS.

Dengan cara seperti ini,
seseorang bisa menemukan
setting dengan kinerja paling
tinggi yang masih membuat
sistem cukup stabil, setidaknya
melakukan POST. Satu hal yang
perlu diingat adalah, kestabilan
pada saat POST tidak menjamin
kestabilan pada saat melakukan
suatu pekerjaan. Oleh karena itu
jangan lupa untuk melakukan uji
kestabilan sistem setidaknya
untuk pekerjaan yang ingin
dilakukan, sebelum
menggunakan PC tersebut.

HEMAT WAKTU
Suatu setting BIOS yang

stabil untuk suatu pekerjaan
belum tentu menghasilkan
tingkat kestabilan yang sama
pada pekerjaan yang lain. Hal ini
pernah dialami sendiri oleh
PCplus di saat menjalankan suatu
game dengan setting BIOS

tertentu tidak berhasil
memberikan kestabilan yang
memadai. Padahal sewaktu diuji
dengan program benchmark

tertentu, diperoleh kondisi yang
bisa dikatakan stabil.

Menggunakan setting BIOS
yang menghasilkan kondisi yang
stabil untuk game tersebut
membuat nilai benchmark yang
diperoleh menjadi lebih rendah.
Dari hal ini bisa disimpulkan
bahwa untuk memperoleh
kinerja maksimal dengan
kestabilan yang memadai pada
berbagai software yang
digunakan, kadang kala
diperlukan setting yang berbeda.
Mengubah setting BIOS setiap
menggunakan software yang
berbeda memang bisa dilakukan.
Sayangnya hal ini kurang praktis
khususnya bila nilai yang harus
dirubah cukup banyak.

Sebagian produsen
mainboard memberikan fasilitas
untuk menyimpan setting BIOS
yang diinginkan pada media
penyimpanan non volatile seperti
halnya harddisk. Dengan
menggunakan fitur ini pengguna
PC bisa dengan mudah

memanggil setting BIOS yang
diinginkannya tanpa perlu
mengatur setiap nilai yang
diinginkan untuk berubah lagi.

Cakrawala Gintings
cakra@e-pcplus.com BIOS Semakin

T

Di sinilah BIOS mainboard disimpan.

Tidak perlu takut lagi untuk merubah nilai-nilai yang mempengaruhi
kinerja dan kestabilan.
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Pintar Saja!
Selain hal-hal di atas, ada

juga produsen mainboard yang
menawarkan semacam fitur yang
akan menentukan seberapa besar
overclock yang dilakukan,
khususnya pada clock yang
diberikan ke prosesor, dan
diklaim masih memberikan
kestabilan yang memadai. Jadi
fitur ini memungkinkan
seseorang untuk tidak perlu
melakukan banyak trial and
error dalam hal menaikkan clock
yang diberikan pada prosesor
untuk memperoleh kinerja
maksimal.

SELAIN PINTAR JUGA
AMAN

Di samping fitur seperti ini,
fitur lain yang sebenarnya bukan
sesuatu yang sangat baru juga
membuat BIOS semakin pintar
dan memberikan keamanan
lebih. Hardware monitoring
sudah tersedia cukup lama, hanya
saja tingkat pengimplemen-
tasiannya berbeda-beda setiap
pada setiap mainboard. Hard-
ware montoring ini memonitor
kondisi dari beberapa hardware
yang tersedia pada PC.

Beberapa yang umum
dimonitor adalah suhu,
kecepatan kipas, dan tegangan.
Adapun komponen yang sering
dimonitor adalah prosesor,
mainboard, dan power supply.
Fitur ini bisa memberikan
semacam peringatan bila salah
satu dari nilai yang dimonitor
tidak masuk dalam batas yang
wajar. Sering pula untuk
keamanan, fitur ini bisa diatur
untuk melakukan shut down bila
nilai tersebut telah melampui
nilai tertentu. Jadi kalau kipas
dari pendingin yang digunakan
prosesor mati, bisa saja sistem
menyala sejenak dan langsung
melakukan shut down. Dengan
BIOS seperti ini, sistem menjadi
lebih aman dari bahaya
kerusakan akibat suhu yang
tinggi.

Pengembangan lebih lanjut
dari hardware monitoring ini
adalah penghematan daya dan
pengurangan polusi suara.
Dengan semakin panasnya
komponen PC yang digunakan
dewasa ini, sering kali HSF (Heat
Sink Fan) yang digunakan
membutuhkan daya yang lebih
besar dan yang paling
mengganggu adalah tingkat
kebisingan yang terjadi. Karena
sistem tidak selalu dalam kondisi
“bekerja keras”, sebagian
mainboard masa kini
menawarkan kemampuan untuk
mengatur daya yang diberikan
pada HSF tersebut. Jadi kalau
lagi tidak bekerja keras, HSF
tersebut diberi daya sedikit
(kecepatan kipas rendah) dan
bila sistem bekerja keras, HSF
tersebut diberi daya yang lebih
tinggi ataupun maksimum. Fitur
ini tentunya diatur pada Setup
BIOS.

Melihat dari berbagai

kemampuan yang
diberikan oleh BIOS
tersebut, BIOS masa
kini bisa dikatakan
BIOS pintar yang
semakin pintar saja
seiring dengan kema-
juan teknologi. Rasa-
nya di masa depan
BIOS semakin pintar
lagi dan bisa membe-
rikan kinerja dan ke-
stabilan yang mak-
simal bagi sistem. PC+

Atur peringatan dini terhadap suhu prosesor yang tinggi.

Bila sistem menolak untuk POST,
tidak perlu lagi untuk clear CMOS
secara manual.

○ ○ ○ ○ ○ ○ ○
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Mengaktifkan Menu
Network Monitor di Ponsel

Bagaimana kondisi
ponsel dan jaringan
operator yang Anda gunakan?
Berapa suhu battery ponsel
Anda saat ini dan bagaimana
kondisinya? Berapa jumlah SMS
yang pernah dikirimkan dari
ponsel Anda? Semua
pertanyaan tadi akan terjawab
jika Anda mengaktifkan
Network Monitor pada
ponsel. Tidak hanya itu saja,
Anda bahkan bisa mengetahui
daya yang sedang dialirkan saat
charging, informasi mengenai
jaringan, kapasitas battery, dan
masih banyak lagi.

Sebenarnya menu ini tidak
diperuntukkan bagi awam.
Tetapi, jika Anda hanya sebatas
“lihat-lihat saja” dan tidak
melakukan perubahan apapun,
dijamin tidak akan ada masalah.
Sekedar informasi, ponsel yang
dapat mengaktifkan menu ini
hanyalah ponsel Nokia mono-
chrome alias hitam-putih.
Tertarik untuk segera
mengaktifkan menu ini? Siapkan
Infrared atau kabel data dan
software LogoManager for
Nokia Phones, kemudian ikuti
langkah-langkah berikut:
1. Aktifkan Infrared atau kabel

data yang menghubungkan
ponsel ke PC

2. Klik [Start]>[All
Programs]>[LogoManager
for Nokia
Phones]>[LogoManager for
Nokia Phones] untuk
menjalankan program.

3. Ketika program
LogoManager terbuka, klik
[Tools]>[Network Moni
tor...] untuk membuka
window Network Monitor.
Pastikan bahwa koneksi
ponsel ke PC berlangsung
dengan baik, karena jika ada
masalah dalam koneksinya
tombol [Network Moni
tor...] pada menu [Tools]
tidak akan dapat diklik.

4. Setelah window Network
Monitor terbuka, perhatikan
pada Monitor output. Di
sana terdapat berbagai
informasi yang akan
ditampilkan di layar ponsel
jika Anda mengaktifkan
Network Monitor.

5. Sekarang klik [Enable...].
Pada window berikutnya yang
terbuka terdapat tiga opsi
yang dapat Anda pilih:
[Deactivate], [Field Test],
[Engineering]. Pilihan

akan mendapatkan menu
yang berisikan informasi
yang lebih banyak dan lebih
lengkap.

6. Jika Anda telah menentukan
pilihan, tekan [OK] lalu
tekan [Close].
Sekarang lihat menu utama

di ponsel Anda. Terdapat sebuah
menu baru dengan nama
Network Monitor. Jika Anda
masuk ke menu tersebut Anda
akan diminta untuk memasukkan
sebuah input berupa angka.

[Deactivate] adalah untuk
menonaktifkan menu
Network Monitor di
ponsel. Sedangkan [Field
Test] dan [Engineering]
mengaktifkan Network
Monitor. Bedanya, pada
opsi [Engineering] Anda

Masukkan angka 01, kemudian
kembali ke standby mode.
Disana akan terdapat berbagai
informasi mengenai ponsel dan
jaringan yang Anda gunakan.
Gunakan panah atas dan bawah
untuk melihat informasi
lainnya.

Jika Anda ingin kembali
mode normal, masuk kembali
ke menu Network Monitor
kemudian masukkan angka 00.

Steven Andy Pascal
steven@e-pcplus.com
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Jika Anda
pengguna Yahoo!
Messenger maka untuk mene-
mukan ruang chat akan sangat
mudah sekali. Anda tinggal pilih
[Join Room] lalu masuk ke da-
lam room sesuai kategori yang
Anda inginkan. Apakah itu ka-
tegori musik, olahraga, regional
atau yang lainnya. Lalu bagai-
mana jika Anda seorang chatter
yang menggunakan mIRC untuk
chatting, lalu ingin join ke suatu
channel tapi tidak tahu nama

Search Engine untuk Mencari
Channel di mIRC

channel-nya. Sebab di mIRC tidak
ada fasilitas kategori seperti yang
ada di Yahoo! Messenger. Yang
ada hanyalah daftar channel tapi
kita tidak tahu channel itu masuk
ke kategori yang mana.

Trik untuk mencari channel
yang kita inginkan adalah, jalan-
kan browser dan pergi ke http://
irc.netsplit.de/channels/ . Situs
tersebut merupakan search engine
untuk mencari channel yang ada
di dalam jaringan mIRC. Hingga
saat ini sudah 548 network yang

sudah terdaftar pada search
engine ini.

Cara menjalankannya sa-
ngat mudah, sama seperti Anda
menggunakan Google, Yahoo!,
atau yang lainnya. Setelah Anda
memasukkan keyword lalu hasil
yang akan ditampilkan adalah
nama channel-nya, nama server,
jumlah user, dan topik yang
sedang dibahas. Happy hunting!

Rully Novrianto
roolee@telkom.net

Menu Help and
Support yang terdapat di
menu [Start] Windows XP dise-
diakan oleh Microsoft untuk
membantu Anda memahami dan
menggunakan sistem operasi
buatannya. Pada menu ini dise-
diakan berbagai informasi sepu-
tar Windows, seperti cara pema-
kaian berbagai fungsi di Win-
dows, meng-update Windows
serta mendapatkan bantuan atas
permasalahan yang Anda temui

Menyembunyikan Menu
Help and Support

pada sistem operasi ini.
Meskipun kegunaan dari

menu Help and Support ini
cukup besar bagi pemula,
namun bagi Anda yang sudah
terbiasa menggunakan Win-
dows, menu ini hanya membuat
menu [Start] menjadi penuh.
Oleh karena itu Anda dapat
menonaktifkannya jika memang
dirasa menu ini kurang berman-
faat bagi Anda. Caranya:
1. Klik [Start]>[Run..]. kemudian

ketik regedt32.exe pada
window Run yang terbuka.

2. Masuklah ke subkey:
HKEY_CURRENT_USER\
Software\Microsoft\
Windows\Current
Version\Policies\Explorer.

3. Pada bagian kanan window,
klik kanan mouse kemudian
klik [New]>[DWORD value]
untuk membuat sebuah
DWORD value baru.

4. Beri nama DWORD value terse-
but dengan nama NoSMHelp.

5. Isikan value data-nya
dengan nilai 1.

Steven Andy Pascal
steven@e-pcplus.com
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Menampilkan Lirik Lagu
Pada Windows Media Player

Anda ingin tahu
berapa banyak karakter yang
ada pada sebuah sel, misalnya
sel A1? Anda bisa
menggunakan fungsi LEN.
Caranya, jalankan Excel, klik
pada sel yang diinginkan.
Ketikkan (terserah Anda)

DATA pada sel A1
Andhi Irawan pada sel A2
Jakarta pada sel A3

lalu tekan Enter.

Klik sel B1, ketikkan =len(a1)

Fungsi Len pada Excel
Klik sel B2, ketikkan =len(a2)
Klik sel B3, ketikkan =len(a3)

tekan Enter. Sel B1 akan
menampilkan 4, sel B2
menampilkan 11, sel B3
menampilkan 11 (7 karakter
dan 4 spasi).

Satu trik lagi, gunakan
perintah =LENB( ) untuk
karakter bukan huruf Latin
(gambar 2), dengan syarat
penulisan harus diapit tanda
kutip.

Andhi Irawan
andhiirawan@hotmail.com

Gambar 1

Gambar 2

Sebagai player
standar bawaan Windows,
Windows Media Player versi
teranyar tampaknya kini cukup
dapat diandalkan untuk
menjadi teman setia Anda
dalam memainkan file multime-
dia. Jika Anda menggunakan
Windows XP sebagai sistem
operasi yang terpasang pada
komputer, maka secara default
Windows Media Player yang ada
pada komputer Anda adalah
Windows Media Player 8. Versi
terbaru player gratisan dari
Windows ini sekarang sudah
mencapai versi 9. Informasi
lebih lengkap mengenai player
ini dapat Anda baca di
plusFokus edisi 122.

Fitur-fitur yang disuguhkan
oleh Windows Media Player
sejak versi 8.00 sudah cukup
lengkap baik dari segi interface
maupun kemampuan lainnya
seperti streaming, ripping,
burning. Bahkan player ini juga
memiliki beberapa kelebihan
yang jarang dimiliki oleh
multimedia player lainnya
semisal Winamp ataupun
Musikmatch Jukebox. Salah
satu kelebihan yang dimiliki
oleh Windows Media Player
adalah Anda dapat
menampilkan lirik lagu sewaktu
Anda memainkan file
multimedia dengan player
tersebut.

Fasilitas untuk
memunculkan lirik lagu
sebenarnya juga dapat Anda
lakukan pada Winamp,
namun Anda terlebih dahulu
harus memiliki plug-in
LyricsShow seperti yang
pernah diulas pada
plusDownload edisi 113.
Berbeda dengan Winamp,
jika Anda menggunakan
Windows Media Player, Anda
tidak perlu repot-repot men-
download plug-in hanya
untuk menampilkan lirik
lagu, yang perlu Anda
lakukan adalah mengikuti
trik sederhana berikut ini.

Langkah pertama yang perlu
Anda lakukan adalah
menciptakan suatu file multime-
dia yang memiliki lirik caranya
sebagai berikut:
• Buka Windows Media

Player.
• Klik [File]>[Add to Media

Library]>[Add File].
Kemudian browse menuju file
multimedia yang Anda ingin
tampilkan liriknya. File
tersebut bisa merupakan file
berekstensi apa saja baik yang
audio maupun video asalkan
ekstensi tersebut didukung
oleh Windows Media Player.

• Klik taskbar Media Library
yang terdapat di sisi kiri
player. Jika taskbar tersebut
tidak terlihat, Anda dapat
menghilangkan tanda
centang pada [View]>[Full
Mode Option]>[Hide
Taskbar] untuk
memunculkan taskbar
tersebut. Cara lain yang dapat
Anda lakukan untuk
mengakses Media Library
adalah dengan mengklik
[View]>[Taskbar]>[Media
Library].

• Cari file multimedia yang
telah Anda simpan di dalam
Media Library tersebut. Jika
file tersebut berupa audio

maka terletak pada
[Audio]>[All Audio]. Jika
berupa video maka terletak
di [Video]>[All Clips].

• Klik kanan file multimedia
tersebut dan pilih Proper-
ties. Pada dialog box
Properties pilih tab [Lyrics].

• Ketikkan lirik lagu dari file
multimedia tersebut, setelah
itu klik [Apply]> [OK].
Pada tahap ini Anda telah
berhasil menciptakan suatu
file multimedia yang
memiliki lirik. Jika file
multimedia yang telah
memiliki lirik tersebut
terhapus dari Media
Library, Anda hanya cukup
melakukan langkah kedua
untuk memunculkannya
kembali pada Media
Library dan tidak perlu lagi
menulis lirik. Liriknya akan
tetap ada meskipun file
tersebut terhapus dari
Media Library. Asal bukan
file-nya saja yang terhapus
dari harddisk.
Tahap selanjutnya adalah
menampilkan lirik tersebut,
caranya sebagai berikut:

• Klik taskbar [Now Playing]
atau [View]>[Taskbar]>[Now
Playing].

• Klik drop down menu pada

sisi kanan atas player, dan
pilih [All Audio] atau [All
Video] sesuai dengan jenis file
multimedia Anda.

• Mainkan file multimedia ter-
sebut dan klik [View]>[Now
Playing Tools]> [Lyrics].

Kini Anda sudah dapat
menikmati musik sambil melihat
lirik lagu dari file multimedia
yang sedang Anda mainkan

dengan Windows Media Player.
Perlu diketahui, lirik ini hanya
dapat ditampilkan pada saat
player berada dalam keadaan
Full Mode. Dalam keadaaan
Skin Mode ataupun Full
Screen Anda tidak akan pernah
menjumpai lirik lagu tersebut.
Selamat bermultimedia.

ARIF PERDANA
mail_id_2001@yahoo.com
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Splitz!

Potong Gambar
Untuk Web

SWFscanner

Mengambil Isi SWF

Salah satu taktik
untuk menampilkan gambar
yang cukup besar untuk sebuah
situs adalah dengan memecah
gambar tersebut menjadi
beberapa bagian kecil. Taktik ini
bisa juga digunakan apabila
pada bagian tertentu dari gam-
bar merupakan link ke halaman
lain. Memecah gambar dan
menyatukannya lagi dengan
menggunakan tabel di HTML
harus telaten agar gambar yang
disatukan tidak mencong.

Freeware yang dapat
melakukan potong-memotong
itu adalah Splitz!. Splitz! dapat
memecah gambar berdasarkan
grid yang dibuat, lalu kemudian
mengekspor hasilnya dalam
bentuk tabel di HTML. Grid
yang dibuat bisa di-save untuk
di-load kembali pada gambar
yang lain.

Output gambar yang
dihasilkan ada beberapa tipe,
antara lain JPEG, BMP, TIFF,
dan PNG. Harus diperhatikan
bahwa untuk ditampilkan di
halaman situs, ukuran file
gambar sebaiknya kecil agar
lebih cepat di-load.

Agar ukuran file gambar
lebih optimal, Splitz!

menyediakan kompresi untuk file
JPEG. Kompresinya bisa dipilih
antara [Best Compression], yang
berarti file-nya berukuran kecil
namun kualitas gambarnya
diturunkan, atau [Best Quality],
yang berarti ukuran file-nya
besar namun kualitas gambarnya
seperti kualitas file asli.

Fitur lain dari Splitz! adalah
pengaturan warna. Ada tiga
buah jenis, yaitu RGB (Red,

Green, Blue), CMY (Cyan,
Magenta, Yellow) dan HLS (Hue,
Lightness, Saturation).
Ketiganya bisa diatur untuk
menghasilkan gambar sesuai
selera.

Splitz! bisa diperoleh dari
www.b-zone.de. Freeware ini
berukuran 356KB.

Alex Pangestu
alex@e-pcplus.com

Di dalam file SWF
terdapat berbagai objek seperti
gambar, suara dan actionscript.
Biasanya file SWF terkunci.
Objek-objek di dalamnya tidak
bisa diambil untuk disimpan.
Sampai akhirnya muncullah
SWFscanner, sebuah aplikasi
yang bisa mengambil isi file SWF.

SWFscanner bisa di-down-
load dari www.livetronix.com.
Ukurannya tidak besar-besar
amat, cuma 781KB. Versi yang
di-download ini adalah versi
yang belum diregister. Untuk
meregisternya, biaya yang
dibutuhkan adalah US$19.99.

Sebelum diregister, SWFscanner
tetap dapat digunakan walaupun
ada fitur yang dimatikan, yaitu
fitur mengambil actionscript yang
digunakan pada file SWF.

Setelah sebuah file SWF
dibuka, jeroan-nya langsung bisa
dilihat. Objek-objek tersebut bisa
diekstrak satu per satu maupun
sekaligus. Untuk satu per satu,
klik objek yang ingin diekstrak,
kemudian klik [Tool]>[Extract
Objects]. Sedangkan untuk
mengekstrak seluruhnya, klik
[Tool]>[Extract All Objects].

SWFscanner dapat
digunakan untuk memodifikasi

ukuran dan frame rate movie.
Untuk memodifikasi dua
properti tersebut, klik
[Tool]>[Edit Movie Properties].
Fitur lainnya adalah mengganti
sebuah gambar yang ada di
dalam movie. Caranya, pilih
gambar yang ingin diganti, lalu
klik [Tool]>[Replace Image].

SWFscanner hanya
kompatibel dengan file SWF
yang dihasilkan oleh Flash 4 dan
Flash 5. SWF keluaran Flash MX
tidak bisa dibuka menggunakan
SWFscanner.

Alex Pangestu
alex@e-pcplus.com
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R-Studio

Menghadirkan
Kembali File yang

Terhapus
Barang kutah iku
wutuh (benda yang
tumpah itu tidak berkurang)
adalah sesuatu yang mungkin
diterapkan dalam dunia
komputer. Bagaimana tidak?
File kita yang sudah hilang
akibat terhapus ataupun
sengaja dihapus sebenarnya
tidak hilang. File itu masih ada
di dalam harddisk dan Anda
bisa mengambil kembali file
yang terhapus tersebut.

R-Studio adalah salah satu
software yang dapat mem-
bantu Anda untuk mengem-
balikan file-file yang telah hi-
lang. Dengan R-Studio Anda
dapat me-restore atau
mengembalikan file-file Anda
yang telah terhapus. Cukup An-
da scan partisi mana yang akan
anda cari file-nya. Jika Anda
lupa pada partisi mana file
yang terhapus, Anda bisa men-
scan satu atau lebih harddisk.

Jika file telah ditemukan,
beri tanda centang dengan
cara mengklik sekali pada
folder atau file tersebut.
Selanjutnya Anda recover
dengan menekan tombol
[Recover] dan file Anda pun
akan kembali lagi. Sebagai
catatan bahwa semakin besar
kapasitas suatu partisi atau
suatu harddisk, semakin lama
pula waktu yang dibutuhkan
untuk mencari file tersebut.

Tidak hanya pada
harddisk, file Anda yang
hilang pada disket atau CD
juga dapat di-restore dengan
bantuan R-Studio. Program
yang tergolong komersial ini
sudah mampu mendukung
sistem FAT 12 (disket), FAT 16
(Windows 95), FAT 32 (Win-
dows 98, ME, 2000,XP), NTFS
(Windows 2000, XP), NTFS5
(untuk Windows 2000), dan
Ext2FS (Linux).

Pada gambar terlihat
contoh folder penulis yang
telah terhapus. Pada jendela
sisi kiri adalah Windows
Explorer yang menunjukkan
keadaan harddisk pada partisi
drive F. Pada jendela sisi kanan
terlihat R-Studio yang aktif
dan telah men-scan partisi
drive F. Terlihat perbedaan
pada jendela sisi kiri tidak
terdapat folder MSDOS 7
sedangkan pada jendela
sebelah kanan terdapat folder
MSDOS 7 yang berisi file-file.
Dengan menekan tombol
[Recover], maka folder atau-
pun file yang terdapat pada
folder MSDOS  7 akan dapat
dikembalikan.

Jika Anda tertarik dengan
software data recovery ini, Anda
bisa mencobanya dengan men-
download di situs www.r-tt.com
dan jika Anda tertarik untuk

memiliki, Anda dipaksa untuk
merogoh kocek sebesar US$
179.99.

Andi Pramono
kompunet@telkom.net
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Copernic

Freeware Sebagai
Search Engine

Robust Internet Speed Booster v3.0

Percepat Akses Internet

Para pengguna
Internet pasti tidak asing
dengan istilah search
engine.Dengan search engine
para pengguna Internet bisa
mencari beragam informasi
seputar topik yang mereka
inginkan. Dengan hanya
mengetikkan kata atau kalimat
pada kotak pencarian, search
engine akan menyajikan
hasilnya, lengkap dengan
alamat Web yang diinginkan.

Untuk dapat
memanfaatkan fasilitas search
engine, tentu para pengguna
Internet harus mengakses situs
yang menyediakan fasilitas
tersebut. Jika search engine
yang digunakan tidak hanya
satu, para pengguna Internet
bisa repot bolak-balik antar-
search engine. Namun dengan
Copernic, kerepotan itu bisa
teratasi.

Copernic adalah sebuah
software yang menggabungkan
beberapa search engine.
Software ini bersifat freeware
dan bisa didapatkan di
www.copernic.com (untuk

Banyak faktor yang
dapat menentukan
kecepatan akses di dunia maya.
Selain dari software itu sendiri,
faktor lainnya yang turut
mendukung adalah hardware,
jenis koneksi (dial-up, kabel,
DSL, ISDN dan satelit) dan ISP
(Internet Service Provider alias
penyedia layanan Internet).
Tetapi dengan Robust Internet
Speed Booster, performa
kecepatan akses Internet dapat
ditingkatkan, walaupun masih
tergantung dari faktor-faktor

versi Copernic Agent Basic 6.1
dengan ukuran 3,3MB).

Segera setelah software ini
diinstal, berbagai kemudahan
akan didapatkan. Salah satunya
adalah, seperti yang tadi sudah
disebutkan, perlu bolak-balik ke
situs penyedia search engine
hanya untuk mencari secuil
informasi. Semuanya sudah
ditangani oleh Copernic.

Situs-situs apa saja yang
mampu dijelajah Copernic, bisa
dilihat di bagian [Engine En-
ables]. Di sini pula situs search
engine yang digunakan Copernic
bisa dikurangi atau ditambah.

Selain situs web, Copernic
juga mampu melacak alamat e-
mail atau kategori lain yang
terletak di sebelah kiri layar.
Kategori yang aktif diberi tanda
lebih terang sementara kategori
lainnya hanya bisa dilacak
dengan menggunakan dua versi
Copernic lainnya yakni Copernic
Agent Personal dan Copernic
Agent Professional.

Selamat bertualang!

Edi Kurniadi
albanjary07@plasa.com

yang tadi disebutkan.
Kelebihan software ini

dibandingkan software sejenis
lainnya adalah adanya 3 paket
yang disertakan, yaitu:
• Network Pinger: berfungsi

sebagai pencegah
terputusnya antara koneksi
dengan ISP. Paket  ini
mengatur agar koneksi
dengan host selalu
terhubung.

• Internet Speed Booster: paket
ini yang digunakan untuk
mengonfigurasi jenis koneksi

dan kemudian
mengoptimalkannya secara
otomatis maupun manual.

• FreeMEM: berfungsi untuk
mengoptimalkan RAM
dengan cara membebaskan
bagian memori yang tidak
terpakai.
Robust Internet Speed

Booster termasuk freeware alias

gratis. Software sebesar
3,696MB ini dapat Anda peroleh
dengan mudah di
www.robust.ws. Tidak lupa,
software ini dapat dijalankan
pada semua versi Windows (95/
98/2000/NT dan XP).

Pramadhi Jatmika
pramadhi@hotmail.com
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GNU/Linux SuSE 8.02: Si Bunglon
dari Eropa yang Semakin Menawan

B

Vincent Bayu T.B.
vincent@e-pcplus.com

Layaknya bunglon
yang pandai beradap-

tasi dengan tempat
hidupnya, GNU/Linux

SuSE mengalami
perubahan yang cepat
sekali dalam beradap-

tasi, menyesuaikan diri
dengan harapan para
user akan kemudahan

dan tampilan yang
familiar serta artistik.

(Gambar1)

ila tidak
waspada dan
mawas diri, bukan tidak
mungkin dominasi

sistem-sistem operasi komersil-
kapitalistik akan terlibas oleh
barisan distro GNU/Linux yang
semakin ciamik ini. Hal apa saja
yang memberi kontribusi

terhadap daya tarik distro GNU/
Linux dari negeri filsuf Friedrich
Nietzsche ini?

Otomatisasi Instalasi
Secara praktis, instalasi

hanya tinggal klak-klik tombol
dan pilihan yang telah
disediakan. Dua partisi utama
yang diperlukan dalam instalasi

GNU/Linux, yaitu /
swap dan /(root)
dibuat dan
ditentukan
letaknya secara
otomatis oleh GNU/
Linux SuSE. Namun,
pengeditan partisi-
partisi dalam
harddisk tetap bisa
dilakukan setelah
instalasi selesai
dengan fasilitas
YaST (Yet another
Setting Tool)
Control Center

yang bisa diakses melalui [Main
menu]>[Preferences]>
[YaST menu]>[YaST2 Control
Center]>[Hardware]>[Partitioner]
(Gambar 2).

Demikian pula bila user tidak
mau repot. Pemilihan paket
aplikasi yang akan diinstal
dilakukan secara otomatis oleh
GNU/Linux SuSE berdasarkan

analisis terhadap kapasitas
harddisk dan spesifikasi hardware
komputer oleh YaST2 Tool.
Sebaliknya, jika user ingin
memilih sendiri paket instal,
tinggal klik kategori software
dan memilihnya.

Ada satu bagian yang perlu
diperhatikan dalam instalasi,

yaitu pengaktifan fasilitas 3D
untuk menunjang tampilan grafis
di GNU/Linux SuSE. Pilihlah
"activate" saat kita sampai pada
kotak dialog aktivasi fasilitas 3D.
Langkah lain yang perlu
dilakukan sendiri oleh user
adalah penentuan zona waktu,
pengisian user, password user
serta password root. Setelah

"instalasi dasar" (demikian istilah
yang diberikan oleh GNU/Linux
SuSE saat instalasi CD pertama
selesai), user harus memindah
prioritas booting komputer dari
CDROM ke harddisk sekaligus
untuk mengaktifkan sistem
operasi GNU/Linux SuSE untuk
pertama kali. Sebelum masuk ke

sistem, masukkan
dahulu CD instalasi
kedua. Segera
setelah kita masuk
ke sistem GNU/
Linux SuSE, sistem
akan melanjutkan
instalasi sampai
selesai. Praktis,
yang dapat kita
lakukan adalah
"duduk manis",
menunggu proses
instalasi selesai
(persis seperti yang
ada pada proses
instalasi Windows).

Pesona langsung ditebar oleh
GNU/Linux SuSE saat instalasi
selesai dan langsung menuju
login pertama kali. Desktop KDE
begitu terasa menawan.

Kekayaan Paket
Instalasi RPM

Sampai saat ini, paket RPM
(Redhat Packages Manager)

merupakan paket standar
instalasi aplikasi di tiga distro
GNU/Linux (Redhat, Mandrake
dan SuSE) yang paling mudah
dan praktis dilakukan. Di
samping menggunakan perintah
# rpm -ivh lokasi file nama
file.rpm, GNU/Linux SuSE juga
menyediakan fasilitas instalasi
dengan tampilan grafis dan
tinggal klik ganda paket RPM
tersebut. Fasilitas ini dapat
diakses melalui [Main
menu]>[Preferences]>[YaST
menu]>[YaST2 Control
Center]>[Software]>[Install/
Remove Software].

Mungkin, realitas lebih kaya
dan beragamnya paket-paket
RPM yang disediakan GNU/Linux
SuSE (dan GNU/Linux Mandrake)
dalam portal-portal penyedia
download paket RPM semacam
www.rpmfind.net dibandingkan
GNU/Linux Redhat merupakan
suatu ironi. RPM adalah paket
instalasi aplikasi standar GNU/
Linux Redhat yang "khas" Amrik
(Amerika). Tetapi, justru hal
itulah salah satu faktor yang
membuat GNU/Linux SuSE yang
"Eropa sentris" ini semakin eksis
dan berkibar.

Mounting Otomatis
terhadap Partisi
Harddisk, Partisi
Sistem Operasi Lain
serta Hardware

Multi boot merupakan
fenomena yang mulai terasa
populer di kalangan pengguna
komputer. Keberadaan partisi

Gambar 1. Tampilan desktop
KDE GNU/Linux SuSE 8.02

Gambar 2. YaST2 Tool yang khas GNU/Linux
SuSE dan multifungsi
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sistem operasi lain dideteksi dan
di-mount secara otomatis oleh
GNU/Linux SuSE sehingga user
tidak perlu login sebagai root
dan me-mount dengan perintah
# mount -t
formatfilesistemoperasi /dev/
hda lokasi partisi /mnt.
Bahkan, partisi tersebut langsung
diberi nama sesuai dengan sistem
operasinya.

Tidak seperti distro GNU/
Linux lainnya yang memasukkan
partisi sistem operasi lain ke
dalam direktori /mnt, GNU/Linux
SuSE memasukkan partisi sistem
operasi lain sejajar dengan
direktori utama lainnya (Gambar
3). Jika kita hanya akan melihat
atau mengambil (mengimpor) file
dari partisi sistem operasi lain,
login sebagai root memang tidak
diperlukan. Namun, bila kita
akan menyimpan data ke partisi
tersebut, login sebagai root harus
dilakukan. Sama halnya dengan

GNU/Linux Mandrake, tampilan
login sebagai root belum tampak
sebelum diaktifkan.

Mounting terhadap hard-

ware, utamanya CD-ROM
dilakukan secara otomatis,
sehingga kita tidak perlu
melakukan pengeditan di
direktori /etc/fstab dan
memount di direktori /mnt.

Paket-Paket Aplikasi
yang Relatif "Ringan"

Berbeda dengan dua
'saudara dekat"nya, yaitu GNU/
Linux Mandrake dan GNU/Linux
Redhat, GNU/Linux SuSE
menyediakan aplikasi standar
KDE, seperti: Kword (penyunting
kata), Kspread (penyunting
spreadsheet), Kchart dan Kivio
(penyunting presentasi).

GNU/Linux Mandrake pada
versi terbarunya menyediakan
kombinasi aplikasi office antara
OpenOffice.org dengan KOffice,
sedangkan GNU/Linux Redhat
versi terbaru (versi 9.0)
menyediakan aplikasi
OpenOffice.org sebagai standar.

Dalam penggunaannya, kita
akan merasakan bahwa aplikasi-
aplikasi dalam OpenOffice.org
berjalan relatif lebih lambat dan

berat dibandingkan dengan
aplikasi-aplikasi serupa di
KOffice. Selain aplikasi kantor,
dan game, GNU/Linux SuSE juga
menyertakan aplikasi
"edutainment" seperti Klogic
yang merupakan aplikasi simulasi
sirkuit digital.

Fasilitas Entertain-
ment dan Game

Skin (tampilan) KDE yang
diterapkan oleh GNU/Linux SuSE
sangat menawan dan terkesan
futuristik. Bila pada GNU/Linux
Redhat dan GNU/Linux Mandrake
patch atau codec
xmms.mpg.123 diperlukan
supaya XMMS tetap bisa
memainkan file audio MP3,
ternyata tambahan file tersebut
tidak diperlukan oleh XMMS di
GNU/Linux SuSE.

Selain player VCD RealPlayer,
Xine yang merupakan player VCD
andalan KDE perlu diinstal dalam

GNU/Linux SuSE ini.
Cara lain, Anda perlu
mengaktifkan pilihan
Xine dalam
pemilihan paket
instal saat proses
penginstalan GNU/
Linux SuSE.

Perlu game-
game 3D bawaan
instalasi yang
mengasyikkan? Coba
saja TuxRacer atau

Armagetron.
Tapi, ingat, fasilitas 3D harus

diaktifkan saat instalasi sistem
GNU/Linux SuSE agar tampilan

bisa lebih halus dan game
berjalan lebih mulus. Mau game
strategi? Coba aksi Si Penguin di
Pingus (Gambar 4).

Walaupun lahir di Eropa,
GNU/Linux SuSE menyediakan

game permainan ala Asia seperti
Mahyong (Cina) dan Sinsen-Sho
(Jepang).

Fasilitas Multimedia
Multimedia telah menjadi

salah satu gaya hidup masyarakat
dewasa ini.

Bila paket Multimedia dan
Entertainment kita masukkan
dalam daftar paket yang akan
diinstal saat proses instalasi GNU/
linux SuSE, maka akan tersedia
aplikasi produksi multimedia,
seperti: KonCD untuk
"membakar" CD, Kmixer untuk
mengolah file audio, MIDI
synthesizer, Alsa Modular

Synthesizer, Broadcast2000, dan
lainnya.

Senjata Pamungkas:
YaST2

Fasilitas YaST2 (Yet another
Setting Tool)
yang menjadi
salah satu
"trademark"
GNU/Linux
SuSE patut
diakui
sangatlah
powerful.
Bagaimana
tidak? Fasilitas
yang satu ini
menangani
berbagai
fungsi, seperti:
menjalankan
penginstalan
yang memiliki
banyak

otomatisasi, deteksi dan
konfigurasi hardware,
administrasi sistem dan user,
administrasi jaringan dan
Internet,  layanan update dan
pemeliharaan sistem, dan
lainnya. Fungsi yang disebutkan
terakhir dikenal dengan nama
SuSE YOU (YaST2 Online Up-
date).

Maka...., jika kita
memerlukan distro GNU/Linux
yang user friendly, serba
otomatis, yahud di desktop
(aplikasi rumahan dan multime-
dia) maupun kuat di jaringan,
GNU/Linux SuSE adalah alternatif
jawabannya. PC+

Gambar 3. Partisi sistem operasi lain tidak ditempatkan di dalam direktori /mnt,

Gambar 4. Game Pingus dan Tux Racer
yang lucu, 3D dan mengasyikkan.
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Menjaga Prosesor
Agar Tetap Aman

Silvester Sila Wedjo
sila@e-pcplus.com

S

Buat sebagian besar
pengguna PC, panas
yang berlebih pada
prosesor tentu jadi
momok yang amat

ditakuti. Penurunan
performa bisa jadi
akibat yang paling

ringan. Yang paling
berat adalah rusaknya

prosesor lantaran
terbakar. Untuk

penggunaan biasa,
kejadian semacam ini

memang jarang
terjadi, apalagi jika

aplikasi yang
dijalankan tidaklah

terlalu menuntut
kerja berat dari

prosesor. Namun,
karena suatu sebab

yang tidak jelas,
bukan tidak mungkin

prosesor Anda tiba-
tiba punya panas yang

berlebih dibanding
biasanya.

ebenarnya,
banyak kiat
yang bisa dilakukan
agar panas prosesor

Anda tidak akan pernah sampai
pada batas yang membahayakan.
Selain komponen pendingin yang
harus benar-benar dipilih secara
teliti, beberapa langkah juga harus
Anda perhatikan agar suhu
prosesor bisa tetap terjaga.

1.  PAKAILAH THERMAL
PASTE

Ini adalah salah satu
komponen terpenting untuk
pendingin prosesor yang kadang
dilupakan atau diabaikan sebagian
besar pengguna PC. Padahal,
untuk transfer panas dari prosesor
ke pendinginnya, thermal paste ini
fungsinya sangat vital. Maklum,
thermal paste memang sangat
penting untuk mengisi rongga-
rongga antara antara prosesor dan
heatsink yang kadang berukuran
mikroskopis. Padahal, adanya
rongga ini bisa membuat transfer
panas menjadi kurang sempurna.
Oleh sebab itu, thermal paste

inilah yang mengisi rongga-rongga
seperti ini.

Meski begitu, tidak semua
thermal paste yang dijual di pasaran
punya kualitas yang baik. Maklum,

bahan dan “racikan” dari masing-
masing merek berbeda-beda. Kalau
Anda mau prosesor Anda selamat
dari bahaya kepanasan, pilihlah
thermal paste yang berkualitas baik,
meskipun terkadang harganya
sedikit lebih mahal.

Yang tak kalah penting,
apabila Anda sering melepas
prosesor, senantiasa gunakan
thermal paste baru dan bersihkan
terlebih dahulu sisa-sisa thermal
paste yang lama, karena kadang
kala barang yang lama tadi justru
menjadi penyebab panas.

2.  PAKAI PENDINGIN
YANG BAIK

Urusan pendingin prosesor
memang tidak ada habis-habisnya
dibicarakan. Buat penggunaan
standar, heat sink fan standar
memang cukup. Tetapi tidak untuk
mereka yang gemar mengutak-atik
prosesornya agar performanya
melebihi kemampuan standar. Buat
pengguna semacam ini, pendingin
yang digunakan haruslah yang

benar-benar teruji. Selain bahannya
yang harus diperhatikan, desainnya
juga tak kalah penting disimak.
Beberapa pengguna memang masih
tetap percaya diri menggunakan

heat sink fan
standar dari
bahan aluminium
dengan fan
berkecepatan
standar. Namun,
banyak juga yang
menggunakan air,
bahkan
kompresor
pendingin, hanya
untuk menjaga
prosesor yang
bekerja tidak
sampai
mengeluarkan
panas yang
tinggi.  Ini
biasanya

dilakukan para overclocker yang
memacu prosesornya jauh melebihi
kecepatan standar.

3.  PASTIKAN PENDINGIN
PROSESOR DALAM
KEADAAN MANTAP

Posisi atau kedudukan
pendingin prosesor terkadang
tidak diperhatikan betul saat
pemasangan oleh penggunanya.
Padahal, ini bisa sangat berakibat
fatal buat prosesor. PCplus
misalnya pernah mengalami panas
berlebih ketika menggunakan
kompresor sebagai pendinginnya.
Akibatnya, meski menggunakan
komporesor yang sangat dingin,
suhu prosesor tetap panas, tidak
seperti biasanya.  Buat prosesor
Intel Pentium 4, kesalahan
pemasangan ataupun kurang
pasnya kedudukan heatsink
memang tidak dimungkinkan
lantaran klep pengunci heatsink
akan sangat sulit terkunci bila
posisinya belum pas benar.
Namun, untuk heatsink fan

prosesor AMD, kemungkinan
kurang pasnya kedudukan
heatsink fan masih mungkin
terjadi.

4.  PERHATIKAN SISTEM
ALIRAN UDARA DALAM
CASING

Meski pendingin prosesor
Anda sudah benar-benar
memuaskan dari segi bahan dan
desainnya, bukan berarti Anda
benar-benar aman dari panas
berlebih pada prosesor. Faktor lain
yang mesti diperhatikan adalah
sistem aliran udara di dalam
casing. Sirkulasi udara yang baik
di dalam casing akan
menyebabkan suhu ruang di
dalam casing juga akan
rendah. Ini sangat penting
mengingat suhu di
dalam casing juga
sangat
memengaruhi suhu
udara yang
mengalir di dalam
heatsink fan
pendingin prosesor.

Untuk
membuat sirkulasi
udara yang baik,
selain penambahan
fan di front panel
dan di bagian
belakang casing dan
pemilihan bahan
casing yang teliti,
pengaturan kabel-kabel yang ada
di dalam casing juga sangat
penting. Bila memungkinkan, atur
kabel power dari power supply
agar tidak mengganggu aliran
udara dalam casing. Begitu pula
dengan kabel-kabel data.
Beberapa seri motherboard sudah
menyertakan kabel data buat
harddisk dengan bentuk yang
cukup ramping. Kabel data
semacam ini memang dirancang
agar aliran udara tidak
terganggu.

5.  SETTING BIOS UNTUK
BATAS AMAN

Untuk keamanan prosesor
dari bahaya panas berlebih, rata-
rata motherboard juga
menyertakan fitur keamanan
prosesor pada BIOS pintarnya.
Fitur-fitur keamanan untuk
prosesor semacam ini haruslah
Anda setting ke posisi enable agar
prosesor terhindar dari panas yang
tidak diinginkan.

Fitur keamanan yang paling
umum adalah batas suhu maksimal
yang bisa diatur oleh pengguna
yang memungkinkan sistem akan
melakukan shutdown ataupun
throttle ketika batas suhu tersebut
terlampaui. Fitur lain yang
terkadang dimiliki pula oleh BIOS
motherboard adalah pengaturan

kecepatan putar fan. Pada
motherboard yang memiliki fitur
semacam ini, fan akan bekerja
pada putaran maksimal begitu
sistem sedang melakukan aplikasi
berat. Dengan cara ini, panas yang
dibuang dari prosesor akan
semakin banyak.

Nah, bila langkah-langkah di
atas sudah Anda lakukan, niscaya
prosesor Anda akan aman,
meskipun Anda menjalankan PC
selama berjam-jam bahkan
berhari-hari. PC+

Salah satu fitur pengaman prosesor untuk
menghindari panas berlebih.

Pemilihan pendingin prosesor dan thermal paste
harus benar-benar diperhatikan agar transfer
panas dari prosesor bisa sempurna.
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Minta Saran Beli
Harddisk Baru

Rekan-rekan milis sekalian,
minggu-minggu ini saya
berencana untuk membeli
harddisk merek Seagate yaitu
jenis Barracuda ATA IV 7200rpm
dengan kapasitas 40GB. Yang
jadi pertanyaan saya adalah, se-
telah harddisk tersebut dipasang
di komputer, apa yang terlebih
dahulu harus saya lakukan?

Kalau cuma sekadar mema-
sang biasa saja sih saya bisa. Te-
tapi setelah habis saya nyalakan,
apakah bisa langsung saya ma-
sukkan Windows XP Professional
yang ada tulisan bootable-nya
trus beres?

Satu lagi. Kalau pendingin
khusus untuk harddisk apa ya
istilah populernya? Masa’ cooler
saja gitu? Terima kasih atas
masukannya. Salam.

Master Jambroet

Jawab:
Pastinya pertama kali harus

baca doa, moga-moga harddisk
tersebut dalam keadaan sehat
dan baik. Setelah itu baru Anda
pasang dan mau digunakan
sebagai master, slave, atau single.
Perhatikan setting jumper jika
ingin menggunakan harddisk
tersebut sebagai master, slave,
single drive, ataupun cable select.

Setelah semuanya benar dan
sudah sesuai dengan keinginan,

langkah berikutnya yang harus
Anda lakukan adalah dengan
mempartisinya.

Anda tahu kan caranya?
Gunakan Fdisk atau Disk
Manager kalau Anda ingin
melakukannya lewat basis DOS.
Atau Anda juga bisa
menggunakan Partition
Magic, yang berjalan dari Win-
dows. Dibagi menjadi tiga atau
empat partisi sudah cukup kok.

Untuk alat pendinginan
harddisk, biasanya istilahnya sih
HDD Cooler. Perangkat ini ada
dua macam. Pertama yang
dipasang di bawah harddisk,
kedua yang dipasang di drive
bay 5 1/4 inci. Kalau menurut
saya sih, perangkat ini

sebetulnya nggak perlu-perlu
amat.

Karena biasanya kan casing
keluaran sekarang sudah
memakai fan intake, nah
harddisk barunya dipasang di
belakang fan intake-nya saja,
jadi fan-nya sekaligus
berfungsi sebagai HDD
Cooler juga.

Lumayan kan,
kelebihan dananya
bisa Anda gunakan
untuk membeli heat
sink fan yang lebih
bagus. Kalo ini saya rasa
jauh lebih berharga buat
komputer Anda.

pramudya_xxx, Adhitya F. Anggoro

Browser MyIE vs
Crazy Browser

Eh teman-teman, ada yang
sudah pernah pakai Crazy
Browser belum? Kalau sudah,
tolong kasih tahu kelebihan
MyIE yang tidak ada di Crazy
Browser tersebut. Kalau
memang ada banyak, gue mau
nyoba juga deh browser MyIE
ini. Kasih penjelasan ya, apa saja
kelebihan-kelebihan dari MyIE
dibanding CB. Kalau memang
OK, gue pasti ngikut dah, tapi
jangan main flame di milis ya.

BK

Jawab:
Gue juga memakai Crazy

Browser (CB) juga gara-gara

dapet informasinya dari lo kan?
Nah, kemarin gue di-japri sama si
blicok, dia ngasih informasi ten-
tang MyIE2. Tetapi waktu itu dia
gue cuekin aja. Tetapi lama-lama
gue penasaran juga sih. Setelah
dicoba, busyet dah. Kalah jauh CB
mah. Semua feature CB adalah
sebagian kecil dari feature-
feature yang ada di MyIE2.
Silakan lo simpulin sendiri deh.

Bener kok Bung BK. Lebih ba-
gus MyIE2 dibandingkan dengan
Crazy Browser. Untuk sesama
browser yang menggunakan basis
(engine) Internet Explorer,
kayaknya ini yang paling komplit
fasilitasnya. Perbedaan yang
cukup mencolok dibanding Crazy
Browser di antaranya seperti:
• Ada tab auto hide disebelah

kiri untuk lihat Favorite,
Search (malah bisa di-
customize juga), Weather,
dan ini yang paling bagus,
bisa browsing folder di local
computer. Jadi kalau punya
file ekstensi html di kompu-
ter tinggal klik aja via folder
itu. Muncul dah. Gak perlu
lagi pakai klik [File]>[open].

• Selain itu, icon Favorite
Homepage juga bisa
dimunculkan di tab-nya (gue
baru lihat di sini, kayaknya
gak ada sebelumnya di
browser-browser multitab
lainnya), selain itu ada
beberapa skin (on the fly),
Simple Collector untuk
meng-copy bagian dari
halaman situs (always on top,

tinggal copy-paste trus di save
dah, gak perlu lagi buka
Notepad), Google bar com-
patible, juga ada Edit url per
kata di tab address kaya di IE.
(Crazy Browser gak bisa nih).

• Apa lagi ya? Kayanya banyak
plug in-nya juga, tinggal

sedot dari situsnya. Cuma
yang ini sih ane belum
pakai. Cobain dah, it’s worth
to try deh pokoknya.
Gimana, ane dah cocok jadi
sales belum? :-) Wassalam.

H@]]!, oyi KRESNAMURTI

ARE/PCplus
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Indocomtech 2003:
Ajang Pameran Produk Anyar

Terakhir di Tahun Ini

Muhammad Firman
firman@e-pcplus.com

Minggu ini, perhelatan
terbesar dunia

komputer di Indonesia
berlangsung. Dimulai

pada hari pertama
bulan Oktober dan

berlangsung selama 5
hari, pameran tersebut

akan diadakan di hall
A dan B Jakarta Con-

vention Center.

ntuk PC,
kecepatan PC desktop
untuk mainstream akan
bergeser dari Pentium-4

1,8GHz ke 2,4GHz. Sedangkan di
bidang prosesor, tampaknya pada
Indocomtech kali ini Pentium-4
dengan teknologi Hyper Thread-
ing-nya masih mendominasi.

Berbeda dengan prosesor
AMD yang produk terbarunya
sangat sulit ditemukan di pasaran
Indonesia, produk prosesor Intel
ini dapat dijumpai dengan
mudah. Meskipun harganya
masih cukup mahal, namun
penerimaan pasar atas Intel
Pentium-4 dengan Hyper Thread-
ing ini cukup bagus. Dengan
target market segmen bisnis dan
consumer, pada Indocomtech kali
ini prosesor Pentium-4 Hyper
Threading ini diperkirakan akan
menjadi primadona.

Bagi fanatik prosesor AMD,
tampaknya mereka belum dapat
memenuhi keinginannya untuk
mendapatkan prosesor terbaru.
Saat ini prosesor AMD untuk
desktop PC yang umum tersedia
di pasaran adalah Athlon XP versi
lama masih yang menggunakan
core Thoroughbred. Prosesor
Athlon dengan core Barton
apalagi yang sudah
menggunakan FSB 400MHz juga
tampaknya tidak akan ditemukan
pada Indocomtech kali ini.

Untuk motherboard-nya,
produk-produk yang
diperkirakan akan marak adalah
yang menggunakan chipset Intel
875 dan 865, serta SiS648 dan
SiS648FX. Dari MSI, distributor
produk ini berencana untuk
memajangkan produk terbaru
mereka yang menggunakan
chipset Intel 848 yang juga sudah
mendukung Hyper Threading.
Chipset ini merupakan chipset
i865PE namun dibuat hanya
mendukung single channel
memory.

Untuk motherboard AMD
Athlon XP, produk yang akan
ditonjolkan adalah yang
menggunakan chipset nForce-2
dan KT600. Selain itu, beberapa
vendor seperti MSI dan Gigabyte
akan menggelar produk mereka
yang sudah mendukung prosesor
terbaru yaitu Athlon64 yang
menggunakan chipset K8T800
dan nForce 3.

Memori Dual Channel
dan Kartu Grafis

Dengan maraknya teknologi
dual channel memory yang kini
sudah mencapai dual channel
DDR400 baik untuk sistem AMD
ataupun Intel, membuat
produsen-produsen memori

seperti Corsair dan Kingston
menawarkan produk memori
yang dijual secara berpasangan.

Dari Corsair, produk memori
jenis berpasangan yang sudah
dapat dimiliki oleh pengguna di
Indonesia adalah TwinX,
sedangkan milik Kingston adalah
seri HyperX. Produk-produk ini
diklaim dapat membuat sistem
yang menggunakan dual channel
memory menjadi lebih optimal.

Untuk kapasitasnya, rata-
rata modul memori yang diminati
oleh user saat ini adalah yang
berkapasitas 256MB. Modul
memori yang berkapasitas 512MB
juga mulai dilirik pengguna,
sedangkan kecepatannya yang
akan hadir di Indocomtech
adalah memori DDR500 (PC-4000)
dan DDR433 (PC-3500).

Di bidang kartu grafis,
perebutan posisi produsen kartu
grafis “number one” tampak
semakin ketat. Kartu
grafis buatan partner
nVidia yang biasanya
merupakan kartu grafis
tercepat di kelasnya
mulai digeser oleh
kartu-kartu grafis
buatan ATi atau
partner-partnernya.
Produk kartu grafis
buatan ATi memang
tampaknya tidak
dipajangkan pada
Indocomtech tahun ini,
namun partner-partner
ATi seperti Gigabyte,
Giga Cube, dan
Sapphire akan
memajangkan produk kartu
grafis tercepat untuk PC desktop
saat ini yang menggunakan chip
VPU Radeon 9800Pro baik yang
menggunakan memori 128MB
ataupun yang memori videonya
sebanyak 256MB.

Untuk produk kartu grafis
chip nVidia, beberapa produsen
kawakan yang sudah lama
bermain di bidang kartu grafis
seperti Asus, Winfast, PixelView,
dan produsen seperti MSI serta
Albatron sudah menjual pula
produk yang menggunakan chip
terbaik nVidia saat ini yaitu
GeForce FX5900. Kartu grafis
yang menggunakan chip grafis
ini umumnya memiliki desain
pendingin yang unik. Seperti
model Twin Flow Cooling System
milik MSI ataupun model Wise
Fan milik Albatron yang
menggunakan hingga tiga kipas
pada sebuah board kartu grafis.

Bagaimana dengan Xabre?
Tampaknya, kartu grafis ini sudah
mulai tenggelam lagi.
Kecepatannya memang sedikit
lebih baik dari beberapa seri chip
grafis mid end dari nVidia
ataupun ATi, namun berhubung
kemampuannya yang hanya
mendukung DirectX 8.1 dan

U

vendor chip grafisnya kurang
agresif dalam persaingan, kartu
grafis dengan chip Xabre ini tidak
terlalu banyak gaungnya.

Media Simpan
Pada tahun ini

perkembangan media
penyimpanan tampaknya banyak
terfokus ke perangkat thumb
drive. Selain digunakan sebagai
media penyimpanan, beberapa
produsen menambahkan
kemampuan pada produk-produk
thumb drive mereka. Sebut saja
merek-merek seperti Ennyah dan
Creative. Selain menyediakan
kapasitas penyimpanan mulai
dari 64 hingga 256MB, produk-
produk keluaran dua vendor ini
ada yang dilengkapi dengan
kemampuan sebagai pemutar file
audio dengan format MP3, WAV,
ataupun WMA.

Bila masih kurang lengkap,

thumb drive yang menggunakan
interface USB ini juga dapat
digunakan sebagai audio
recorder. Selain milik kedua
produsen tersebut, produk USB
flash drive keluaran Cryptonix
juga bisa melakukan rekam suara
yang dapat disimpan sebagai file
WAV yang sudah terkompresi.
Ada juga beberapa yang
melengkapi produknya dengan
kamampuan menerima sinyal
radio AM atau FM dan juga
translator. Produk yang memiliki
fitur-fitur ini adalah Mega Stick 5
in 1.

Yang lebih unik adalah
produk keluaran Xonix. Media
penyimpanan USB berkapasitas
simpan 128MB ini berada di
dalam sebuah jam tangan yang
juga anti air. Untuk
menggunakannya, pemakai jam
tangan ini tinggal mencolokkan
kabel USB yang tersedia pada tali
jam ke komputer, dan jika sistem
operasi Windows XP yang
digunakan, media penyimpanan
USB jam tangan ini sudah bisa
langsung diisi data.

Sebagai pelengkap PC dan
sebagai fasilitas penyimpanan
data, peranan CD-ROM sebagai
drive optik yang wajib sudah

semakin tergantikan. Tidak ke
DVD-ROM, drive legendaris ini
lebih terpuruk oleh
membanjirnya CD-RW drive yang
memiliki
kemampuan
lebih dari
sekadar
membaca. Hal
ini ditambah
lagi dengan
harga sebuah
CD-Writer
yang semakin
terjangkau.

Vendor-
vendor yang
bermunculan
pada tahun
2003 ini di
bidang drive
optik
jumlahnya juga cukup banyak. Di
antara beberapa produsen yang
kini ikut bermain di bidang

media optik ini
terutama CD-Writer
adalah Enlight, ION,
dan Gigabyte.
Produsen yang
disebut belakangan,
selain menyediakan
produk CD-RW,
menyajikan pula
media DVD-ROM,
dan DVD-Dual yang
merupakan DVD-
Writer yang mampu
menulis ke media
DVD+R, dan DVD-R.
Meski demikian,
Gigabyte juga turut
memproduksi CD-

ROM drive bagi mereka yang
membutuhkan.

Dari segi kecepatan,
tampaknya untuk CD-ROM 52x
adalah kecepatan tertinggi yang

sulit untuk ditembus lagi.
Demikian pula untuk CD-RW.
Meskipun kecepatan tulis
ulangnya sudah dinaikkan hingga
mencapai 32x, namun kecepatan
tulis ke media CD-R-nya tetap di
52x. Pada DVD-ROM, kecepatan
bacanya masih berkisar pada 16x.

Produk drive optik lain yang
dapat ditemukan adalah DVD-
Combo yang merupakan produk
CD-Writer dan DVD-ROM. Salah
satunya adalah keluaran MSI.

Wireless
Sesuai dengan tema

pameran, Indocomtech 2003 ini
juga dipenuhi oleh produk-
produk wireless. Interface yang
berpotensi untuk berkembang
asalkan regulasinya jelas ini tentu
akan sangat bermanfaat, apalagi
melihat kondisi geografi Indone-
sia. Melihat potensi ini, vendor-

vendor tentu akan memajangkan
produk-produk berteknologi
wireless andalannya. Produk yang
akan dipajang tersebut adalah
seputar networking dan commu-
nication product seperti wireless
LAN card, HUB/Switch, LAN card,
dan Acces Point.

Demikian pula untuk
perangkat notebook. Sesuai tren
wireless tadi, produk-produk
berbasis Intel Centrino
diperkirakan akan semakin
membanjiri pasaran. Dengan
akan menjamurnya tempat-
tempat yang menyediakan
layanan hot spot, tampaknya
produk-produk notebook
wireless juga akan semakin
diminati.

Selain notebook berbasis
Centrino, produk-produk berbasis
desknote juga akan banyak
dijumpai. Berbeda dengan
Centrino yang berbasis wireless,
perangkat wirefull yang

merupakan kombinasi notebook
dengan PC desktop ini juga
diincar karena diyakini dapat
memudahkan bagi pekerja yang
sering berpindah-pindah tempat,
namun tetap dapat terhubung ke
sumber listrik.

Produk komputer jinjing lain
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Salah satu produk wireless yang akan
menjadi tren dimasa depan

Selain dapat digunakan untuk menyimpan data dan file
audio, perangkat ini juga mampu merekam suara

Notebook centrino, semakin tipis, ringan dan diminati



| 21

plusFokus IV • 01 - 07 Oktober 2003
PCplus 146

Pada Indocomtech 2003 kali ini, peserta dan pengunjung
pameran dapat menikmati layanan jaringan dan Internet secara
wireless di arena Jakarta Convention Center. Layanan ini merupakan
kerja sama antara Dyandra sebagai penyelenggara pameran,
Corexindo sebagai penyedia perangkat pendukung, dan tentunya
ISP-ISP seperti Radnet, Centrin, Indo.net, dan CBN. Layanan ini dapat
digunakan selama pameran berlangsung dan tanpa dipungut biaya
tambahan bagi peserta dan pengunjung pameran.

Selain menjadi peserta pameran biasa, ISP-ISP yang merupakan
pemain utama di bidang layanan Internet di Indonesia men-support
bandwidth untuk keperluan pameran tersebut melalui koneksi
wireless. Di booth-nya (stand) nanti, mereka akan menyediakan
layanan hot spot bagi setiap pengunjung yang membawa perangkat
wireless-nya.

Selain itu, booth-booth tersebut akan dijadikan tempat demo
untuk layanan hot spot. Di booth milik CBN misalnya, mereka juga
akan menjelaskan layanan hot spot yang telah mereka terapkan di
beberapa café di Jakarta, seperti Coffee Club Plaza Senayan dan
Mister Bean Coffee di Cilandak Town Square (Citos).

Booth-booth lain pada Indocomtech 2003 juga menyediakan
layanan demo hot spot. “Sejauh ini, tidak ada persyaratan tambahan
bagi peserta pameran untuk memanfaatkan layanan tersebut, karena
semua layanan difasilitasi oleh sponsor”, ungkap Sutiono Gunadi,
General Manager PT. Multicom Persada International. “Peserta
pameran pun tidak perlu mengeluarkan biaya ekstra”, tambahnya.
(raa, fmn) PC+

All About Wireless di Indocomtech 2003

yang akan tersedia pada
Indocomtech kali ini adalah
tablet PC. MSI, yang kini juga
mulai bermain di pasaran tablet

PC menyatakan telah siap dengan
produk terbarunya seperti Pen
Note 3100. Sementara vendor-
vendor yang sudah lebih dulu
memasarkan produk tablet PC
juga tentunya tidak mau
ketinggalan.

Bila desktop PC trennya
mulai tergeser dengan produk
komputer jinjing, monitor CRT
yang besar dan memakan tempat
juga sedikit-demi sedikit sudah
mulai ditinggalkan oleh
penggunanya. Terutama
kalangan office user.

Monitor LCD yang lebih
hemat tempat, hemat energi,
tingkat radiasi yang jauh lebih
rendah, serta harganya yang
cenderung turun membuat
produk ini mulai dilirik oleh end

user biasa. Produsen-produsen
monitor LCD-pun mulai banyak
bermunculan, diantara nama-
nama produsen yang baru

tersebut adalah Umax, CMV,
Cinex, PixelView, dan IVIO. Target
market yang dulunya cuma high
end user, kini sudah mulai
merambah ke pasaran SOHO.

Untuk melengkapi PC,
terutama mereka yang senang
mengoleksi foto-foto untuk
didigitalkan, tentunya
membutuhkan scanner.
Pengguna scanner yang sering
melakukan scan foto tersebut
saat ini semakin dimudahkan.
Beberapa produsen scanner
seperti Epson dan Umax telah
merilis produk yang dapat
melakukan scanning langsung
dari film negatif.

Produk yang memiliki
kemampuan tersebut di
antaranya adalah Umax Astra

4400U dan Epson Perfection
1670.

Meskipun bukan fitur baru di
dunia scanner, saat ini
kemampuan scanning film
negatif sudah lebih maju dengan
kemampuan untuk memperbaiki
hasil scan, dan lain-lain. Produk
scanner lain yang diunggulkan
oleh Umax, salah satu vendor
scanner populer di Indonesia
adalah produk terbarunya yaitu
Umax Astra Scanner 3600 dan
5650.

Bagaimana dengan
speaker? Pengguna speaker
aktif biasa tampaknya sudah
tidak puas lagi dengan kualitas
suara yang dihasilkan. Produk-

produk speaker yang akan
banyak diandalkan oleh masing
masing merek adalah
merupakan produk speaker 5.1
yang memliki efek surround,
Doubly Digital (AC-3) dan DTS
yang akan memberikan kualitas
suara yang lebih baik dari
speaker 2.1 dan mampu
memenuhi tantangan dari
kebutuhan kualitas suara
multimedia, gaming system dan
home theater.

Dari informasi yang kami
dapat, pasaran speaker 5.1 kian
meningkat, jadi para pemain di
bidang speaker tentunya akan

berusaha untuk memenuhi
kebutuhan pasar. Target pasar
untuk model-model terbaru juga
disesuaikan dengan kondisi serta
kebutuhan user yang berbeda-
beda.

Produk-produk lain yang
tampaknya akan marak pada
pameran komputer terbesar
akhir tahun ini seperti kamera
digital juga tampaknya akan
marak.

Vendor yang sudah
memastikan akan memajangkan
produk-produk terbarunya di
Indocomtech kali ini adalah
Umax. PC+
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Jam tanganpun sudah bisa digunakan untuk menyimpan data

Pengguna kamera digital dengan
CF dapat langsung menghubung-
kan CF card ke PC lewat USB
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Computex 2003: TrenTeknologi
Bisa Diintip dari Sini

Silvester Sila Wedjo
sila@e-pcplus.com

T

Republic Of China atau
yang lebih dikenal

sebagai Taiwan
beberapa dekade

belakangan ini
memang menjadi

macan Asia, khususnya
di bidang industri IT.

Betapa tidak? Dengan
hadirnya begitu

banyak pabrik pem-
buat komponen-

komponen komputer,
negeri  yang menjadi

negara tersendiri sejak
tahun 1912 ini berubah

menjadi negara yang
sangat maju dan

disegani di dunia IT.
Tak heran jika Compu-

tex yang merupakan
pameran teknologi IT
Taiwan ditunggu ba-

nyak kalangan. Bahkan
Computex kemudian

menjadi salah satu
barometer perkemba-

ngan IT dunia.

ahun ini, Compu-
tex berlangsung dari
tanggal 22 hingga 26
September. PCplus ber-

kesempatan menyaksikan salah
satu pameran komputer paling
akbar dunia ini, melihat secara
langsung pameran yang dipadati
tak kurang dari 2500 stand, me-
manfaatkan 3 gedung pameran
terbesar di jantung kota Taipei.
Sebagai salah satu pameran kom-
puter terbesar dunia, peserta dan

pengunjung yang datang tidak
hanya dari kawasan Taiwan dan
sekitarnya. Peserta dan pengun-
jung yang ambil bagian berasal
dari lebih dari 150 negara, terma-
suk Indonesia yang dikoordinir
oleh APKOMINDO maupun yang
datang sendiri-sendiri.

Menariknya, Computex yang
sudah berlangsung sebanyak 23
kali ini pada tahun 2003  memberi
tekanan pada  teknolo-gi flat
panel dan desain IC . Se-jumlah
produk-produk mutakhir dari
pabrik-pabrik komponen PC
maupun pembuat IC diluncurkan
di sini, tentunya dengan muatan

teknologi yang lebih baru yang
lebih canggih dari sebelumnya.
Dari pameran ini secara gamblang
terbaca  tren ke depan industri IT.

Semua Ke
Arah
Wireless!

Dari pantauan
PCplus, pada pameran
kali ini terlihat sekali
tren ke depan yang
coba ditawarkan
sebagian besar
vendor besar. Yang
paling nyata terlihat
adalah teknologi
wireless yang diotaki
oleh Intel dan kawan-
kawan. Teknologi
Centrino yang
menggabungkan 3 buah
perangkat dalam satu sistem
misalnya jelas terlihat pada
hampir seluruh produk-produk
notebook yang dipajang oleh
manufaktur notebook. Tak
ketinggalan produk-produk
jaringan berbasis nirkabel juga
diluncurkan oleh beberapa
manufaktur besar, termasuk
manufaktur yang biasanya hanya
berkutat di bidang motherboard,
storage, dan lain lain.

Perkembangan teknologi ke
arah wireless ini misalnya
diungkap oleh Tomasz
Swatowski, Marketing Planning

Departement Albatron
Technology ketika ditemui
PCplus saat Computex
berlangsung. “Ke depan,
kita harus mengikuti jejak
Intel yang mengembangkan
teknologi wireless ini. Oleh
karena itu kami pun
membuat produk yang
berbasis wireless untuk
jaringan,”
ungkapnya.

Uniknya,
tak hanya
manufaktur-
manufaktur
ternama saja
yang mengem-
bangkan tekno-
logi wireless ini.
Produsen sto-
rage yang biasa-
nya hanya
berkutat pada
masalah penyim-
panan data juga

tak ketinggalan turut
mengembangkan
teknologi bluetooth
untuk sistem berbasis wireless ini.
Pretec maupun TwinMos
misalnya, yang biasanya hanya
bergerak untuk urusan memori
dan penyimpanan data,
menyertakan pula produk
terbarunya berupa USB pen drive
yang selain sebagai tempat
penyimpan data juga berfungsi
sebagai kartu WLAN dengan
bentuk yang mungil. Begitu pula
Gigabyte yang pada Computex
kali ini menggelar produk-produk
mutakhirnya yang berbasis

wireless, termasuk seri-seri
bluetooth-nya.

Tak ketinggalan produk-
produk router, access point, dan-
lain lain yang berbasis wireless

yang dikembangkan oleh
produsen komponen terkenal,
mulai dari D-Link, Gigabyte, Asus,
Albatron, dan lain-lain.

Flat Panel: Teknologi
Yang akan segera
Membumi

Selain Wireless, teknologi
flat panel untuk monitor juga
terasa sekali pada Computex
2003 ini. Boleh dibilang semua
stand menampilkan flat panel
sebagai monitor pilihan. Bebe-
rapa produsen monitor besar
Fujitsu, Albatron, Samsung,
Sharp, Philips misalnya menampil-
kan seri produk terbarunya yang
mengusung teknologi flat panel
ini. Meskipun saat ini masih
tergolong mahal, namun Tomasz
dari Albatron memrediksi tahun-
tahun ke depan flat panel ini
akan semakin luas penggunaan-
nya. Selain harganya yang akan
semakin murah karena banyak-
nya produsen yang bersaing

untuk urusan harga, kemampuan
monitor flat panel yang semakin
baik juga akan mendorong para
gamers maupun pengguna
aplikasi berat lainnya beralih
menggunakan monitor jenis ini.

Mini PC:
Tren PC Ramping

Yang tak kalah mencolok
adalah mini PC yang tampak jelas
ingin “didorong” lebih
berkembang lagi oleh para
produsen besar. Manufaktur-

manufaktur besar seperti Shuttle,
Biostar, Acorp, MSI, dan-lain-lain
pada pameran ini memajang
begitu banyak seri-seri terbaru
mini PC dengan pilihan

motherboard maupun
model casing yang
cukup beragam.

Namun demikian,
sebagian besar
umumnya
menawarkan
spesifikasi yang relatif
sama yaitu casing dan
power supply  serta
motherboard dari
beragam tipe
tergantung seri
masing-masing. Meski
rata-rata mini PC ini
diperuntukkan buat

kalangan kantoran untuk aplikasi
ringan hingga sedang, beberapa
juga menyertakan motherboard
dari kelas performance. Biostar
misalnya mengusung seri terbaru
dari mini PC-nya yang
menggunakan motherboard ber-
chipset
nForce3.

Tak
hanya itu.
Pada
pameran kali
ini Asus juga
menge-
luarkan
produk
mutakhirnya
berupa
barebone PC
yang
berbentuk
yang amat
ramping yang
disebut
DigiMatrix
yang memadukan PC, digital

entertainment, dan
aplikasi wireless,
dalam satu unit
barebone yang amat
ramping.
Menariknya, untuk
memutar DVD atau
aplikasi hiburan
lainnya, pengguna
tak perlu harus
masuk menu utama
sistem operasi.
Operasi hiburan
seperti ini bisa
dijalankan
tersendiri.

Chipset-
Chipset Baru

Berdatangan
Pada Computex 2003 ini

bisa dilihat pula jejeran
motherboard yang mengusung
chipset-chipset terbaru.
Menariknya, produk chipset
yang diluncurkan tidak hanya
melulu buat kelas performance.
Untuk kelas value beberapa
vendor  seperti Asus, Biostar,
Albatron, Gigabyte juga mena-
warkan produk motherboard
mereka yang mengusung
chipset Intel 848P yang

diprediksikan akan
menggantikan tipe 865P namun
dengan sistem single channel
untuk memorinya.

Tak ketinggalan VIA juga
mempromosikan chipset-nya
yang  terbaru yaitu K8T800 untuk
mengimbangi kemunculan
nForce3 dari nVidia untuk sistem
berbasis Athlon 64 atau AMD
Opteron. Bisa jadi dalam bulan-
bulan ke depan, motherboard-
motherboard yang menggunakan
dua jenis chipset ini akan
bersaing secara ketat di pasaran.

Tak hanya urusan chipset
motherboard. Untuk kartu grafis
dua produsen juga meluncurkan
produk mutakhirnya. Nvidia
misalnya meluncurkan NV38 dan
NV36 yang merupakan chipset
andalannya yang terbaru untuk
kelas GeForce FX5950 dan
GeForce FX5700. PCplus sendiri
melihat demo secara langsung
dua buah kartu grafis terbaru
dari Albatron yang
memanfaatkan dua chipset ini
yaitu dari seri FX5950QV dan
FX5700PV/UV dengan teknologi
Wise Fan II yang mengusung fan
backup sebagai fan ketiga yang
akan berputar begitu salah satu
dari 2 fan utama tidak berfungsi.

Tak hanya nVidia, pada
pameran kali ini muncul juga

produk kartu grafis terbaru
yang mengusung chipset dari
XGI Technology Inc. PCplus
berkesempatan melihat secara
langsung dua tipe kartu grafis
dari Power Color yang
mengusung chipset baru ini.
Satu serinya misalnya
memanfaatkan jenis chipset
Volari Duo yang memanfaatkan
dua prosesor grafik secara
bersamaan.  Munculnya chipset
baru ini memang cukup
fenomenal di tengah
persaingan antara nVidia dan
ATI. Beberapa pengamat yang
ditemui PCplus di Computex
kali ini bahkan berani
memprediksi akan munculnya
mekanisme pasar yang baru
yang memungkinkan harga
kartu grafis akan lebih murah
dibanding sekarang dengan
hadirnya chip-chip alternatif
dari XGI ini.

Masih banyak lagi inovasi-
inovasi baru yang bisa dilihat
pada Computex 2003 kemarin.
Yang pasti, tampaknya
teknologi-teknologi yang
dihadirkan pameran tersebut
tak lama lagi akan Anda lihat
dengan mata kepala sendiri.
Kita tunggu saja! PC+
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Chipset dari XGI siap bertarung dengan pesaing chip
GPU yang sudah ada.

Mini PC multimedia jadi tren di masa depan karena
sifatnya yang multifungsi dan bentuknya yang
ramping.

Barebone PC jadi produk unggulan sebagian besar
manufaktur besar menghadapi persaingan pasar yang ketat.

Flat panel bakal jadi tren karena
harganya yang makin terjangkau.
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Cakrawala Gintings
cakra@e-pcplus.com Lebih Jauh

Mengenal AC3

A

Istilah AC3 mungkin
belum familiar bagi
sebagian pengguna
PC meskipun sudah

sering menonton
DVD-Video. Berbeda

halnya dengan istilah
Dolby Digital, yang

rasanya sudah umum
didengar bagi yang

sering menonton
DVD-Video.

C3 atau
lebih sering
dikenal sebagai Dolby
Digital ini merupakan

format digital terkompresi dari
audio yang menjadi standar
pada DVD-Video. Setiap
DVD-Video harusnya memiliki
Dolby Digital ini. Berbeda
dengan DTS yang tidak
merupakan standar yang harus
tersedia pada DVD-Video. Suatu
DVD-Video tidak harus
dilengkapi dengan DTS,
meskipun saat ini banyak
DVD-Video yang sudah
dilengkapi dengan DTS ini.
Sesuai namanya Dolby Digital,
AC3 ini dikembangkan oleh
Dolby Laboratories yang
memang menghasilkan
banyak format dalam dunia
audio.

SEJARAH AC3
Sebelum bioskop

menggunakan teknologi tata
suara 5.1, tata suara yang
digunakan adalah tata suara
yang meng-encode 4 kanal ke
dalam 2 kanal dan kembali lagi
ke 4 kanal (4-2-4). Sumber suara
yang memiliki 4 kanal di-encode
ke dalam 2 kanal oleh encoder
yang sesuai.

Suara yang sudah menjadi 2
kanal ini kemudian dapat
didistribusikan dengan cukup
mudah karena 2 kanal saat itu
sudah merupakan hal yang
umum. Pada saat dimainkan,
decoder yang sesuai akan men-
decode suara 2 kanal tersebut
kembali menjadi 4 kanal.

Pada tahun 1990, teknik ini
sudah digunakan cukup lama
sehingga timbul banyak
keinginan untuk memberikan
industri bioskop suatu tata suara
yang baru dan digital. Dari suatu
hasil penelitian diperoleh bahwa
banyaknya kanal yang sebaiknya

tersedia pada suatu film adalah
5.1. Adapun keenam kanal itu
adalah kiri, tengah, kanan,
surround kiri, surround kanan,
dan subwoofer.

Seperti diketahui, area pada
film 35mm yang digunakan pada
bioskop terbatas. Hal ini

membuat data digital yang bisa
diletakkan pada film tersebut
memiliki data rate yang terbatas.
Tentunya tidak diingankan data
digital tersebut sampai
mengganggu hal lain (gambar
misalnya) yang terdapat pada
film 35mm tersebut.
Ditetapkanlah bahwa suatu error
corrected audio data dengan
data rate sebesar 320kb/s dapat
diletakkan dan diambil secara
reliabel. Hal ini membuat
konsep dari AC3 adalah audio
CODEC yang beroperasi pada
320kb/s.

PROPERTI AC3
Saat ini AC3 adalah suatu

format audio digital yang
terkompresi. Teknik kompresi
yang digunakan adalah yang
lossy alias ada data yang hilang.
AC3 ini jelas mendukung multi
kanal 5.1. Bit rate yang dimiliki

oleh AC3 ini umumnya mulai
dari 64kbps hingga 448kbps.

Untuk 5.1 kanal umumnya
yang digunakan adalah yang
sebesar 384kbps ataupun
448kbps. Sedangkan untuk
stereo, bit rate yang umum
adalah 192kbps. Bit rate dari
AC3 ini adalah fixed alias tetap,
tidak variabel. Adapun
frekuensi sampling yang
dimiliki adalah 48kHz dengan
resolusi hingga 24 bit.

Satu hal yang perlu diingat
adalah bahwa Dolby Digital
mendukung 5.1 tetapi bukan
berarti harus 5.1. Oleh karena
itu suatu DVD-Video yang
menggunakan Dolby Digital
belum tentu memberikan 5.1
kanal audio. Bisa saja stereo 2
kanal atau bahkan mono. 5.1
adalah jumlah kanal tertinggi
yang didukung oleh Dolby
Digital. PC+

DVD-Video yang menggunakan
Dolby Digital tidak selalu
menawarkan 5.1 kanal.

ISTIMEWA
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Penggunaan
Cookie

Pada PHP

Yahya Kurniawan
yahya@e-pcplus.com

Kita sering mendengar
istilah cookie pada saat

browsing di Internet.
Apa sih sebenarnya

cookie itu? Kalau Anda
cari di kamus Bahasa

Inggris – Indonesia,
cookie berarti kue.

Tetapi di dunia
Internet cookie sama
sekali bukanlah kue!

ookie adalah
mekanisme penyimpa-
nan data pada browser
(client) di mana data

tersebut mengandung informasi
tentang indentitas user, kebiasa-
an user dalam mengakses suatu
situs, atau informasi-informasi
lain yang pada hakekatnya mem-
permudah user apabila dia da-
tang kembali pada suatu situs
yang memberikan cookie tersebut.

PHP sebagai suatu bahasa
skrip server side yang canggih
tentu saja menyediakan kemam-
puan untuk “membuat” suatu
cookie. Kemampuan tersebut di-
sediakan dalam suatu fungsi ber-
nama setcookie(). Karena cookie
merupakan bagian dari HTTP
header, maka fungsi setcookie()
harus dijalankan sebelum ada
output apapun pada browser.
Jika ternyata telah ada output
yang dikeluarkan sebelum fungsi
setcookie(), maka fungsi ini
akan menghasilkan nilai FALSE

C

dan cookie tidak akan terkirim.
Namun yang harus diperhatikan
bahwa nilai TRUE atau FALSE
dari fungsi ini tidak mencermin-
kan apakah cookie telah berhasil
diterima oleh user atau tidak.

Pada PHP versi 4.1.0 ke atas,
cookie disimpan dalam variabel
global $_COOKIE untuk
keperluan penggunaan dan
pengolahan lebih lanjut.

OK, sekarang kita bahas le-
bih dalam fungsi setcookie().
Sintaks penggunaan fungsi set-
cookie() adalah sebagai berikut:

setcookie (nama [,
nilai [, kadaluwarsa
[, path [, domain [,
secure]]]]])

Arti dari argu-
men-argumen tersebut
adalah sebagai berikut:

• Nama: merupakan
nama dari cookie.
Jika nama cookie
tersebut telah ada
di browser, maka
cookie lama akan
dihapus dan
diganti dengan
cookie yang baru.

• Nilai: merupakan informasi
yang akan disimpan dalam
cookie.

• Kadaluwarsa: merupakan
tanggal kadaluwarsa dari se-
buah cookie. Jika melewati
tanggal tersebut, maka infor-
masi cookie akan dihapus.
Nilai dari argumen ini meng-

gunakan tipe Unix time inte-
ger yang dapat dihasilkan dari
fungsi time().

• Path dan domain: PHP
manual tidak memberikan
deskripsi mengenai kedua
argumen ini, tetapi diduga
kedua argumen ini memberi-
kan informasi mengenai path
dan domain dari situs yang
dikunjungi oleh user.

• Secure: menentukan apakah
cookie akan dikirim melalui
protokol HTTPS.

Selain argumen nama,
argumen-argumen tersebut
bersifat opsional. Jika harus
dituliskan tetapi tidak
mengandung isi apapun,
argumen nilai, path, dan domain
dapat dituliskan dengan string
kosong (“”) sedangkan argumen
kadaluwarsa dan secure karena

berupa integer dapat dituliskan
dengan angka 0.

Berikut adalah contoh seder-
hana dari penggunaan cookie.

<?
if (!isset($_COOKIE['test'])) {

setcookie("test","Isi
test cookie");
echo "<HTML>";
echo "<HEAD>";
echo "<TITLE> Wel
come </TITLE>";
echo "</HEAD>";
echo "<BODY>";
echo "This is your first
visit";
echo "</BODY>";
echo "</HTML>";

} else {
echo "<HTML>";
echo "<HEAD>";
echo "<TITLE> Wel
come </TITLE>";
echo "</HEAD>";
echo "<BODY>";
echo "You have
visited here before
<BR>";
echo "This is your
cookie's value: <BR>";

echo $_COOKIE['test'];
echo "</BODY>";
echo "</HTML>";

}
?>

Simpanlah skrip ini dengan
nama cookie.php. Jika file
cookie.php tersebut kita
jalankan pada browser, maka
mula-mula PHP akan memeriksa
apakah variabel $_COOKIE['test']
telah diset. Jika belum, maka
server akan mengeksekusi skrip
pada blok yang pertama (sebe-
lum else). Dengan demikian pa-
da pemanggilan file cookie.php
yang pertama kali akan muncul
tulisan “This is your first visit”
(bandingkan dengan Gambar 1).
Sebelum itu PHP akan mengirim
cookie bernama test yang isinya
adalah “Isi test cookie”.

Lalu pada kunjungan yang
kedua dan seterusnya, cookie
telah tersimpan pada browser
dan otomatis variabel
$_COOKIE['test'] telah diset
sehingga dengan demikian yang
dieksekusi oleh server adalah
blok skrip setelah else. Jadi pada

Gambar 1
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kunjungan yang kedua dan se-
terusnya, browser akan memberi-
kan output seperti Gambar 2.

Jika Anda menginginkan
cookie tersebut memiliki kadalu-
warsa, maka contoh
penggunaannya adalah sebagai
berikut:

setcookie("test","Isi test
cookie", time() + 3600);

Cookie tersebut akan
memiliki kadaluwarsa 1 jam
setelah diset. Ingat, 1 jam adalah
sama dengan 3600 detik.

Cookie yang telah diset juga
dapat dihapus. Penghapusan
cookie juga menggunakan fungsi
setcookie(). Caranya adalah de-
ngan mengatur waktu kadalu-
warsa cookie dengan suatu nilai

di masa lampau. Contoh:
setcookie("test","Isi test
cookie", time() - 3600);

Penggunaan cookie ini
memiliki kelemahan yaitu apabila
user melakukan setting pada
browsernya agar tidak dapat

menerima
cookie. Jika hal
ini terjadi, maka
eksekusi
terhadap file
cookie.php
tidak akan
pernah menca-
pai keadaan
seperti pada
gambar 2,
melainkan akan
terus seperti
gambar 1.

Jika Anda
menggunakan
Mozilla (atau
Netscape), maka
setting cookie
dilakukan de-
ngan menu
[Edit]>

[Preferences]. Pada kotak
dialog yang muncul masuklah ke
bagian [Privacy &
Security]>[Cookies]. Lihat
Gambar 3. Di sana Anda dapat
memilih [Disable cookies],
[Enable cookies for the originat-
ing web site only], dan [Enable
all cookies]. Anda juga dapat
menentukan browser untuk
menanyakan terlebih dahulu
apakah Anda mau menerima
cookie atau tidak serta

membatasi waktu kadaluwarsa
sebuah cookie.

Jika Anda
menentukan
browser untuk
menanyakan
terlebih dahulu
apakah Anda mau
menerima cookie
atau tidak, maka
setiap kali ada
HTTP header yang
mengirimkan
cookies browser
akan menampilkan
kotak dialog
seperti pada
Gambar 4. Pada
kotak dialog ini Anda dapat
memilih untuk menampilkan
atau menyembunyikan detil dari
cookie serta mengingat
keputusan Anda untuk cookie
tersebut, diterima atau ditolak.

Untuk para pengguna
Internet Explorer, pengaturan

masalah cookie
dilakukan
dengan menu
[Tools]>[Internet
Options],
kemudian pada
kotak dialog
yang muncul
masuklah ke tab
[Security]. Di
sana Anda dapat
menentukan
apakah Anda
akan
menentukan
security secara
[Default] atau

[Custom]. Jika Anda memilih
default, ada beberapa tingkatan

security yang dapat Anda pilih,
yaitu sebagai berikut:

• High, cara paling aman dalam
browsing di Internet namun
tentunya banyak fitur yang
hilang. Cookie tidak bisa
diterima oleh browser

sehingga beberapa situs tidak
dapat ditampilkan dengan
baik.

• Medium, cara ini masih
cukup aman.
Anda akan ditanya apabila
browser akan men-download
content yang dianggap secara
potensial berbahaya atau
sesuatu yang
“mencurigakan”, seperti
misalnya komponen ActiveX
yang unsigned.

• Medium-Low, hampir sama
dengan medium, hanya saja
Anda tidak akan ditanyai
apabila ada content yang
dianggap berbahaya. Hanya
komponen ActiveX yang

unsigned yang tidak
didownload.
• Low, semua komponen
dapat dijalankan dan
dibaca oleh browser.

Jika Anda memilih
custom, maka akan
muncul sebuah kotak
dialog lagi. Pada kotak
dialog ini Anda dapat
menentukan sendiri
setting keamanan browser
Anda.

Karena hal ini, maka
apabila Anda akan

mengembangkan aplikasi Web
menggunakan cookie, maka
sebaiknya di halaman pertama
dari aplikasi tersebut diberi suatu
petunjuk agar user mengaktifkan
penerimaan cookie pada
browsernya.

Selamat belajar.  PC+

Gambar 2

Gambar 3

Gambar 4
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Lowongan Terbuka Lebar
pada Industri “Mobile Content”

F.X. Bambang Irawan
fbi@e-pcplus.com

Y

Tingkat penjualan
coklat di Inggris anjlok.
Ini kali pertama terjadi

selama 50 tahun
terakhir. Apa pasalnya?

Suplai melimpah?
Mutu menurun?

Kesadaran kesehatan?
Bukan karena semua

itu. Musababnya
adalah anggaran

belanja kaum muda di
negeri tersebut
dialihkan untuk

membeli produk-
produk yang berkaitan

dengan ponsel, yaitu
SMS, MMS, game Java,

dan ringtone.

ang namanya
download sekarang bu-
kan lagi monopoli para
netter. Para pengguna

ponsel pun sekarang akrab de-
ngan istilah ini. Mereka bisa pergi
ke mal atau pusat-pusat kesibukan
lain untuk men-download ring-
tone (nada dering) dan gambar
pengganti logo operator untuk
menghias ponsel kesayangan.

Salah satu mesin yang
populer untuk melakukan
transaksi tersebut adalah Rilo.
Mesin ini sebenarnya
“hanya’merupakan unit
komputer biasa yang dilengkapi

harddisk berisi ribuan koleksi
lagu untuk nada dering dan gam-
bar-gambar untuk wallpaper, ser-
ta kabel-kabel interface untuk
mengirim data dari PC ke ponsel.
Mesin ini terbukti sudah menjadi
mesin duit dan dikaryakan oleh
para pengusaha di berbagai pusat
kesibukan di seluruh tanah air.

Di luar itu, industri jasa
pengiriman nada dering ini juga
menggunakan cara-cara lain.
Banyak penyedia jasa yang
memasang iklan satu halaman
berisi kode-kode lagu dan
gambar di media-media cetak.
Berdasarkan kode tersebut,
konsumen menelepon ke penye-
dia jasa melalui jasa premium
call, mengikuti petunjuk yang
diberikan selama kurang lebih 3
menit. Setelah selesai, nada
dering atau gambar yang dipesan
akan dikirim melalui SMS.

Provider lain menempuh
cara-cara yang kurang lebih
sama, hanya saja ada yang
mempublikasikan kode-kodenya
melalui situs atau media lain
seperti televisi. Bahkan, stasiun
televisi bonafide dan ngetop di

kalangan anak muda seperti MTV
Asia pun menyediakan suguhan
download nada dering ini. Di
tanah air, stasiun yang mengikuti
jejaknya adalah Anteve.

Operator tentu diuntungkan
dengan maraknya bisnis ini,
terutama jika metode pengiriman
dilakukan lewat mekanisme SMS
atau over the air (OTA) dan
bukan langsung download lewat
kabel, inframerah, atau blue-
tooth. Namun, operator pun tak
mau ketinggalan menangguk ru-
piah dari industri ini dengan me-
nyediakan layanan serupa, baik
diselenggarakan sendiri maupun
bekerja sama dengan content
provider.

Pola Jajan
Ringtone merupakan

fenomena yang menarik dalam
jagad perponselan, selain SMS.
Siapa yang mengira bahwa nada
untuk merepresentasikan
panggilan telepon ini akan
menjadi sangat populer dan
menjadi “lambang kreativitas”?
Sebelum musim nada dering
polyphonic, ringtone malah
hanya mampu membunyikan satu
instrumen dengan pengaturan

tempo yang
kadang
“kacau”.
Maklum,
kebanyakan
ringtone
yang beredar
adalah
“bikinan
sendiri”
melalui
fasilitas
composer
yang banyak
disuguhkan
pada
berbagai

ponsel. Namun demikian,
memperdengarkan “musik” yang
lucu dan kreatif ketika ponselnya
mendapat panggilan adalah
budaya baru yang sangat dige-
mari saat ini. Wajar jika peng-
guna ponsel, terutama kaum mu-
danya, selalu berlomba mencari
ringtone yang paling unik.

Wajar juga kalau meski
kelihatannya sepele, namun
ringtone ternyata merupakan
industri yang sangat besar
duitnya (apalagi kalau tidak ada
pembajakan). Menurut Mobile
Data Association (MDA),
penjualan ringtone di Inggris
tahun ini diharapkan meningkat
60 persen. Senilai 70 juta pound-
sterling akan dibelanjakan untuk
memberi nada dering tahun 2003
ini, meningkat dari hanya 40 juta
poundsterling tahun lalu.

Sedang di Asia, pasar ring-
tone tahun ini diperkirakan ber-
nilai 1,3 miliar dolar AS. Bahkan
menurut Connie Hsu, seorang
manajer di Pyramid Research,
Hong Kong, pasarnya diperkira-
kan akan membubung sampai 3,6
miliar dolar pada tahun 2007.

Sedang jika menukik ke pasar
yang lebih umum, yaitu pasar
mobile data di Asia, menurut
W2Forum (Wireless World Forum)
yang berbasis di London, tahun
ini nilainya sudah mencapai 3
miliar dolar AS. Angka ini akan
membengkak menjadi 6,5 miliar
dolar pada tahun 2006. Di benua
ini sekitar 55 persen pengguna
ponsel sudah pernah men-
download content ke peranti
mereka. Jepang dan Korea
merupakan dua negara yang
sudah sangat akrab dengan
aktivitas ini.

Kaum Muda
Pasar utama mobile data

atau mobile content ini memang
terutama kalangan muda usia.
Memang sifat content untuk
peranti jenis ini paling pas buat
segmen ini. Selain ringtone dan
gambar untuk wallpaper atau
logo operator, jenis layanan yang
menjadi favorit kalangan ini ada-
lah download game dan (kompo-
nen-komponen untuk) MMS
(Multimedia Messaging Service).

Kutipan yang diambil pada
awal tulisan merupakan ilustrasi
dari hasil penelitian bertajuk
“mobileYouth 2003” yang
dilakukan oleh W2Forum
terhadap kaum muda di negara-
negara maju yang kini bisa
menghabiskan 9 sampai 13,5
persen dari uang sakunya untuk
berbelanja produk-produk
mobile, yaitu SMS, MMS, game
Java, dan ringtone. Di Inggris,
belanja coklat anjlok dari 1,84
miliar euro menjadi hanya 1,73
euro, dan diduga salah satu
penyebabnya adalah pola jajan
yang beralih ke produk-produk
mobile tersebut.

Booming industri content di
seluruh jagad tersebut
mengingatkan harapan orang
kepada industri content di
Internet. Harapan yang terakhir
tersebut memang terbukti
tinggal menjadi harapan karena
lebih banyak orang yang suka
dan bisa mendapatkan content
dari Internet secara gratisan.
Apakah nasib mobile content
juga akan serupa?

Menurut penelitian yang
dilakukan oleh Jupiter MMXI,
jawabannya adalah tidak.
Mengapa? Karena dengan media
ponsel orang jadi mempunyai
sistem pembayaran yang lebih
baik. Praktik billing bisa
dilakukan langsung digabung
dengan penghitungan pulsa,
umpamanya. Maka tak heran jika
jumlah uaNG yang sudah
dihabiskan oleh penduduk Eropa
untuk membayar mobile content
tahun 2001 saja mencapai 590
juta euro, sudah hampir dua kali
melampaui content Internet yang
memangsa 252 juta euro.

Lowongan Pemain
Beberapa ilustrasi kuantitatif

di atas menggambarkan sebuah

potensi yang sangat besar bagi
mereka yang ingin terjun ke
industri ini. Industri baru mobile
content ini menawarkan
berbagai “lowongan” untuk
dilamar. Selain operator, supplier
peranti jaringan, dan pembuat
handset yang merupakan
pemain-pemain “kelas berat”
dan padat teknologi-padat
modal, tersedia
lowongan pada
sisi “jasa”
antara lain
sebagai
content
provider,
application
developer,
application
provider, dan
portal provider.

“Lowongan”
pada segmen
yang lebih
padat skill atau
ketrampilan ini
lebih mungkin
menarik buat kita di sini, karena
tidak begitu membutuhkan
investasi besar. Dan penyedia
content umumnya merupakan
pilihan yang paling diminati di
antaranya. Segmen ini menjadi
paling terbuka
untuk dimasuki
karena
merupakan
level terendah
dalam hal
penguasaan
modal dan
infrastruktur
dibanding
model bisnis
lain.

Ada tiga
model bisnis
(atau bisa juga
disebut
struktur karena
sifatnya yang bertingkat-tingkat)
yang umum dikembangkan
dalam bisnis ini, yaitu:
• Mobile content provider.

Merupakan
pihak
penyedia
content
yang paling
hulu.
Content
tangan
pertama
yang
dihasilkannya
umumnya
seperti
berita,
informasi,
serta
produk dan
layanan
digital. Mereka menyediakan
content untuk dunia mobile
tersebut untuk para content
syndicator.

• Mobile content syndicator.
Model bisnis yang ini tidak
memroduksi content sendiri,
melainkan mengepulnya dari

berbagai sumber content lain.
Sindikator ini kemudian
mendistribusikan content
tersebut ke berbagai channel
atau portal yang ada.

• Mobile portal. Bisnis ini
bertindak sebagai distributor
yang menyalurkan content
dan menjadi bagian hilir yang
berhubungan langsung

dengan pelanggan peranti
mobile.

Di negara-negara maju,
terutama yang sudah mempunyai
saluran mobile data yang cepat

dan leluasa, dagangan digital
yang ditawarkan oleh para
penyedia content sudah nyaris
lengkap jenisnya. Mereka dengan

leluasa mengeksplorasi segala
kemungkinan aspek kehidupan
yang bisa didigitalkan dan
diusung ke layar ponsel atau
PDA. Dengan adopsi terhadap
teknologi 3G dan bersiap untuk
generasi 4G, mereka benar-benar
seperti sedang berpesta-pora
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Hasrat punya ponsel lain daripada yang lain memicu
turut memicu industri mobile content

Walau kelihatan sepele, ternyata ringtone mampu
menghasilkan uang yang sangat besar

Industri mobile content menawarkan berbagai
lowongan antara lain sebagai content provider,
application provider dan portal provider

Segmen yang pas untuk industri mobile content
aalah kaum muda. Demikian hasil penelitian
mobileYouth 2003.



plusPonsel

 | 27

PCplus 146
IV • 01 - 07 Oktober 2003

mengguyur peranti mobile
dengan bergalon-galon “anggur
kenikmatan”. Konon, di Jepang
sudah terdapat 26 ribu penyedia
mobile content. Saking menarik-
nya industri ini, banyak pula war-
tawan di Jepang yang sudah
settle bahkan berinisiatif heng-
kang dari kantornya untuk men-
dirikan content provider sendiri!

Di tanah air, untunglah,
teknologi ponsel dan infrastruk-
tur yang masuk tidak terlalu ke-
tinggalan hingga para pengem-
bang juga sudah leluasa mena-
warkan beberapa jenis dagangan
yang mereka unggulkan sebagai
“killer content”.  Berbagai tekno-
logi ponsel terkini sudah pula
masuk ke pasar ponsel nasional.
Berbagai fitur layanan operator
sampai generasi terkini (generasi
2,5G dengan kehadiran teknologi
GPRS) membuat krativitas itu
menjadi mimpi yang menjadi
kenyataan.

Jika ponsel kita cukup
canggih atau merupakan
keluaran baru, maka berbagai
layanan mobile data ala Indone-
sia sudah bisa kita cecap. Koran
bisa masuk ke ponsel karena kita
mendapatkan berita terbaru dari
berbagai media ternama di Indo-
nesia.  Ponsel kita bisa menjadi
layar televisi karena mulai ada
fitur video streaming langsung ke
layar ponsel yang lebar dan ber-
GPRS. Kita bisa menyanyi bak
sedang berada di karaoke room
karena kita bisa men-download
lagu-lagu kesukaan berikut teks
yang mengikuti irama yang

sedang dimainkan. Itu sekadar
beberapa contoh kreativitas para
pemain industri mobile data kita.

Sadar Pasar
Berbagai layanan tersebut

cukup memberi indikasi bahwa

para pengembang dan penyedia
mobile content di tanah air
sudah cukup aware dengan
perkembangan teknologi dan
pasar peranti mobile. Dan
dengan bangga harus dikatakan
bahwa pihak yang paling
antusias dengan hal ini adalah
(lagi-lagi) kaum muda. Dalam
beberapa lomba untuk membuat
aplikasi mobile (yang antara lain

berbasiskan Java), majoritas
peserta dan pemenangnya
merupakan anak muda yang
masih duduk di bangku kuliah.

Semoga fenomena ini terus
mendapat perhatian dan campur
tangan industri sehingga mereka

bukan hanya paham
dalam teknis mem-
buat content, namun
juga mengenal de-
ngan baik situasi dan
kebutuhan pasar.
Secara teknis memang
kemampuan para
pengembang kita tak
perlu diragukan lagi,
namun tentu saja itu
belum cukup. Bebe-
rapa aspek yang harus
dipahami agar mereka
sukses di lini teknis
maupun di lini pemas-
aran misalnya adalah:
• Mekanisme dis-
     tribusi content.
      Sudahkah  mere-
      kam memikirkan
      strategi distribusi
      yang efektif dalam
hal pembayaran, pe-
masaran, dan delivery

produk?
• Content visibility. Apakah

content yang disiapkan akan
dapat dinikmati oleh
pelanggan? Seberapa besar
persentase ponsel di pasar
yang akan dapat (setidaknya)
menampilkan suguhan Anda
di layar ponsel mereka?

• Key differentiator. Tawaran
menarik apakah yang bisa

menjadi pembeda content
mereka dibanding dengan
ribuan content lain yang
sudah ada? Inovasi atau mati!

• Revenue model.
Pengembang harus memunyai
strategi untuk mendapatkan
share pendapatan yang rasio-
nal atas karya atau content
yang disediakannya. Jangan
sampai mereka hanya menjadi
mangsa partner bisnis seperti
sindikator, mobile portal, atau
operator jaringan. Memang
belum ada formula yang pasti
untuk revenue sharing macam
ini, sangat bergantung pada
negosiasi. Sebagai gambaran,

pengembang game Java di
negara-negara maju bisa
memperoleh sampai 25 persen
pendapatan. Lihat boks untuk
rincian model-model
pembagian revenue.

Kita sangat berharap bahwa
selain hanya bisa menerima ketika
digerojok peranti keras mobile,
kita justru bisa mengembangkan
industri content ini. Beberapa
sepak terjang kaum muda kita
sudah menunjukkan tunas-tunas
harapan ke arah sana. Malah, tak
berlebihan jika industri ini disebut
merupakan industri “dari kaum
muda, untuk kaum muda”. PC+

Bagaimana kita bisa meraup rupiah dari content dan karya
mobile? Apakah kita cukup “jalan sendiri” atau perlu bekerjasama
dengan pihak lain? Berikut ini beberapa model yang lazim ditemui
pada industri mobile content dewasa ini (E-business Strategies,
“Business Models for Mobile Content Provider”):
• Pay per use. Setiap kali ada pelanggan menggunakan content

yang dipajang di portal, content provider mendapatkan bagian.
• Flat subscription. Biaya berlangganan ditarik dalam jumlah yang

tetap untuk jangka waktu tertentu. Penggunaan content tidak
terbatas.

• Revenue sharing. Operator jaringan akan mendapatkan bagian
dari segala urusan yang dilakukan oleh peselancar mobile yang
mengklik link menuju ke situs partner (dalam hal ini content
provider).

• Time specific pricing.  Content tersedia dengan harga tertentu
untuk kurun waktu tertentu.

• Personalized service and content. Harga ditentukan berdasarkan
personalisasi yang dilakukan.

• Free content. Menyediakan content gratis untuk penggunanya.
Bisa dilakukan untuk promosi produk lain.

• Content license fee. Perusahaan database content yang
memberikan hak terbatas untuk mendistribusikan ulang content
kepada organisasi atau portal.

• Value-based pricing. Harga ditentukan berdasarkan kecepatan
koneksi atau lokasi pengguna jasa. PC+

Download ringtone dari mesin khusus makin
mudah dijumpai

Model Pembagian Pendapatan
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SMS Gratis
dengan Yahoo! Messenger

Alex Pangestu
alex@e-pcplus.com

P

Pakai Yahoo! Messen-
ger makin asyik aja.

Sekarang Yahoo!
Messenger dapat
digunakan untuk
mengirim SMS di

Indonesia. Gratis! Tapi
baru pelanggan

Telkomsel yang bisa
menikmati fitur Ya-

hoo! bernama
Yahoo!2SMS ini. Pada

hari-hari pertama
layanan ini aktif,

pelanggan Excelcom
bisa turut menikmati.

Tapi kemudian,
Excelcom menghilang

dari daftar operator
yang mendukung

Yahoo!2SMS.

elanggan
operator
lain? Untuk
sementara, cuma bisa

kirim SMS ke kawan-kawan
mereka yang berlangganan
Telkomsel. Namun jangan harap
bisa menerima SMS yang dikirim
dari Yahoo! Messenger. Tapi
siapa tahu suatu saat nanti
mereka juga bisa nimbrung.

Yahoo! Messenger yang
dapat digunakan untuk ber-SMS
ria ini adalah Yahoo! Messenger
versi paling baru. Pada versi-
versi sebelumnya, Indonesia
belum ada di daftar negara
yang operatornya bisa dikirimi
SMS dari Yahoo! Messenger.
Yahoo! Messenger paling baru
adalah Yahoo! Messenger versi
5.6.

Mengirim Pesan
Sebelum bisa mengirim

SMS, seorang pengguna Yahoo!
Messenger harus memiliki
mobile friends, yaitu daftar
teman-temannya yang memiliki
nomor ponsel. Untuk
menambah mobile friends, klik
ikon [Mobile] pada Yahoo!
Messenger. Boks Add a Mobile
Friend akan muncul. Cari
Indonesia di daftar negara.
Secara otomatis [Country
Prefix] akan berisi angka 62.

Kemudian masukkan nomor
telepon tanpa angka 0 (nol).
Misalnya nomor telepon
08128836XXX, ditulis dengan
8128836XXX. Masukkan pula
nama pemilik nomor telepon
tersebut.

Jika Yahoo! Messenger
pernah digunakan untuk
mengirim SMS, setelah ikon
[Mobile] diklik, yang muncul
bukan boks Add a Mobile Friend,
melainkan boks Start a Mobile
Conversation seperti Gambar
diatas Boks ini bisa juga diakses
melalui [Tools]>[Send]>[Start a
Mobile Conversation]. Mobile
friends yang ingin dikirimi SMS
bisa dipilih di [To]. Kemudian
pesan diketik di boks teks di
bawah, di sebelah tombol [Send].
Setelah pesan selesai diketik, klik
[Send].

Dari boks Start a Mobile
Conversation, boks Add a Mobile
Friend bisa diakses. Caranya
dengan mengklik [Add a new
Mobile Friend]. Boks Add a New
Mobile Friend akan muncul. Dari
boks Start a Mobile Conversation
disediakan pula akses untuk
memodifikasi data milik mobile
friends. Klik [Edit List]. Boks
Yahoo! Messenger Preferences
muncul. Di situ mobile friend bisa
ditambah, dihapus atau diubah

datanya, tergantung keperluan.

Di Ponsel
Mobile friend yang dikirimi

pesan akan menerima pesan di
ponselnya. Di inbox ponsel
penerima, muncul pesan dengan
nomor tertentu. Isi pesan dimulai
dengan Yahoo! ID, diikuti oleh
pesan.

Layaknya
pesan SMS
biasa, pesan
dari Yahoo!
Messenger
bisa di-reply.
Cuma, me-
reply pesan
dari Yahoo!
Messenger ini
tidak gratis.
Bahkan lebih
mahal
daripada me-
reply pesan
SMS biasa.

Bagi pelanggan telkomsel me-
reply pesan SMS dari Yahoo!
Messenger dikenai biaya Rp.
500,00.

Pada saat masih aktif,
Sedangkan
pelanggan pro-XL
dikenai biaya Rp.
500,00.

Pesan balasan
yang dikirim oleh
pemilik ponsel,
diterima di boks
Start a Mobile
Conversation,
bukan di ponsel si
pengirim pesan.

Hati-hati
SMS Spam

Mudahnya
mengirim pesan
SMS dengan
Yahoo! Messenger bisa
disalahgunakan oleh spammer
untuk melaksanakan aksinya.
Yahoo! tampaknya menyadari hal
ini sehingga menyediakan sarana
yang dapat digunakan oleh

pemilik ponsel untuk memblok
pesan SMS dari seseorang.

Setelah pemilik ponsel mene-
rima pesan SMS dari Yahoo! Me-
ssenger, ia bisa memblok Yahoo!
ID milik pengirim pesan. Caranya
dengan me-reply pesan tersebut
dengan pesan berisi “block”.

Bisa juga seorang pemilik
ponsel memblok seluruh pesan
SMS yang dikirim melalui Yahoo!
Messenger. Bagi pelanggan
Telkomsel, baik itu Halo dan
Simpati, yang ingin memblok
pesan SMS dari Yahoo! Messen-
ger, kirim pesan “block all” ke
nomor 4246600.

Walaupun sudah diblok,
pemilik ponsel masih tetap
menerima pesan SMS orang yang
sudah diblok. Syaratnya adalah
dengan menonaktifkan blok
untuk yang bersangkutan.
Pemilik ponsel bisa membuka
jalan untuk semua Yahoo! ID
atau Yahoo! ID tertentu saja.

Misalnya si Ciplus memblok
Yahoo! ID alexpangestu280
sehingga pemilik Yahoo! ID
alexpangestu280 tidak dapat
mengirim pesan SMS ke ponsel si

Ciplus. Kemudian si Ciplus ingin
menerima SMS dari
alexpangestu280. Yang ia
lakukan adalah mengirimkan
pesan berisi “unblock alex-
pangestu280” ke nomor 4246600.

Kemudian si Ciplus ingin
kembali dapat menerima SMS
dari Yahoo! Messenger. Maka
yang ia lakukan adalah
mengirim pesan berisi “unblock
all” ke nomor 4246600.

Hasil Coba-coba
Pertama kali mengetahui

bahwa Yahoo! Messenger bisa
digunakan untuk mengirim
pesan SMS di Indonesia, PCplus
langsung mencoba mengirim
pesan. Setelah beberapa kali
mencoba, ada beberapa pesan
SMS yang langsung sampai di
ponsel, ada pula yang tertunda
cukup lama, dengan waktu
yang bervariasi. Selain itu,
pesan yang sama kadang-
kadang diterima dua kali.

Pada saat menambah
mobile friend, kadang-kadang
muncul pesan bahwa aksi ini
belum bisa dilakukan sekarang.
Jika ini terjadi, coba logout dari
Yahoo! Messenger kemudian
login lagi. Ulang langkah-
langkah untuk menambah
mobile friend.

Sedikit Tips
Setiap kali tombol [Send]

ditekan, orang yang dikirimi
pesan SMS akan menerima
sebuah SMS. Jadi lebih baik
ketik dulu pesan sampai selesai,
baru tekan tombol [Send] atau
[Enter]. Dengan demikian,
orang yang dikirimi pesan tidak
menerima pesan sekian banyak.

Bagi para pelanggan
operator selain Telkomsel bisa
mengusulkan agar operator
yang mereka gunakan juga
menjadi partner Yahoo! dalam
urusan ber-SMS. Usul bisa
disampaikan dari http://
sg.mobile.yahoo.com/sms/
y2sms/report.php.

Dengan adanya
Yahoo!2SMS ini memang
benar-benar membantu.
Apalagi layanan ini tidak
memungut biaya. Andai saja
Yahoo!2SMS menyediakan
delivery report, ber-SMS bisa
lebih asoy lagi.

Untuk informasi lebih
lanjut mengenai Yahoo!2SMS,
kunjungi http://
asia.mobile.yahoo.com. PC+

A
LE

X
/P

C
pl

us

Boks start a mobile conversation digunakan untuk
mengirim pesan SMS ke ponsel

Contoh pesan SMS yang dikirim menggunakan
Yahoo! 2 SMS
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Evil Laughter:
Membuat Kesan

Gerak dengan
Adobe Image Ready

Vincent Bayu T.B.
vincent@e-pcplus.com

O

Sekali lagi, kita akan mencoba membuat animasi sederhana dari
rangkaian imaji statis, seperti pada bahasan minggu lalu.

Namun demikian, bila minggu lalu kita menggunakan kombinasi
Adobe Photoshop dan Macromedia Flash, kali ini kita akan

menggunakan alat kerja yang lain, yaitu Adobe Image Ready.

ke, mari kita “jump” ke alat kerja tersebut.
Klik bagian bawah Toolbox Adobe Photoshop yang bernama “Jump to Image Ready”.

10.  Aktifkan layer Asli, lalu klik ikon Add Layer Mask pada bagian bawah palet layers.
        Pilih nada gelap pada palet Background Color (di bagian bawah Toolbox), klik
        Paintbrush Tool, lalu sapukan untuk merapikan bagian-bagian gambar sehingga
        perpindahan antar-frame bisa halus. Ukuran Brush diatur dengan tombol [ atau
        tombol ] di keyboard.
11.   Klik ikon Select Looping Options di bagian bawah palet Rollover, lalu pilih “For
        ever”. Klik tombol [Play/Stop Animation] pada bagian bawah palet Rollover untuk
        melihat hasil animasi.

12.   Save pekerjaan Anda.
Selamat mencoba… File Source latihan ini bisa Anda download di unofficial website

PCplus www.pcplus-online.cjb.net. Demikian pula, pertanyaan dapat Anda kirim ke
e-mail vincent@e-pcplus.com. PC+

3. Salinlah layer rahang bawah tersebut dengan klik panah hitam di kanan atas palet
layer (layer options) dan pilih Duplicate Layer. Putar sehingga rahang terkesan
bergerak membuka. Gunakan menu [Edit]>[Transform]>[Rotate]. Klik Move tool
pada Toolbox, lalu klik [Apply]. Salin layer dengan cara menekan tombol arrow
(panah hitam) di bagian kanan atas palet layer, lalu pilih Duplicate Layers.  Beri nama
layer Rahang 2 (Gambar 3).

4. Lakukan lagi langkah 3 dan putar layer sehingga mulut terkesan membuka semakin
lebar. Beri nama layer Rahang 3 (Gambar 4).

5. Sembunyikan layer Rahang 2 dan layer Rahang 3. Lakukan dengan klik dan
menghilangkan ikon mata pada palet layer (Gambar 5).

6. Klik menu [Window]>[Animation]. Pilihan ini akan menampilkan Rollover, tempat
kita akan menyusun animasi. Klik pada panel Rollover, lalu klik “Large” untuk
memilih thumbnail bingkai animasi dengan ukuran besar.

7. Aktifkan frame 1 dalam Rollover, lalu klik kanan di bagian bawah bingkai/frame.
Pilih waktu penangguhan (delay time pada 0 atau pilihan “no delay time”).

8. Klik ikon “Duplicate Curent Frame” di bagian bawah palet Rollover. Sembunyikan
layer Rahang 1 dan layer Rahang 3 (Gambar 6).

9. Ulangi langkah 8 dan sembunyikan layer Rahang 1 dan layer Rahang 2 (Gambar 7).

1. Bukalah gambar Raksasa Cakil, lalu crop bagian kepalanya dengan Crop Tool pada
Toolbox. Klik kanan pada layer dalam palet Layer, lalu pada layer properties beri
nama Asli (Gambar 1).

2. Buatlah seleksi pada bagian bawah rahang Raksasa Cakil, misalnya dengan Polygo-
nal Lasoo Tool di Toolbox, lalu jadikan layer baru. Caranya, klik menu [Edit]>[Copy],
lalu [Edit]>[Paste]. Beri nama layer Rahang 1 (Gambar 2).
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Tahun 2003 adalah
“Year of The Notebook”

D

Sonny Walla
sonny@notebook-bekas.com

Pada bulan Mei 2003,
untuk pertama

kalinya dalam sejarah
bisnis PC (Personal

Computer) di Amerika
Serikat, angka

penjualan PC note-
book melampaui PC

desktop. Seperti
dilaporkan NPD

Techworld, 54% dari
seluruh pendapatan

penjualan PC di bulan
Mei 2003 sebesar

US$500 juta,
disumbangkan oleh

notebook.

ari semua unit
PC yang keluar pintu
toko pengecer, 40%-
nya berupa notebook,

lebih banyak 33% daripada
bulan April 2003, dan melejit
hingga 58% dibandingkan
penjualan unit di bulan Mei
2002. Padahal, sampai dengan
bulan Januari 2000 notebook
hanya menempati seperempat
bagian dari seluruh penjualan
PC di Amerika Serikat.

Statistik pasar yang dirilis
IDC (International Data Corpo-
ration) juga mengonfirmasi
peran notebook yang sangat
menentukan dalam
kebangkitan PC di Inggris pada
kuartal kedua tahun 2003,
dengan angka kenaikan sebesar
41.4% dibandingkan periode
yang sama di tahun
sebelumnya.

Di Singapura, menurut GfK
Asia, penjualan PC notebook
pada bulan Juni 2003 naik 10%
sampai 55%, sehingga untuk
pertama kalinya dalam sejarah
menggeser rekor penjualan PC
desktop di negara itu. Rekor ini
berlanjut hingga bulan Juli 2003
dengan angka sebesar 57%,
dibandingkan 43% dari
penjualan desktop.

Rekor penjualan yang
dicatat PC notebook,
khususnya dalam paruh
pertama tahun 2003 ini
ditentukan setidaknya oleh
empat komponen, yakni mobile
lifestyle, wireless mobility, price
gap & technology lapse, dan
booming business.

Mobile Lifestyle
Teknologi mobile

secara dramatis telah
mengubah pola
pikir dan gaya
hidup
konsumen saat
ini. Mobilitas
dan produktivitas
telah menjadi suatu nilai (value)
baru yang dicari banyak orang,
sekalipun harus dibayar dengan
harga premium. Seperti klaim
Steve Baker, salah seorang
analis NPD Techworld, ”Value
doesn’t mean cheap. Value
means price-appropriate.”

Dibandingkan telepon
konvensional di rumah, orang
cenderung memilih mobilitas
dan potensi produktivitas yang
ditawarkan ponsel, sekalipun

dengan harga yang lebih tinggi.
Pergeseran pola berpikir serta
gaya hidup yang mengarah
kepada mobilitas dan
produktivitas ini merupakan
salah satu faktor mengapa
mobile computing semakin
populer dewasa ini.

Khususnya bagi perusahaan,
Total Benefit of Ownership (TBO)
atau total manfaat dari
kepemilikan notebook
sebenarnya lebih tinggi nilainya
daripada Total Cost of Ownership
(TCO) atau total biaya
kepemilikan notebook.
Perusahaan yang menyediakan
notebook bagi karyawan-
karyawannya, entah yang
traveler maupun non-traveler,
akan menuai high rewards
berupa kerja overtime “cuma-
cuma” untuk semua tugas atau
proyek yang dikerjakan karyawan
di luar kantor, entah di jalan atau
di rumah.

Wireless Mobility
Salah satu teknologi mobile

yang paling berpengaruh adalah
wireless networking atau wireless
LAN (Local Area Network).
Beberapa produsen PC notebook
terbesar di dunia mengklaim
lebih dari separuh konsumennya
membeli option perangkat
wireless, dengan biaya ekstra
sebesar US$50.00 sampai
US$75.00.

Fakta ini menunjukkan
jumlah

pemakai fasilitas wireless pada
notebook telah berlipat 200%
hingga 300% dibandingkan
tahun 2002. Seperti diprediksi
IDC, di penghujung tahun 2003
ini juga, setidaknya setengah dari
enam juta rumah tangga di

Amerika Serikat yang memiliki
home network, akan dilengkapi
fasilitas wireless LAN.

Wireless mobility adalah
salah satu alasan mengapa saat
ini konsumen bertendensi
memilih PC notebook
sebagai komputer
sekunder atau meng-
upgrade PC desktop-nya.
Mengutip komentar
seorang analis IDC,
Jonathan Gaw, “What's the
point of having a wireless
network if you're going to
be chained to a desktop?"

Seiring mulai
menjamurnya fasilitas
public wireless access atau
hot spots di tempat-tempat
pusat keramaian seperti
bandara, hotel, gedung
pertemuan, perpustakaan,
kafe, dan sebagainya, di
mana secara instan orang
dapat mengakses Internet,
berkomunikasi, dan
bertukar data, notebook akan
menjadi primadona baru dalam
pasar PC.

Price Gap
dan Technology Lapse
Kian Menyempit

Agaknya tidak terlalu
berlebihan jika secara teknis, PC
desktop tak akan dapat
ditandingi oleh PC notebook.
Kendala-kendala seperti desain
prosesor khusus untuk ukuran
casing notebook, expansion

options yang
terbatas, konservasi energi,
ukuran dan keluaran panas,
merupakan sebagian tradeoffs PC
notebook untuk dapat bekerja
secara maksimal. Namun,
kesenjangan harga dan
kelambatan teknologi notebook
ini semakin lama semakin sempit.

Mobile lifestyle telah menjadikan
pasar notebook semakin besar
dan bergairah sehingga dapat
memberikan akselerasi pada
perkembangan teknologi dan
efisiensi produksinya.

Pada bulan Mei 2003, harga
eceran rata-rata sebuah PC
notebook di AS berkisar
US$1,294.00 dibandingkan
US$757.00 harga rata-rata desk-
top. Di Asia sendiri, kesenjangan
harga notebook dengan desktop
menyempit 28% dan hingga
bulan Juli 2003, harga notebook
di Asia hanya 20% lebih tinggi
daripada harga desktop, seperti
yang dilaporkan Jennifer Chan,
General Manager GfK Asia.

Sampai dengan bulan
September 2003, prosesor
tercepat untuk PC desktop
setara Pentium 4 dengan
teknologi Hyper-Threading
(HT) berkecepatan 3.2GHz.
Kapasitas harddisk drive
(HDD) terbesar untuk
desktop adalah 200GB.
Prosesor tercepat untuk PC
notebook setara Pentium 4
dengan kecepatan 3.06Ghz,
sedangkan kapasitas terbe-
sar HDD-nya adalah 80GB.

Booming
Business

Dahulu, ponsel
sering dipandang

sebagai telepon
sekunder (second-

ary telephone),
yang hanya

digunakan di
luar rumah

atau kantor.
Pemilik ponsel umumnya telah
memiliki telepon konvensional di
rumah sebagai telepon primer
(primary telephone).

Hari ini, sebagian besar
orang telah memiliki ponsel,
sebagian lagi bahkan mempunyai
lebih dari satu unit. Ponsel dapat
dibeli oleh siapapun, baik yang
sudah memiliki telepon

konvensional maupun yang
tidak sama sekali. Ponsel dapat
menjadi perangkat komunikasi
primer maupun sekunder—
terlepas dari segala
kekurangannya.

Seperti ponsel, di atas
kertas, PC notebook memiliki
potensi pasar yang lebih besar
daripada PC desktop. Orang
dapat membeli notebook
sekalipun telah memiliki
komputer desktop di mejanya.
Memang benar performa
notebook tak akan dapat
menandingi desktop. Namun
mobilitas yang dimiliki note-
book juga tidak dapat
digantikan oleh desktop.
Performa relatif masih dapat
ditoleransi, tetapi mobilitas
tidak. Rasanya cukup rasional
orang menggunakan notebook
sekalipun di dalam rumah atau
di kantor saja, tetapi tak
terbayangkan orang membawa
seperangkat desktop untuk
dipakai on the road atau
diangkut ke luar kota.

Potensi pasar notebook
yang lebih menjanjikan ini
telah menarik lebih banyak
produsen PC untuk melakukan
ekspansi. Selain itu profit
margin PC desktop yang sudah
sangat tipis menjadikan
notebook satu-satunya
alternatif untuk memperoleh
keuntungan.

Ekspansi dan kompetisi
para produsen notebook akan
membuat pasar notebook
semakin meriah. Bak pesta
peragaan busana, setiap
minggu orang akan
menyaksikan notebook-
notebook baru naik ke
panggung, dengan teknologi
canggih, wajah segar, tubuh
seksi, dan harga yang kian
menggoda. Jadi, tidaklah
berlebihan jika sang CEO Apple
Computer dan Pixar, Steve Jobs,
mengklaim tahun 2003 sebagai
“Year of the Notebook”.  PC+
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Bentuknya makin trendi, layar
lebih lebar, fasilitas komplit

Untuk pertama kali dalam sejarah penjualan notebook melampaui
penjualan PC desktop
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Cabe Rawit
dari Dunia Maya

YJ. Thurana
thurana@e-pcplus.com

S

“Kecil-kecil cabe
rawit!” Begitu kira-kira

penggambaran
masyarakat kita

mengenai sesuatu
yang berukuran kecil

tetapi kemampuannya
hebat. Sepertinya

penggambaran itu
tepat untuk software
yang akan kita bahas

berikut ini.

emua kriteria
yang dibutuhkan untuk
menjadi software
favorit dimilikinya.

Ukurannya kecil, hanya 423KB.
Kemampuan hebat dan fasilitas
yang dimilikinya pasti
dibutuhkan oleh para masyarakat
virtual. Dan yang paling penting,
harganya: Gratis!

Penasaran? Silakan langsung
cicipi Google Toolbar versi
teranyar. Hati-hati kepedasan!

Versi 2? Akhirnya...
Keandalan Google sebagai

search engine terbaik sudah tidak
perlu dipertanyakan lagi. Salah
satu buktinya adalah dengan
dimasukkannya fasilitas Googling
pada hampir semua Browser
modern seperti Opera, Netscape,
Mozilla, Slim Browser, dan
bahkan Safari yang berjalan pada
paltform Mac.

Anehnya, browser yang kata-
nya paling populer dan paling
banyak digunakan didunia –Inter-
net Explorer– tidak sedikitpun

melirik. Karena itulah muncul bar
tambahan kecil untuk IE hasil
pengembangan Google sendiri,
Google Toolbar, yang fungsinya
mempermudah Googling –
pencarian informasi di In-ternet
dengan menggunakan Google
sebagai search engine-nya.

Versi 1-nya sudah menjadi
sedemikian populer dan menjadi

semacam “suplemen” wajib bagi
IE. Karena sepertinya dirasa tidak
ada yang perlu diperbaiki dari
versi pertama tersebut, perlu
waktu yang cukup lama sebelum
Google mengeluarkan versi 2 dari
toolbar favorit kita. Sekarang,
dengan berbagai kemampuan
baru, ia kembali menggebrak.

Jangan mengaku peselancar
dunia maya sejati jika tidak
memiliki Google Toolbar terbaru.
Jadi sebelum berbicara panjang
lebar, mereka yang masih ber-
tangan kosong sebaiknya men-
download file installer-nya di:
http://toolbar.google.com/
data/en/big/current/
GoogleToolbarInstaller.exe

Catatan: Sistem komputer
Anda harus memiliki setidaknya:
• Microsoft Windows 95, 98,

ME, NT, 2000, XP, atau 2003
Server

• Microsoft Internet Explorer
versi 5 atau lebih baru
Setelah itu, silakan lanjutkan

membaca.

Berkenalan
dengan Si Kecil

Setelah proses instalasi
selesai (hanya perlu dua kali klik
saja), kita bisa langsung
menggunakannya. Caranya, buka
saja Internet Explorer dan Anda

akan bisa langsung melihatnya di
bagian toolbar. (Gambar 1)

Jika ternyata ia bersembunyi
dan tidak mau muncul, Anda bisa
membuatnya menunjukkan
batang hidung melalui menu
[View]>[Toolbars] lalu pilih
[Google]. Pada IE versi yang labih
awal dari 5, ada kemungkinan
toolbar ini tidak dikenali dan

dianggap sebagai Radio. Jika
kasusnya seperti ini, pilih saja
radio yang kedua.

Untuk mengubah

tampilannya, gunakan [Options].
Letaknya di menu drop down di
sebelah lambang Google

(Gambar 2 dan
Gambar 3). Banyak
ikon fungsi yang ber-
guna yang bisa dimun-
culkan dan disem-
bunyikan dari jendela
ini. Gunakan tab
[Options] dan [More].

Menggunakan dan
Memaksimalkan

Yang paling mudah sih
dengan memasukkan kata kunci
yang akan kita cari ke kotak
pencarian di toolbar tersebut.
Gunakan kombinasi [Alt]+[G]
untuk langsung masuk ke kotak
pencarian tanpa harus

menggerakan mouse sedikit pun.
Setelah menekan [Enter], Anda
akan dibawa ke halaman hasil
pencarian di www.google.com.

Jika Anda tidak mau hasil
pencarian tersebut di buka di
jendela yang sedang Anda lihat,
karena mungkin terasa
mengganggu, buka saja jendela
baru dengan hasil pencarian
Anda. Caranya adalah: dari
jendela [Options], beri tanda cek
pada pilihan Open a new
window to display results
each time you search.

Penggunaan lainnya adalah
untuk mencari
istilah yang
ada pada
halaman Web
yang sedang
Anda lihat.
Caranya: blok
kata yang
Anda maksud,
lalu drag dan
letakkan di
kotak
pencarian
Google. Bisa juga dengan
melakukan klik kanan pada kata
tersebut dan memilih “Google

Search” (Gambar 4).
Kadang-kadang kita perlu

juga membatasi pencarian yang
kita lakukan pada hasil yang
berada di negara kita sendiri saja.

Misalnya mencari informasi
mengenai tempat untuk
mendapatkan DVD di Indonesia.
Dengan Google Toolbar ini, kita
bisa melakukannya, Caranya:
1. Dari jendela [Option], buka

menu drop down yang akan
menampilkan domain Google
untuk negara-negara yang

berlainan. Pilih negara yang
diinginkan. Misalnya
www.google.com.sg untuk
Singapore. Sayangnya,
Indonesia tidak ada daftar
tersebut (Gambar 5).

2. Masukkan kata kunci pada
kotak pencarian dan dari
tombol [Search Web] pilih
[Search Country] (Gambar
6).

Anda juga bisa menambah-
kan ikon [Search Country]
melalui jendela [Options]>[More]
dan memilih Search Country di
bagian Extra Search Button.
Dan jika Anda sering melakukan
pencarian pada salah satu negara
saja, pilih Remember Last
Search Type, lakukan pencarian
cepat dengan mengklik tombol
[Search Country]. Kali
berikutnya Anda melakukan
pencarian, setting terakhir-lah
yang akan digunakan. PC+

Gambar 1

Gambar 1

Gambar 3

Gambar 4

Gambar 5

Gambar 6
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Pro1200:
UPS 1200VA dari Prolink

Perfection 1670:

Scanner Pintar
Keluaran Epson

Epson Indonesia
www.epson.com.sg
☎ (021) 5723161

± 115 - 150 dolar AS

Colortac LM17XU:

Monitor LCD 17 Inci
Pertama dari Umax

Umaxindo
www.umax.com
☎ (021) 6122781

535 dolar AS

Prolink Indonesia
www.fida.com

☎ (021) 6283205
100 dolar AS

Sebagai salah satu
produsen yang cukup aktif dalam
merilis produk-produk
perlengkapan komputer, Epson
kembali menambah koleksi
produk terbarunya untuk
dikonsumsi kalangan pengguna
PC di Indonesia. Kali ini produk
yang ditawarkan adalah Perfec-
tion 1670. Scanner ini merupakan
produk jenis Flatbed Color Image
dan sudah dipersenjatai dengan
teknologi-teknologi terkini oleh
Epson.

Beberapa fitur unggulan
scanner ini antara lain adalah
kemampuannya untuk melakukan

Semakin mendekati
penghujung tahun 2003, vendor-
vendor yang memasukkan produk
monitor LCD ke pasaran Indonesia
semakin banyak. Setelah secara
berturut-turut pada beberapa edisi
lalu kita membahas produk-
produk monitor LCD dari pemain
yang baru masuk ke Indonesia,
kini kita juga akan membahas pula
salah satu monitor LCD dari Umax,
yang juga merupakan salah satu
pemain baru di bidang ini.

Produk monitor LCD dengan
merek Umax yang baru pertama
kali kami terima ini adalah
Colortac seri LM17XU yang
merupakan sebuah monitor LCD
dengan lebar diagonal layar 17
inci.

Seperti produk-produk
monitor LCD yang kita bahas
beberapa edisi lalu, pada monitor
Umax ini juga sudah disertai
dengan dua buah speaker
multimedia yang menggunakan
daya 2 watt. Tetapi, berbeda
dengan produk-produk lainnya,

Saat Anda sedang
bekerja, tiba-tiba listrik padam.
Padahal data yang baru saja Anda
kerjakan tersebut belum sempat
disimpan. Panik bukan?

Kejadian ini sering terjadi
baik di kantor ataupun di rumah-
rumah yang hanya menggunakan
stabilizer pada PC-nya. Perangkat
ini memang cukup baik untuk
mengatasi tidak stabilnya
tegangan listrik, namun itu
terkadang belum cukup. Salah
satu cara untuk mengatasi
masalah yang ditimbulkan dari
gangguan daya listrik adalah
dengan menggunakan UPS.
Dengan UPS, tidak hanya
perlindungan dari gelombang
listrik (surge) saja yang dapat
diatasi, tetapi UPS dapat

scanning langsung dari negatif film,
Color Restoration, dan Dust
Removal. Untuk melakukan scan
dari film negatif, pengguna scanner
ini dapat melakukannya secara
langsung. Pada Epson Perfection
1670 tersedia film holder. Dengan
alat ini, negatif film bisa langsung
ditempatkan, di-scan, dan kemudian
file gambar dalam format yang
umum digunakan pada
komputerpun bisa langsung
dihasilkan. Lalu bagaimana dengan
kualitasnya? Jangan khawatir,
dengan resolusi hingga 1600dpi, file
gambar hasil scan Epson Perfection
1670 ini memiliki kualitas yang baik.

Foto
atau dokumen
yang dapat di-scan
oleh produk yang
sudah menggunakan
interface USB 2.0 ini adalah yang
berukuran mulai dari 49 x 126 mm
untuk film negatif hingga 216 x 297
mm dokumen A4 atau Letter. Untuk
gambar yang dihasilkan, jumlah
warna pada gambar hasil keluaran
scanner ini memiliki kedalaman
warna mulai dari 1 bit monokrom,
8 bit (256 warna), 16 bit (65536
warna), 24 bit (16,7 juta warna),

hingga 48 bit yang
kedalaman
warnanya

bisa
mencapai
281,5
trilyun
warna.

Fitur
Color

Restoration
yang disediakan

pada produk ini
dapat membuat foto-

foto usang dapat di-scan
dan menjadi “tampak seperti

baru” untuk kemudian di print
kembali di printer foto. Sedangkan
salah satu fitur lainnya yaitu Dust
Removal, dapat menghilangkan
efek berdebu yang kadang muncul
pada foto-foto lawas.

Scanner yang saat beroperasi
hanya membutuhkan daya sebesar
17 watt ini juga dilengkapi dengan
fitur Epson Smart Panel versi 3.0.
Software ini berfungsi seperti

set-
ting
untuk
volume,
bass, dan
treble kedua speaker ini dapat
diatur melalui fitur on screen display
monitor.

Selain menyediakan speaker,
pengguna monitor ini juga dapat
menggunakan earphone yang
dapat dicolokkan ke konektor yang
tersedia di panel belakang monitor.

Pada bagian ini, tersedia
pula power input, dan
interface untuk kartu grafis.

Resolusi maksimal yang
dapat digunakan saat
bekerja dengan monitor ini
adalah hingga 1280 x 1024.

Pada resolusi tersebut, monitor
dapat menghasilkan tampilan

layar dengan kualitas optimal.
Refresh rate yang dapat dihasilkan
oleh monitor pada resolusi ini
adalah 75Hz. Sejumlah hingga 16,7
juta warna dan dengan rasio
kontras 400:1 dapat dihasilkan oleh
monitor, sedangkan tingkat
brightness monitor yang
menggunakan interface VGA D-Sub

15-pin ini adalah 250 candela per
meter persegi.

Untuk terhubung ke jala-jala
listrik, monitor ini menggunakan
adaptor. Sedangkan saat bekerja,
monitor yang memiliki dot pitch size
0,264 mm ini membutuhkan
pasokan daya listrik sebesar 42 watt.
Saat sedang aktif, tampilan pada
monitor Umax Colortac LM17XU
dapat dilihat dengan baik hingga
sudut pandang 75 derajat ke kiri
dan 75 derajat ke kanan. Untuk
vertikalnya, tampilan pada layar
masih dapat dilihat dengan baik
dari sudut pandang 70 derajat ke
atas dan 70 derajat ke bawah.

Pengguna monitor Umax

memberikan listrik yang lebih stabil.
Selain itu UPS dapat berfungsi
sebagai baterai cadangan yang
dapat memberikan kita kesempatan
untuk menyimpan data dan
melakukan shutdown, hingga data
dan harddisk kita dapat terjaga
dengan baik.

Salah satu produk UPS yang
dapat kita gunakan adalah seri
Pro1200 buatan Prolink. Produk ini
dapat melindungi sistem dari
overload atau short circuit,
memberikan output power yang
stabil, serta berfungsi sebagai
sumber daya cadangan sementara
bagi perangkat elektronik.

Untuk inputnya, jangkauan
voltase yang mampu ditangani UPS
dengan rating 1200VA ini berkisar
antara 160-275V dengan frekuensi

45-65Hz. Sedangkan untuk
output, frekuensinya antara 50 -
60Hz.

Sebagai fasilitas backup,
perangkat ini menggunakan baterai
jenis lead-acid yang akan terisi
hingga 90% jika UPS tersebut sudah
di-charge selama 8 jam. Jika baterai
sudah dalam kondisi penuh, Prolink
UPS Pro1200 ini dapat memberikan
supply listrik selama 15 hingga 45
menit. Tergantung banyaknya daya
yang dibutuhkan oleh perangkat
yang dihubungkan ke UPS ini.

Saat digunakan, tingkat
kebisingan yang dikeluarkan Prolink
UPS Pro1200VA ini tidak sampai
45db. Agar lebih tahan lama, UPS ini
sebaiknya ditempatkan di ruangan
yang memiliki suhu antara 0 sampai
40 oC.

Pada kemasan  penjualan UPS
ini, Anda akan menemukan sebuah
software bawaan yaitu RUPS 2000
yang dapat berfungsi untuk
memonitor dan mengontrol secara
terus menerus status listrik dan
kondisi baterai baik secara lokal
ataupun dalam jaringan.

Untuk mengontrol secara lokal,
Anda dapat menghubungkan kabel
RS-232 yang disertakan ke UPS dan
ke PC Anda. Sedangkan untuk
mengontrol secara jaringan, Anda
dapat melakukannya secara remote
melalui TCP/IP. Software ini sendiri
dapat berjalan di background, jadi
Anda dapat melihat status atau
kondisinya kapan saja.

Secara fisik, UPS Prolink
Pro1200 ini tidak jauh lebih besar
dari perangkat stabilizer biasa.
Perangkat yang memiliki bobot
seberat 9,5Kg ini memiliki ukuran
yang cukup kecil yaitu 44,5 x 19,5 x
30. Namun tentunya dengan
kemampuan yang lebih dari sekadar
stabilizer. (fmn)

shortcut untuk melakukan
berbagai jenis pekerjaan yang
dapat dilakukan oleh Epson
Perfection 1670.

Seperti layaknya produk-
produk komputer terbaru, seperti
yang telah disebutkan di atas,
pada scanner ini hanya
menyediakan interface USB 2.0.
Jadi, sistem pada PC yang akan
digunakan, sebaiknya mendukung
pula USB 2.0. Untuk sistem
operasinya, perangkat ini sudah
dapat diinstalasikan pada sistem
operasi Microsoft Windows 98,
ME, 2000 Professional, XP Home
Edition, dan XP Professional.
Untuk Macintosh, sistem operasi
yang sudah mendukung
penggunaan scanner ini adalah
Mac OS 8.6, dan Mac OS X 10.2 ke
atas. (fmn)

LM17XU juga tidak akan terlalu
kesulitan dalam menempatkan
monitor ini. Meskipun layarnya
berukuran cukup lebar, ukuran
fisik monitor ini hanya 480 x 420 x
200 mm. Untuk bobotnya,
monitor ini memiliki bobot bersih
seberat 6,8 kg. Sedangkan layar
LCD yang digunakan pada
monitor ini diklaim dapat bekerja
dengan baik selama 40 sampai 50
ribu jam. (fmn)
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Cryptonix XP4:

Barebone System
Berbasis i845

Mostech Gigaddonics
www.mostech.web.id

☎ (021) 9253484
179 dolar AS

Sonicpower SP551 dan
Sonic Gear Platinum 5.1:

Solusi 5.1 untuk PC Anda

PT Leapfrog Indonesia
☎ (021) 66604784

Sonicpower SR551: ± 115 dolar AS
Sonic Gear Platinum 5.1: ± 35 dolar AS

PCMark 2002
CPU Score :5828
Memory Score :4527
HDD Score :1201

3D Mark 2001
640 x 480  16bit :2455
1024 x 768  32bit :1422

SisoftSandra 2003
ALU :6481 MIPS
FPU :1348 MIPS
ISSE2 :3157 MFLOPS

WCPUID
System Clock :132,95MHz
System Bus :531,82MHz
Internal Clock :2393,18MHz

Sebagai
perlengkapan
standar sebuah komputer,
speaker aktif biasa saja rasanya
sudah tidak lagi mampu
memenuhi kebutuhan. Hal ini
umumnya dirasakan oleh
kalangan pengguna PC gamer
dan terlebih lagi yang meman-
faatkan PC-nya sebagai perang-
kat home entertainment.

Dunia
semakin
sempit. Harga sewa
ruang kerja untuk perkantoran
terutama di kota-kota besar
semakin tinggi. Hal ini terjadi di
seluruh penjuru dunia. Namun
demikian, kebutuhan akan
penggunaan komputer di
sektor ini sudah tidak dapat
terbantahkan lagi. Hal ini
membuat dunia industri harus
membuat inovasi untuk
mengatasi permasalahan
tersebut.

Salah satu solusi yang kini
sudah mulai meluas
penggunaannya adalah
barebone system. Sistem ini
merupakan jalan keluar yang
cukup jitu untuk mengatasi
permasalahan ruang. Dengan
didukung oleh vendor-vendor
komponen PC desktop pada

Memang, untuk para
pengguna seperti disebut di atas,
kebutuhan itu hanya dapat
dipenuhi oleh sebuah speaker
yang benar-benar handal. Selain
itu tentunya harus didukung pula
oleh kartu suara yang berkualitas
tinggi yang kombinasi di antara
keduanya bisa membuat
penggunanya harus merogoh
kocek yang cukup dalam.

Bagi para pengguna kelas
menengah yang tidak seekstrim
pengguna tadi, di pasaran
tersedia solusi speaker 5.1 untuk
PC yang sedikit lebih terjangkau.
Salah satunya adalah Sonicpower
SP551 dari Sonic Gear. Satu set
speaker ini terdiri dari sebuah
subwoofer dan lima buah
satellite. Kelima buah satellite ini
bentuk dan ukurannya sama,

bedanya adalah untuk rear
speaker, kabel yang disediakan
lebih panjang.

Speaker di dalam kotak kayu
yang digunakan oleh subwoofer
ini berukuran 6,5 inci dan
memiliki power output sebesar
50 watt (RMS). Sedangkan kelima
buah satellite yang juga
menggunakan bahan kayu
sebagai pembungkusnya,
memiliki speaker yang masing-
masing berukuran 3 inci
dengan power output 6 watt
(RMS).

Untuk mengoperasikan atau
mengatur tingkat volume, bass,
dan treble pada speaker, pada
paket Sonicpower SP551 telah
disediakan sebuah remote
control. Melalui remote control
ini penggunanya juga dapat
mengatur suara pada rear dan
center speaker. Selain itu,
penggunanya juga dapat
mengganti mode suara yang
dihasilkan speaker ke 2.1 atau
kembali ke 5.1. Jika ingin kembali
ke setting default, pada remote
yang sensornya berada di bagian
depan subwoofer tersedia
tombol reset.

Produk yang memiliki
frequency response antara 35 Hz
sampai 20.000 KHz ini memiliki
signal to noise ratio di atas 80 dB.
Sedangkan untuk distorsinya,
Sonic Gear Lab sebagai
produsennya mengklaim bahwa
Sonicpower SP551 ini memiliki
tingkat distorsi di bawah 1%
THD.

umum-
nya,

tampaknya tidak
lama lagi barebone

system dapat menggantikan
peranan PC desktop di dunia
kerja.

Salah satu produk barebone
system yang sudah dapat kita
jumpai dipajangkan di gerai-
gerai komputer di Indonesia
adalah XP4 buatan Cryptonix.
Sistem ini ditujukan untuk
prosesor Intel Pentium-4 dengan
menggunakan basis chipset
i845GV. Prosesor yang dapat
dipasang pada produk ini adalah
Pentium-4 dengan FSB 400 atau
533MHz, sedangkan untuk
memorinya, pengguna barebone
system ini bisa memasangkan
satu keping memori DDR200,
atau DDR266 berkapasitas 1GB.

Pada barebone Cryptonix seri
XP4 ini hanya tersedia sebuah

slot PCI sebagai fasilitas ekspansi.
Namun demikian, semua fitur
yang dibutuhkan oleh kalangan
pengguna di dunia kerja
umumnya sudah cukup tersedia.
Fasilitas yang sudah terintegrasi
dan “tinggal pakai” pada sistem
ini di antaranya adalah onboard
video dan audio, LAN, dan USB
2.0. Fasilitas standar lainnya
seperti sepasang port PS/2 untuk
keyboard dan mouse, port LPT
untuk printer model lama, dan
sebuah port COM juga sudah
disediakan.

Fasilitas integrated video
pada motherboard ini
merupakan solusi Intel Extreme
Graphics. Untuk integrated
audio, chip yang digunakan
adalah ALC650 buatan Realtek,
sedangkan untuk integrated LAN,
pada motherboard tertanam chip
Realtek LAN 8100.

Komponen-komponen yang
terintegrasi pada motherboard
ini tertata cukup rapi. Dua buah
port IDE yang terletak di bagian
depan motherboard sedikit dapat
mengatasi panjangnya kabel-

kabel IDE untuk tidak
menghalangi aliran udara di
dalam casing. Untuk lebih
menghemat tempat, baterai
CMOS juga dipasang secara
vertikal.

Untuk media penyimpanan,
pada motherboard buatan Iwill
yang digunakan oleh Cryptonix
XP4 ini tersedia dua buah port
IDE. Pada board tersebut port
untuk floppy ditiadakan. Hal ini
mungkin dikarenakan
penggunaan floppy disk dirasa
sudah tidak sepenting dulu dan
sudah dapat digantikan oleh CD-
writer atau dikopikan lewat
jaringan.

Casing Cryptonix XP4 yang
dipoles warna silver ini sendiri
memiliki ukuran sekitar
18,9x26,5x17 cm. Dengan ukuran
seperti ini, pengguna barebone
system tidak membutuhkan meja
kerja yang terlalu luas. Apalagi
kalau monitor yang digunakan
juga merupakan monitor LCD.

Kami menguji barebone
system ini dengan memasangkan
prosesor Pentium-4 2,4GHz ber-

FSB 533MHz, memori Kingston
DDR400 256MB, harddisk
Seagate Barracuda 7200.7 40GB,
dan CD-ROM untuk melakukan
instalasi. OS yang kami gunakan
adalah Windows XP Profes-
sional. Berikut ini adalah hasil
pengujiannya. (fmn)

ARE/PCplus

Sebagai kombinasi untuk
produk speaker Sonicpower
SP551, Sonic Gear saat ini juga
telah menyediakan sebuah
kartu suara jenis 6 channel
audio yang menggunakan chip
CMI8738 buatan C-Media
Electronics Inc. Kartu suara
model PCI yang dapat dibeli
secara terpisah ini mendukung
speaker-speaker 5.1 seperti
Sonicpower SP551 dan juga
tentunya masih mendukung
speaker-speaker 2.1 dan 4.1.

Kartu suara yang
kompatibel dengan Sound
Blaster dan Sound Blaster Pro ini
mendukung Windows Sound
System dan DirectSound,
DirectMusic dan dapat
dijalankan pada sistem semua
sistem operasi Microsoft
Windows.

Produk kartu grafis ini
dilengkapi pula dengan
konektor optical dan coaxial
melalui sebuah card lainnya.
Sangat bermanfaat bagi
pengguna yang memiliki
speaker yang menyediakan
interface tersebut. Selain
menyediakan fitur lebih untuk
pengguna speaker high end,
bagi pengguna yang akan
memakai earphone, pada kartu
suara ini sudah tersedia pula 32
ohm earphone buffer. (fmn)
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FX5900-VTD128:

Kartu Grafis
Mutakhir
dari MSI

Alfa Artha Andhaya
www.msi.com.tw
☎ (021) 6121202

495 dolar AS

Quake III Arena
1024 x 768  16bit :235,8fps
1024 x 768  32bit :236,6fps
1280 x 1024  16bit :225,3fps
1280 x 1024  32bit :224,3fps
1600 x 1200  16bit :200,6fps
1600 x 1200  32bit :198,4fps

3D Mark 2001
1024 x 768  16bit :11742
1024 x 768  32bit :11505
1280 x 1024  16bit :10451
1280 x 1024  32bit :10402
1600 x 1200  16bit :9190
1600 x 1200  32bit :9130

3D Mark 2003
1024 x 768 :4920
1280 x 1024 :3850
1600 x 1200 :3085

Kartu grafis dengan
chip grafis nVidia terbaru buat-
an MSI sudah tersedia. Salah
satu model kartu grafis yang
sudah dapat dimiliki oleh peng-
guna kelas high end di tanah
air adalah yang menggunakan
chip nVidia GeForce FX5900
yang dikombinasikan dengan
memori DDR sebesar 128MB.

Untuk unit jenis ini, MSI
memiliki dua versi produk yaitu
MSI FX5900-TD128 dan MSI
FX5900-VTD128. Perbedaan di
antara kedua model ini hanya
terletak pada fitur Video In
(Composite Video) yang dapat
dimanfaatkan untuk merekam
gambar dari perangkat video
lewat kartu grafis tersebut. Kali
ini, perangkat yang mampir di
lab PCplus adalah kartu grafis
MSI FX5900-VTD128.

Paket produk kartu grafis
ini berbeda dari biasanya.

Dengan
ukuran yang ekstra besar, kartu
grafis ini dikemas dalam boks
plastik transparan yang pada
dudukannya disertai busa pena-
han. Perlengkapan yang disedia-
kan pada kemasan ini di antara
lain adalah konverter DVI ke VGA
D-Sub 15-pin, kabel S-Video,
kabel power, kabel TV-Out, dan
kabel TV-Out/Video-In 4 in 1.

Selain itu MSI juga
menyediakan sebuah buku
manual dan bundel 10 buah CD
yang terdiri dari game
Morrowind, Ghost Recon, Duke
Nukem, satu bundel Games
Collection, software Virtual Drive,
InterVideo WinDVD, MSI Media
Center, WinDVD Creator, dan
Photoshop Album.

Secara fisik, board kartu
grafis yang menggunakan PCB
berwarna merah ini tampak wah.
Dengan menyediakan konektor
D-Sub 15 pin, DVI, dan Video-in/
TV-out, kartu grafis ini dilengkapi
dengan fasilitas pendinginan

yang sangat meyakinkan.
Pada sisi depan board yang

terdapat chip GPU, MSI
memasangkan heat sink fan yang
terbuat dari tembaga berukuran
ekstra lebar yang menutupi lebih
dari separuh board. Demikian
pula pada bagian belakang board
kartu grafis. Tepat di balik posisi
GPU, terdapat pula heat sink
yang disertai pendinginan aktif.
Hal ini tentunya untuk
menghindari panas yang berlebih
saat kartu grafis ini bekerja.
Fasilitas pendinginan di kedua sisi
board ini oleh produsennya
dinamai MSI Twin Flow Cooling
System.

Sebagai media penyimpanan
hasil olahan chip graphics
processing unit, MSI
menyediakan 128MB memori
DDR 128-bit. Untuk clock GPU
tersebut, kami mencatat bahwa
secara default, engine clock kartu
grafis ini bekerja pada 400MHz,
sedangkan memory clock-nya
bekerja pada 850MHz. Saat
pengujian, kami sempat

menaikkan engine clock ini
sampai ke angka 450MHz dengan
mulus.

Dari hasil pengujian, kami
menarik kesimpulan bahwa kartu
grafis MSI FX5900 VTD128 ini
merupakan salah satu kartu
grafis terkuat saat ini yang
ditujukan untuk pengguna kelas
performance. Dipersenjatai oleh
chip grafis seri terbaik dari
nVidia, pengguna kartu grafis ini
dapat menjalankan game 3D
terkini dengan lancar. Tentunya
apabila komponen sistem PC
lainnya juga cukup mendukung.

Kami menguji kartu grafis ini
dengan software uji
3DMark2001, 3DMark 2003, serta
Quake 3 Arena. Untuk sistemnya
kami menggunakan motherboard
Asus A7N8X, prosesor AMD
Athlon XP 2000+, dua keping
memori Corsair DDR400
berkapasitas 256MB, harddisk
Seagate Barracuda ATA IV
7200rpm kapasitas 40GB, dengan

sistem operasi Windows XP
Professional. Untuk driver-nya
kami menggunakan nVidia
Detonator XP versi 44.03. (fmn)
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Street Legal
Racing

Redline:
Duel Antar
Pembalap
Jalanan

J

Pramadhi Jatmika
pramadhi@hotmail.com

Tidak semua game
yang ber-genre racing,

khususnya balap
mobil, menawarkan

kelebihan seperti
fasilitas modifikasi
lengkap mulai dari

interior hingga
eksterior mobil.

Dengan bermain
Street Legal Racing

Redline (SLRR), Anda
bisa mendapatkan

semua fasilitas
tersebut. Setelah seri

pertamanya yang
diluncurkan dengan
banyak bug di sana-

sini, apakah seri
keduanya ini masih

mengadopsi hal yang
sama?

ika melihat
sekilasgame ini,
maka akan
mengingatkan kita pada

film 2 Fast 2 Furious. Ada yang
sudah pernah menontonnya? Di
dalam game ini Anda akan  saling
mengadu kecepatan dalam drag
race dengan para pembalap
jalanan satu lawan satu. Tujuannya
adalah untuk mendapatkan
reputasi teratas atau untuk
mendapatkan sejumlah uang yang
nantinya digunakan sebagai modal
dalam meningkatkan performa
mobil.

SLRR terbagi menjadi tiga
jenis permainan, yaitu Quick Race,
Free Ride dan Career Mode. Quick
Race yaitu cara instan untuk
balapan melawan musuh dengan
menggunakan mobil beserta lokasi
yang ditentukan secara acak. Free

Ride yaitu berputar-putar
mengelilingi kota dengan
menggunakan mobil yang
ditentukan secara acak. Dan
terakhir adalah Career Mode. Di sini
Anda akan memulai karir untuk
menjadi pembalap jalanan. Hal
pertama yang dilakukan adalah
membeli mobil baru. Kemudian
Anda modifikasi sebaik mungkin
guna mendapatkan performa
tertinggi.

Tetapi pada saat pertama kali
bermain di Career Mode, jumlah
uang yang tersedia sangat terbatas.
Bila Anda tidak mau repot dengan
membeli mobil baru, Anda bisa
membeli mobil bekas yang telah
dimodifikasi dengan harga murah.
Berbicara masalah modifikasi, inilah
yang menjadi salah satu
keunggulan dari game sejenisnya.
Anda dapat mengubah komponen-
komponen utama mulai dari mesin,

bodi mobil, dan roda penggerak.
Di game ini Anda juga bisa

merubah interior mobil seperti stir
kemudi dan jok mobil dari standar
hingga yang bergaya sportif.
Kemudian untuk velg dan ban
sudah menjadi komponen yang
terpisah, tidak seperti
pendahulunya. Jadi Anda bisa
menggunakan keduanya dari tipe
dan ukuran yang berbeda. Untuk
mempercantik penampilan mobil,
Anda bisa menghiasinya dengan
variasi warna, gambar maupun
logo.

Tambahan baru lainnya adalah
adanya fasilitas tunning pada mobil
seperti mengatur akselerasi mesin
dan mengatur tekanan angin pada
ban. Apabila akselerasi mobil Anda
dirasakan masih kurang, Anda
dapat menambahkan turbo berupa
nitro (NOS).

Setelah Anda melakukan
modifikasi, Anda bisa langsung
turun ke jalanan untuk balapan.
Jika Anda masih ragu terhadap
mobil hasil modifikasi, Anda bisa
mencobanya terlebih dahulu di
lintasan uji.

Anda akan balapan di jalanan
kota yang luas dengan setting pagi
hari hingga malam hari. Pada saat
malam hari tantangan yang Anda
hadapi lebih besar ketimbang pada
saat hari masih terang, selain itu di
malam hari menjadi ajang
perkumpulan para pembalap
jalanan saling mengadu kecepatan.
Mau ikut balapan atau hanya
menonton saja?

SLRR menyediakan 8 jenis
mobil, plus ditambah 1 mobil bonus,
mulai dari sedan mini sampai sedan
yang beratap terbuka, terdapat
juga jenis truk mini. Terdapat
kurang lebih 100 komponen yang
bisa dibongkar pasang. Setting kota
yang terdiri dari perumahan,
gedung, pohon-pohon, bukit dan
tempat-tempat lainnya.

Kualitas visual game ini bagus.
Fisik mobil dibuat realistis dan detil
yang dipenuhi oleh refleksi.
Sedangkan untuk area dan mobil
lainnya terlihat kurang akurat.
Terdapat efek cahaya dan
bayangan. Sedangkan kualitas suara
juga cukup baik. Kalau mau Anda
bisa mengganti musik yang ada
dengan format MP3.

Ternyata game ini masih tetap
menyisakan masalah yang sebagian

Konfigurasi
Minimal
Sistem :

• Prosesor Intel atau
AMD 500MHz

• RAM 128MB
• Kartu Grafis 32MB
• DirectX 9.0
• Ruang Harddisk

500MB
• MS Windows 98/ME/

2000/XP

besar terletak pada masalah engine
grafis 3D yang belum optimal. Hal
ini mengakibatkan frame rate turun
drastis ketika merender bagian
gambar yang rumit. Ditambah juga
interface game yang kurang
menarik dan penekanan tombol
yang sedikit menyulitkan.

Secara keseluruhan game ini
lebih menekankan pada aspek
modifikasi atau sistem mekaniknya
daripada balapannya itu sendiri.
Bagi Anda yang ingin
memainkannya dengan nyaman
sebaiknya tahan dahulu sampai
adanya perbaikan dari pihak
developer. Tetapi bagi yang tidak

sabaran, Anda bisa langsung
mencobanya. PC+

Supaya bisa ngirit, lebih baik membeli mobil bekas yang
sudah dimodifikasi dibandingkan dengan mobil baru.

Bagian mobil bisa di-tunning untuk mendapatkan hasil yang
maksimal dari modifikasi.

Tidak hanya bagian mesin yang bisa dimodifikasi, tapi juga
aksesori seperti ban, velg, bumper dan sebagainya.

Tempel lawan dengan ketat! Kemudian susul. Setiap kali
memenangi pertandingan, Anda akan memperoleh uang.

Hati-hati terhadap polisi. Ia bisa mengganggu jalannya
balapan antara Anda dengan pembalap lain.

SLRR menyediakan balapan drag race yang head to head.
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Merek-merek CD-RW
Pilihan Para Pembajak

D

Sekarang ini banyak
merek CD-RW beredar

di pasaran. Masing-
masing merek

mempunyai
kelebihan-kelebihan

yang mungkin hampir
sama, seperti

kecepatan, pencegah
gagalnya penulisan

CD, buffer yang besar,
dan berbagai macam

hal lainnya.

ari segi harga,
mereka pun tidak
terpaut terlalu jauh,
sekitar Rp. 400 ribuan.

Dengan kenyataan seperti itu, kita
sering kali dibuat bingung memilih
CD-RW yang tepat. Mau memilih
yang murah kok takut gampang
rusak, mau memilih yang lebih
mahal kok spesifikasi teknisnya
tidak terlalu berbeda dengan yang
murah. Sebagai alternatif,
mungkin pendapat seorang
mantan pembajak CD patut
didengarkan.

Menurut Bram – bukan nama
sebenarnya – yang tinggal di
kawasan Kutisari Surabaya,  cara
terbaik untuk mengetahui mana
yang terbaik adalah dengan
mencobanya satu per satu.
Menurut pria yang sudah lama
malang melintang dalam dunia
pembajakan CD, diperlukan
kombinasi yang tepat antara
software pembakar CD dan CD-RW
itu sendiri. “Jadi ada software yang

bisa jalan dengan baik dengan
suatu merek CD-RW, tapi tidak bisa
berjalan dengan baik kalau
dengan merek lain,” jelas Bram.
“Saya sendiri sudah mencoba dan
mempunyai sekitar 15 merek CD-
RW,” imbuhnya.

Software yang paling sering
digunakan oleh Bram adalah Nero,
WinOnCD, Alkohol 120%, Disc
Juggler, Fantom, dan CloneCD.
Penilaian yang dilakukan oleh
Bram dibuat dengan mengopi
beberapa jenis CD game yang
sangat sukar untuk dikopi.
“Banyak CD game yang sangat

sulit dikopi. File-file yang ada
sudah terkopi semua, tapi
game tersebut tidak bisa
diinstal. Atau bahkan ada CD
game yang betul-betul tidak
bisa dibaca saat akan dikopi,”
ujar Bram. Berikut adalah
CD-RW yang menurut Bram
sukses mengopi CD-CD yang
sangat sulit dikopi:

ASUS CRW 5224A
Performa CD-RW ini

memang sangat bagus. Belum
banyak CD-RW yang betul-
betul mampu mencapai
kecepatan 52x. Untuk
membuktikannya ASUS bahkan
memberikan sebuah CD-R
blank yang bisa ditulis dengan
kecepatan sampai 52x. Dengan
teknologi CAV (Constant Angular
Velocity), P-CAV (Partial Constant
Angular Velocity), dan Flextra Link,
memungkinkan hasil cetakan CD
yang sempurna dalam kecepatan
tinggi. Sementara Flextra Speed
menjamin alur data dari CPU ke CD-
RW selalu lancar.

“ASUS mampu menulis CD-
Audio dengan kecepatan tinggi
dengan hasil yang memuaskan,”
ujar Bram. Menurutnya, untuk
mendapatkan hasil kopian yang
maksimal, baik itu data, CD-Audio,
ataupun game, hanya ada satu
software yang cocok untuk ASUS,
yaitu CloneCD. “Hasilnya sangat
memuaskan, game apapun yang
sulit dikopi, dengan kombinasi
CloneCD dan ASUS pasti tembus,”
ujarnya.

Untuk membaca CD yang
sudah agak cacat, ASUS pun bisa
dengan baik mengatasinya. “Untuk

membaca CD yang sudah baret-
baret, walaupun butuh waktu yang
lebih lama dari biasanya, ASUS bisa
berhasil dengan baik. Software
yang digunakan harus CloneCD,
kalau software lain pasti tidak bisa,”
ujar Bram. “Tapi kalau hanya
sekedar menulis data atau mengopi
VCD, software apa saja juga bisa,”
imbuhnya.

TDK
CD-RW yang punya speed 48x

ini menurut Bram cukup andal.
Dengan teknologi yang hampir
sama seperti ASUS, TDK bisa

digunakan dengan berbagai
macam software pembakar CD
secara maksimal. “Hampir semua
fasilitas apapun di software
pembakar CD bisa digunakan oleh
TDK,” kata Bram.

Perkara membaca CD yang
sudah baret-baret juga OK. “Tapi
kalau baretnya cukup dalam ya
nggak terbaca, tapi kemampuan-
nya membaca CD yang agak sulit
patut diacungi jempol,” ujar Bram.

LITE-ON
Lite-On adalah yang termurah

dari kedua CD-RW di atas, namun
kemampuannya bisa menandingi
ASUS dan TDK. Menurut Bram,
Lite-On hanya sangat cocok untuk
beberapa jenis software pembakar
CD saja, seperti CloneCD, Nero,
Alkohol 120%, dan Disc Juggler.
Tapi kemampuannya membaca CD
yang sudah baret masih kalah jika
dibandingkan dengan ASUS dan
TDK.

Kalau Anda berminat menjadi
pembajak CD atau jika Anda sering
gagal mengopi CD game, ketiga
merek di atas dianjurkan oleh
Bram. “Biasanya yang paling sulit
adalah mengopi CD game. File-nya
sudah terkopi semua tapi tidak bisa
diinstal atau tidak bisa jalan.
Dengan ketiga CD-RW di atas dan
software yang tepat masalah
tersebut bisa diatasi. Yang harus
diperhatikan adalah kombinasi
yang cocok antara software
pembakar CD dengan merek CD-
RWnya,” ujar Bram.

“Tidak ada satu software yang
digunakan dengan maksimal
untuk seluruh merek CD-RW, dan
tidak ada satu CD-RW pun yang
bisa digunakan secara maksimal
oleh semua jenis software
pembakar CD,” imbuh Bram.

“Tapi kalau tujuan Anda
mempunyai CD-RW hanya untuk
backup data, mengopi VCD atau
CD-audio, merek apapun rasanya
tidak masalah. Sofware pembakar
CD jenis apa pun juga tidak
masalah. Kemampuan semua
merek CD-RW sekarang sudah
sangat bagus dan sudah
kompatibel dengan hampir semua
jenis CD-blank,” jelas Bram. PC+

T.J. Setyoadi
dino@e-pcplus.com
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

VIA P4PB-Ultra+RAID  P4X400,
ATX, FSB533, DDR333/400, RAID 103
VIA P4PB400-L  P4X400, ATX,
FSB533, DDR333/400 68
VIA P4PB266EN, P4X266, ATX,
FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 59

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 105
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0,
Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 236
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 174
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 158
Asus P4C800, i875, FSB800,
4DDR, RAID, Audio, Gigabit LAN 210
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84
Asus P4S533-MX, SiS651 FSB533, ATA133,
2DDR+ 2SDR, audio, VGA onboard 74
Asus P4S8X/L 1394, SiS648,
FSB533, 3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89

Asus P4S533-X, SiS645dx,
FSB533, 2DDR, audio, VGA onboard 70
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600,
6 PCI, 3DDR, AGP8x 112
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 107
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP978 Ii845GL, ATX, 400FSB,
SOUND AC97, 2 SDRAM 54
APLUS AP971A+ VIA P4M266,
ATX, 400FSB, SOUND AC97,
2 SDRAM, S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E,
FSB 533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 52
APLUS AP971A VIA  P4M266A, M.ATX,
533FSB, SOUND AC97, 2SDRAM 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 645Combo, SiS 645, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 6PCI 66
MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 73
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 76
MSI 648 MAX, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 88
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133,
SATA, AGP8X 110
MSI 645GLM, I845gl, Matx,
FSB400, 2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X,6PCI 96
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133, AGP8X,
5PCI 130
MSI 845PE Max2-FISR, i845PE,
ATX, FSB533, 2GBDDR, ATA133,
AGP4X 163
MSI K7N2-L, nForce2, ATX, FSB400,
3GB DDR, ATA133, AGP8X, 5PCI 115

K7N2G-L, nForce2, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 5 PCI 130
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 85
KT4V Ultra FISR, Via KT400, ATX,
FSB333, 3GBDDRR, ATA133, SATA 158

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400, ATX,
Soket A, ATA133 89
Gigabyte GA-7N400-L1,
nForce2 ultra, ATX, Soket A,
ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82
Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 242

Jetway J-603TCF, VIA PLE33,
soket 370, M-ATX, FSB100, ATA100 52
Jetway J-P4XFBU, VIA P4X266E,
soket 478, ATX, FSB533, ATA133 62
Jetwat J-615TCS, i845E, soket 370,
M-ATX, FSB133, ATA133 56
Jetway J-615TCF, I845e, M-ATX,
soket 370, FSB133, ATA133 81
Jetway J-830CH, SiS730SE, ATX,
soket 462, FSB266, ATA100 63
Jetway J-P4MDPT, VIA P4M266A,
M-ATX, soket 478, FSB533, ATA133 64
Jetway J-S446, SiS645/961, ATX,
soket 478, FSB400, ATA100 66
Jetway J-845EPRO+ RAID, i845E,
ATX, soket 478, FSB400/533, ATA133 90
Jetway J-845GLM, i845GL,
M-ATX, soket 478, FSB/400, ATA100 67

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69

Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 80
Iwill P4E, i845PE, soket 478,
FSB 400/533, DDR, Audio,
F1 series, ATA133 & 100 76
Iwill DX400-SN, ii860, soket 603, RDRAM,
Dual Pro include casing, SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D, DDR266,
RAID, 6ch audio, AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra, Sis645A2+
961, RAID, 6ch audio, AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 145
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 103
Abit BE7-G, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 127
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BD7, i845D, FSB 533MHz,
2DDR, AGP 4X, 5 PCI 85
Abit BG7E, i845GE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 100
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 194
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 95
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 135
Abit BD7E, i845DDX, FSB 533MHz,
2 DDR, AGP 8X,  5 PCI 75
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT Rp.100.000,-
1.Teknik Komputer+MoBo+Hardisk+Copy Bios
2. Network LAN + EDP + Admin + PC Kloning
3. Design Grafis 4. Private 5. Jarak jauh OK
GRATIS: CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
BELAJAR JARAK JAUH BISA - BERGARANSI
EXSYSCOM : 021.78889003 - 0815.997.1234
Jl.Raya Depok - Depan UI - Blk.Halte - Jakarta 12640

IZZAH COM Kursus “PAKET HEMAT” Merakit PC
75rb LAN 75rb WebDesign 150rb Photoshop 85rb
MS.Office 85rb Pwr Point 75rb Praktis, Cpt, Certifi-
cate Jl.Rawamangun Timur/78 Ph.47867273
http://izzahcomp.tripod.com

LAIN - LAIN

LENGKAP & MEMUASKAN
-Bubuk TONER MURNI dari pabrik
-OPC drum, blades, mag-roller, dll

-Larutan kimia untuk rekondisi
-Tinta literan INKJET MURNI

-Refill tool,resetter,accessories,dll
TERSEDIA BAGI PEMULA :

Paket bisnis isi ulang & Training
www.ecoprintlution.com

(031) 501 6088, 504 0150

Domain E.com/. Net/.org Rp.105.000/ Thn
Web & Mail Hosting Rp.9100/Bln Anti Virus
FREE: Design Web,Forward Web, Biaya setup
Dapatkan: CD,Sticker,T-shirt (Terbatas)
www.Dhewastudio.com  HP.0815.9228166

Koleksi CD Digital Imaging Photo, Clipart,
CD Interactive Edutainment, Majalah
Interactive,dll. Katalog gratis bisa hubungi
ke:galeriku@hotmail.com atau kirim alamat E-mail
anda via SMS ke:0817-224210

5799-2613 *Danang*, Ditawarkan karya musik
dalam bentuk CD. Kualitas “outstanding”,
berpotensi “meledak” (perantara dapat 20%). Kami
juga mengajar software musik (Produksi musik
tanpa studio & alat musik)

IKLAN BARIS

MEMORI

Visipro 128MB (4 IC) PC 133 25
Visipro 128MB (8 IC) PC 133 33
Visipro 256MB (8 IC) PC-133 45
Visipro 256MB (16 IC) PC-133 67
Visipro 512MB PC-133 82
Visipro 128MB (8 IC) PC-2100 28
Visipro 256MB (8 IC) PC2100 50
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 94
Visipro 128MB (4 IC) PC-2700 Call
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 53
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 99
Visipro 256MB PC3200 (8IC) 56
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37
Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 22
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 41
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC) 512MB 83

V-Gen DDR PC-2100  128MB 26
V-Gen DDR PC-2100  256MB 47
V-Gen DDR PC-2700  256MB 49
V-Gen DDR PC-2100  512MB 92
V-Gen DDR PC-2700  512MB 95
V-Gen DDR PC-3200  512MB 96
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 97

NCPRO 256MB DDR PC-3200 47
NCPRO 256MB DDR PC-2700 44
NCPRO 512MB DDR PC-2700 89
NCPRO 128MB DDR PC-2100 18
NCPRO 256MB DDR PC-2100 33

COMPACT FLASH

NCPRO Flash memory 32MB 16
NCPRO Flash memory 64MB 17.5
NCPRO Flash memory 128MB 29
NCPRO Flash memory 256MB 58.5

Visipro Flash Memory 64MB 27
Visipro Flash Memory 128MB 43
Visipro Flash Memory 256MB 71
Visipro Flash Memory 512MB 125

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

NCPRO pen drive 128MB 37
NCPRO pen drive 256MB 59.5
NCPRO pen drive 512MB 115
NCPRO pen drive 128MB USB2.0 44

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound, 128MB, multi MP3,
voice recording, display 115
MagicStar 128 Turbo, USB 2.0, 128MB 70

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 64
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 75
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 83
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 110

Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 180
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 265

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51
Seagate Ux/Cuda 5400.1 40GB
ATA 100 59
Seagate Barracuda ATA IV /V 80GB
7200RPM ATA100 80
Seagate Barracuda 7200.7 40GB
ATA100 62
Seagate Barracuda 7200.7 80GB
ATA100 80
Seagate Barracuda 7200.7 120GB
ATA V/100 108
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 165
Seagate Barracuda SATA 80GB,
ATA100 125
Seagate Barracuda SATA 120GB,
ATA100 143

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 59
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133,
2MB cache 66
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call

Maxtor 4G160H, 160GB, 5400rpm,9,0ms,
ATA100, 2MB cache, dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 125
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 150
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 210
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 250

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210
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Pemenang Kuis Edisi 142/III/2002:
HADIAH SOUVENIR PCplus

1. Aidhi Zulham
Villa Kenal iPermai Blok J3 No.11
RT.15/13 Kota Baru - Jambi 36127

2. Hendy Karles
Jl. Sinyar IX RT.012/009 No. 12B
Jakarta Pusat 10140

3. Husin Sanusi
Jl. Conver 1A No.312
Kemayoran 10630

4. Dewi Kuntari
Jl. Raya Ijen No.58 Sumber Gading
Sukosari - Bondowoso 68287

5. Putut Bayuaji
Sendowo Blok F-139
Jogjakarta 55284

KUIS "Plus, kamu kan sering merakit PC, sebenarnya fitur-fitur atau
komponen umum yang ada pada motherboard apa aja sih?", tanya
Lala, kawan si Ciplus. "Waduh, aku sering sih, merakit PC, tapi

komponennya apa aja ya?", pikir si Ciplus dalam hati. Tolong dong si Ciplus, sebutkan lima
saja fitur atau komponen yang ada pada motherboard? Tuliskan jawaban tersebut di
sehelai kartu pos dengan mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis
asli (di pojok kanan). Jangan menunda-nunda, karena jawaban sudah harus masuk ke meja
Redaksi PCplus paling lambat tanggal 27 Oktober 2003. PCplus akan memberikan 5 buah
kaos PCplus untuk 5 orang pemenang yang menjawab dengan benar dan beruntung!
Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 142/III/2002: Linux Sehat

Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 Call
Intel Pentium-4 2,66GHz,
(512) FSB 533 211
Intel Pentium-4 2,8GHz
(512) FSB 533 280
Intel Pentium-4 2,4GHz,
512KB, FSB800, 478 196
Intel Pentium-4 3.0GHz,
512KB, FSB800, 478 Call
Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,

512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19

Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T 64MB MX440-8X 84
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x, 128MB DDR 620
Asus V9520 Magic/T
GeForceFX 5200, 128MB, AGP8X 95
Asus V9520 Home Theater-128MB 195
Asus V9280 SuperFast/TVD,
Ti4200-128MB 221
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 583

EXTERNAL DRIVE

Maxtor 5000DV 160GB,
USB 2.0, 8MB Cache, 7200rpm 315
Maxtor 5000DV 200GB USB 2.0,
8MB Cache, 7200rpm 400

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB ORCA,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 160
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 455
IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist
Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES,
63,2ms, 4MB 190
Seagate Cheetah 10Krpm,
73GB, U320, 36ES, 63,2ms,
4MB 530
Seagate Cheetah 15Krpm
18,4GB, U160, x 3,9ms,
8MB cache 219
Seagate Cheetah 15Krpm 36,7GB,
U320, x 3,9ms, 8MB cache 397

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300,
1300MB, external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 48
Athlon XP 1900+ (Palomino) 52
Athlon Xp 2000+ (Thoroughbred A) 54
Athlon Xp 2100+ (Thoroughbred A) 57
Athlon XP 2200+ ((Thoroughbred A) 62
AthlonXP 2400+ fan (Thoroughbred A) 75
AthlonXP 2600+ (FSB333) + fan 89
AthlonXP 2800+ (Barton FSB333) 165
AthlonXP 3000+ (Barton FSB333) 215

Intel Pentium-4 1,6GHz)-423 126
Intel Pentium-4 1,8GHz, box, 478 138
Intel Pentium-4 3,06GHz, box),
478 Call
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 Call
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